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Comparing and Contrasting 
Personal Computers 

Computers were originally created for military, scientific, 

government and corporations – organizations with one common 

characteristic – large budgets! Fortunately, since the early days of 

computing, computers have simultaneously become more user-

friendly and affordable giving rise the era of personal computing. 

In 1977 Steve Wozniak and Steve Jobs debuted the Apple-II 

personal computer. However, it wasn’t until the early 1980’s that 

IBM introduced their personal computer (PC), and the personal 

computing era really became legitimate. 

Personal Computers (PCs) are best described as small, inexpensive 

computers designed for individual use. Each of the following are 

examples of personal computers: 

• Desktop computers – designed to utilize a consistent source 

of electric power, these computers fit on or beneath a desk, 

and therefore are not intended to be portable. Most desktops 

contain several peripheral input and output devices intended 

to extend the computing functionality. 

• Laptop and Notebook computers – portable computers 

that utilize a battery for power, and consist of a separate 
display screen and keyboard in a single unit. Laptops have a 

hinged lid that closes the screen onto the keyboard for easy 

portability. Some screens are touch-activated displays. 

• Tablets – thin mobile computers with touchscreen displays. 

Typically, larger than smartphones, tablets are ideal for 

reading eBooks, surfing the Web, and watching videos. 

• Smartphones – pocket-sized mobile phones that combine 

voice, text, e-mail and personal computing into a single 

device that can access the Internet and run a variety of third-

party software components, known as apps. 
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Modern desktop and laptop computers are generally either PCs, 

usually running a Microsoft Windows version operating system, or 

Apple Macintoshes, which run Apple’s proprietary operating 

system (OS) software. Various versions of the Linux OS also 

represent a relevant share of desktop and laptop users on a PC 

platform. However, according to Statista, Microsoft’s Windows is 

the dominant OS in terms of shares of users, with estimates of more 

than 76% of all users in 2022. 1 

What about a Chromebook? According to ZDNet, a Chromebook is 

a portable computer running ChromeOS, a specialized operating 

system designed by Google to rely more heavily on connected and 

cloud-based services than traditional operating systems like 

Windows or MacOS do. Chromebooks look nearly identical to most 

laptops or notebook PCs, but generally include less powerful 

hardware due to their reliance on those cloud-based services, instead 

of locally installed software that requires more horsepower.  

The most popular mobile (tablets and smartphones) operating 

systems are Android (developed by Google), and iOS (developed by 

Apple). 

 
1 https://www.statista.com/statistics/218089/global-market-share-of-
windows-7/#statisticContainer 
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Identifying Computer System 
Components 

Computer systems consist of hardware and software. Hardware is 

the tangible, physical components of a computer, while software is 

the intangible programs that function on a computer. Basic hardware 

components include a hard drive for storing data, a processor for 

This Photo by Unknown Author is licensed under CC BY-SA-NC 

https://www.thegeographeronline.net/it-grade-8.html
https://creativecommons.org/licenses/by-nc-sa/3.0/
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performing operations, memory for holding active data, and 

a motherboard to tie the parts together. Even gaming consoles are 

considered computer hardware.   

Software includes computer programs, libraries and data. Software 

can be categorized as application (most programs), system 

(operating, utilities and device drivers) and malicious software, or 

malware (undesirable programs that results in harm or disruption). 

The four main components of a computer system are input devices, 

output devices, processing devices and the storage devices used to 

store data within the computer system. The flow of data through a 

computer system begins with an input device that enters data into 

the central processing unit which then sends the data to an output 

Computer system processes 
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device as information. Alternatively, data can be retrieved or sent to 

a storage device from the processor. 

Hardware and software work together to process data. When you 

open a software program, the computer reads its data from the hard 

drive or input device, runs the software on the computer’s processor 

and then displays the results on your output device or saves the data 

to a storage device. 

Classifying Various Peripheral 
Devices 

Hardware components that are not an integral part of the central 

processing unit are often referred to as peripheral devices. Peripheral 

devices connect with a computer through several I/O interfaces, 

such as communications (COM), Universal Serial Bus (USB), 

firewire, and serial ports. Peripherals are usually used for either 

input, storage or output. 

Input Devices 

An input device is any device that provides input to a computer. 

There are many input devices, but the two most common ones are 

a keyboard and mouse. Every key you press on the keyboard and 

every movement or click you make with the mouse sends a specific 

input signal to the computer. Examples of commonly used input 

devices include: 

• Mouse: a small object 

that you can roll along 

a hard and flat surface 

which serves as 

pointing device to 
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enable the user to control the movement of the cursor on a 

screen display. Most mice have two or more buttons which 

allow the user to scroll and click objects on the screen. 

• Keyboard: desktop and laptop computers have external and 

built-in keyboards that resemble a traditional typewriter. 

Most keyboards are designed to have the QWERTY layout 

of keys which make keyboarding easy and consistent across 

various devices. Many keyboards have function keys as the 

top row that perform special shortcut functions. 

• Touchscreen: the primary input device for tablets and 

smartphone, this technology combines the functionality of a 

mouse and a keyboard by allowing a finger or stylus to make 

gestures or select on-screen menus and keys. 

• Microphone and Camera: used to record and capture sound 

and images, and to communicate with others using audio and 

video conferencing software. Most portable computers have 

these devices built-in, but external devices are typically a 

higher quality. 

Many input devices operate without cords. Wireless mice and 

keyboards require receivers to collect the electronic signals 

transmitted by the input devices. Bluetooth devices use short-range 

radio waves to communicate between paired devices and computers. 

Other, input devices include scanners, bar code readers, joy sticks, 

light pens, trackballs, magnetic ink character recognition (MICR) 

and optical character recognition (OCR) software.   

Warning! Excessive use of a computer can lead to repetitive motion 

injuries such as carpal tunnel syndrome, and other computer-

related health problems, including computer addiction. Take 

frequent breaks, stretch properly, and utilize ergonomically 

designed input devices to reduce the threat of these injuries. Limit 

your time online and connect face-to-face too! 
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Output Devices 

An output device is any hardware peripheral that disseminates 

processed data. The processed data, stored in the memory of the 

computer is sent to the output device, which then converts it into an 

understandable form.  Examples of commonly used output devices 

include: 

• Monitors: older monitors typically contain a cathode ray 

tube, which result in a heavy display, which is also an 

inefficient use of power and your desktop footprint 

compared to flat screen monitors. A flat panel display uses 

an LCD (Liquid Crystal Display), although some use plasma 

technology. Screen size is measured diagonally across the 

screen, in inches. The entire screen area may not be usable 

for image display. The resolution of the monitor is the 

maximum number of pixels it can display horizontally and 

vertically (such as 800 x 600, or 1024 x 768, or 1600 x 1200). 

Most monitors can display several resolutions below its 

maximum setting. Pixels (short for picture elements) are the 

small dots that make the image displayed on the screen. 

A video card is necessary for generating complex computer 

graphics on a monitor. 

 

Multi-function printer 
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Printers: want a “hard” copy of a document versus a “soft” 

copy of a file? A printed output is referred to as a hard copy 

versus an electronic or soft copy of a file. Printers come in 

various formats. Popular for home computing is ink 

jet printers. These printers form the image on the page by 

spraying tiny droplets of ink from the print head. The printer 

needs several colors of ink (cyan, yellow, magenta, and 

black) to make color images. Some photo-quality ink jet 

printers have more colors of ink. Unfortunately, ink 

cartridges are expensive to replace, so the cheap initial cost 

of ink jet printers is offset by frequent printing usage. 

Conversely, laser printers utilize toner to burn tiny plastic 

particles of pigment onto paper. While the initial cost of laser 

printers can be expensive, they produce a higher quality 

output and are less expensive and faster than ink jet printers 

in the long run. Other printers include dot-matrix which use 

impact and inked ribbon on continuous feed paper. These are 

(were) popular for multi-layer forms. Lastly, multi-function 

printers are popular for home office/small office computing 

because they combine printing, faxing, copying and 

scanning in a single device. 

• Speakers: Audio output requires a sound card and internal 

or external speakers or headphones. 

 

 

 

 

 

Flash Drive 

• Storage devices: While primary storage is the internal 

CPU’s RAM, secondary storage consists of external 

hardware such as CDs, DVDs, flash drives and external hard 

drives. Obsolete secondary storage examples include floppy 
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disks, magnetic tape, punch cards and zip drives. A popular 

alternative to physical secondary storage is cloud 

storage which stores data on remote servers accessed from 

the Internet, or “cloud”, which is maintained by a cloud 

storage service provider built on virtualization techniques. 

 
 

 

 

 

                    Wearable computer device 

• Hybrid peripherals: Wearable computer devices, such as 

augmented reality goggles, smartwatches and fitness 

trackers can all be lumped into this auxiliary device 

category. 

Creating Screenshots 

One of the first steps to securing assistance with computer-related 

issues requires sharing the error or screen output with a teacher or 

technical support staff. Often, these support resources are not 

available to view the screen in-person. Therefore, capturing the 

screen output is a vital skill to help resolve computer issues. 

Screenshots, also known as screen captures, screen grabs, or print 

screens, are the technical terminology assigned to this piece of data. 

A screenshot is a digital image of what appears on a computer or 

television screen. Producing a screenshot can be a confusing task, 

which should be broken down into two parts. The first part is the 

capturing of the screen image, while the second part is the process 

of pasting the capture into a storable file. There are numerous 

methods of capturing a screenshot, and they vary from one computer 
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device to another due to operating system versions and keyboard 

differences. 

Snipping Tool 

The most consistent method for Windows users to create 

screenshots is by utilizing the Windows Snipping Tool. As of late 

2018, the new tool is called Snip & Sketch. Most images in this 

documentation have been generated with the help of these tools. To 

open the Snip & Sketch tool, select the Start button, type “snip” in 

the search box on the taskbar, and then select the 

Snip & Sketch 

Snip & Sketch app from the list of results. In addition to capturing 

a full-screen snip, the Snip & Sketch Tool provides the convenience 

of capturing a more specific “snip” of data by using the mouse to 

draw a rectangular or free-form block of specific data to be captured. 

This allows for more focused data to be collected versus an entire 

screen of potentially competing images. Once the drawing is 

selected, the screenshot should automatically open in a new 

window. You can modify the screenshot by cropping, highlighting 
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annotating or drawing on the image. This image can then be pasted 

into a new program (similar to how the above image was added to 

this document) or saved as a separate file to be stored on a permanent 

or cloud storage device. The Snip & Sketch tool also be set to a timer 

to take a screenshot in three or ten seconds. To take a screenshot 

with Snip & Sketch, just press PrtScn. Screenshots will be quite 

useful for providing feedback or asking questions to/from 

students/teachers, particularly in distance education environments. 

File Management 

One of the many attributes of being a successful college student is 

evidence of time management, communication, and organization 

skills. Managing the files on a computer is essential to excel at all 

of these skills. Almost all courses require a computer to access and 

communicate information. The inability to locate a file on a 

computer or course management system (like Brightspace D2L or 

Blackboard) could result in a late or missing assignment, missed 

conversations with an instructor or classmate, and/or tremendous 

stress.  The primary solution to enhanced computer organization 

skills is through increased knowledge of Windows’ File Explorer 

tool (formerly known as Windows Explorer). 

File Explorer displays the hierarchical structure of files, folders, 

and drives on your computer. All data, including applications, 

program files, etc. is stored on the computer’s disk (also known as 

disk drive). The primary internal hard drive is known as the C: drive. 

The contents of a disk are organized into individual files within 

individual folders. The Document folder is a general storage 

location for files created in programs like Microsoft Office, whereas 

photos downloaded from the Internet or a camera are typically 

stored in the Pictures folder. The Quick Access section displays 

frequently used folders and files, whereas the This PC view displays 

information regarding the computer’s storage capacity, and attached 

storage devices, including optical media. 
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To access the computer’s files, click Start > File Explorer or select 

the File Explorer icon located in the taskbar. Upon launching File 

Explorer in Windows 10, the Quick access window will open. 

Previously known as “Favorites” in previous versions of Windows; 

this is where users will see their most frequently accessed folders 

and files that have been created. 

File Explorer 

The File Explorer window can be broken into the following sections: 

1. File Explorer ribbon. This is similar to the ribbon you will 

find in most Microsoft Office applications. The ribbon 

contains buttons for common tasks to perform on your files 

and folders, such as copying, pasting, moving and renaming 

files and folders. A recommended feature is the View menu 

which allows you to view your files via icons, tiles, a list or 

the underappreciated Details view. 

2. Navigation Pane. Vertically scroll through this pane to 

access commonly used drives and folders. You can also 

access your Downloaded files, Documents, and external 

storage devices, as well as other libraries, such as pictures 

and music. 

3. Frequent folders. This displays the folders you’ve worked 

with recently to allow for quick access. 
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4. Recent files section. Similar to the Frequent folders section, 

this area displays the files and documents that you’ve 

recently opened. 

The Search box is an underappreciated tool to help find files that 

can’t be found in their presumed location. Use the asterisk (*) 

wildcard character to expand the search results. i.e. Plane* will find 

files with the words plane or planet, and more. The File Explorer 

contains an array of tools which can help manage files and stay 

organized! 

Creating a custom hierarchical structure of folders for each semester 

and each course is considered a best practice for organizing college 

data. For example, create a folder with the name of the current 

semester, i.e. 2018 Fall. Within this folder, create subfolders for 

each course, i.e. BUS1100. Descriptive folders and file names also 

diminish confusion when trying to find files on a computer disk. 

Folder Hierarchy 

File Explorer is the primary tool for copying, moving, renaming and 

searching for files and folders. The View tab provides display and 

sorting options for files and folders. Viewing files using the Details 

layout allows for quick sorting by simply clicking a column header 

to toggle between ascending and descending order. The sort order in 

the above illustration is sorted by Name in ascending order. Clicking 

the File name extensions checkbox helps identify the source 

program for each file, particularly if the Type column is not 

displayed. Perhaps the most useful column is Size, which can be 

helpful to determine if a file is too large for distribution via e-mail 

or portable storage methods. 
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Shortcut menu 

One of the most common operations for users is copying files, 

which creates a replica of an original file. To copy a file, select the 

file you want to copy and click Copy under the Home tab. Moving 

a file necessitates substituting the Copy button with the Cut button. 

Moving a file saves hard drive space by not creating a duplicate file. 

To add a new folder, right click and choose New > Folder from the 

Shortcut menu. Conversely, to delete a file or folder, right-click the 

object and choose Delete from the shortcut menu. Warning! – 

Deleted files are not permanently removed from the computer. Most 

computers send deleted files to the Recycle Bin, which still needs 

to be emptied before the file is removed from the computer. 
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Compressing & Extracting Files 

Even though modern hard drives allow for excessive amounts of 

data storage, moving files from one device to another often 

necessitates reduced file sizes for efficient transfer of a files via the 

internet or between physical devices. Computer users utilize file 

compression to reduce the file size of one, or more often, multiple 

files. Although there is no exact measurement of the actual reduced 

size of the compressed file, file compression often reduces a file's 

size by 50 to 90 percent. This makes the process of uploading and 

downloading data files for a computer course much more efficient! 

There are numerous techniques for compressing files. In fact, there 

are numerous synonyms for compressing that are often 

interchangeably used, such as compacting and perhaps the most 

popular, “zipping”.  The process of zipping a file refers to putting it 

into an archive format such as "ZIP." One of the reasons "zip" is the 

term used is that one of the most popular archive formats has the file 

extension "ZIP." 
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Windows makes the compression/extraction process easy. To zip 

(compress) files: 

1. Locate the file or files in File Manager. 

2. Select the files (use the Ctrl key to select multiple files), right-

click and choose Send to, and then choose Compressed (zipped) 

folder.  

A new zipped folder with the same name is created in the same 

location. To rename it, press and hold (or right-click) the folder, 

select Rename, and then type the new name. 

 
A compressed or zipped folder 

Once the compression process is complete, the next step is to 

transfer the file to the recipient (usually via the web or e-mail), and 

then the process of decompression begins. Decompression is more 

commonly referred to unzipping or extracting. To unzip (extract) 

files from a zipped folder: 

1. Locate the file in File Manager. 

2. Right-click the file and choose Extract All. A new window will 

appear asking where the extracted files should be placed. Click 

the Browse button to identify an intentional destination for the 

files. Then choose the Extract button at the bottom of the 

window. 

 

 



Personal Computer Basics | P a g e  | 18 

E-mail Basics 

 
For many college faculty, getting students to properly use their 

college e-mail is a frustrating experience. It typically has less to do 

with understanding how e-mail works, but more about how certain 

generations function. While to many, e-mail might seem like an 

outdated technology, it is still very commonly utilized, particularly 

in larger organizations. Successful college students read and 

respond to their e-mail! 

The main purpose of e-mail is to send fast messages directly to the 

recipient’s inbox whether they’re on the other side of the world or 

the other side of the office. E-mails are often used in internal 

communication among co-workers, and externally among 

customers and suppliers. Some important reasons for utilizing e-

mail versus other forms of messaging: 

1. E-mail creates a paper trail for correspondence. Having 

something in writing is much more credible than hearsay. 

2. E-mail is cheap. E-mail addresses can be acquired from 

organization domains or from free Internet providers. No 

This Photo by Unknown Author is licensed under CC BY-SA-NC 

https://johnny-ong.blogspot.com/2006/12/office-situation.html
https://creativecommons.org/licenses/by-nc-sa/3.0/
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special devices, data plans or contracts are required. Sending 

and receiving e-mail is much cheaper and faster than 

traditional mail delivery. 

3. E-mail is accessible. Web-based e-mail, or webmail, can be 

accessed from anywhere there is an internet connection.  

There are many similarities across different e-mail programs, so 

once you learn one, it should be easy to learn others. However, some 

common issues that often confuse e-mail novices are e-mail address 

syntaxes and e-mail netiquette.  

 

The first part of an e-mail address is the username. The username 

is specific to the person you’re sending messages. The “@” symbol 

separates the username and the domain name. The last part of the e-

mail address syntax is the domain name. This name points to the 

computer or system of computers that manage and host their e-

mails. These are called e-mail servers.  

The domain of your college or university will not end with the .com 

suffix. Instead, your school e-mail address should have a .edu suffix. 

There are other suffixes for the government, the military and non-

profits. What is your school e-mail address? 
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The illustration below identifies some common e-mail features 

including the Compose pane, the Subject, and the Message pane.  

Proper use of each of these features will help ensure proper e-mail 

netiquette. The Compose pane identifies who should receive the e-

mail. In addition to the To: field, a Cc and Bcc field can be utilized 

to express different levels of attention for different recipients. 

Multiple recipient addresses can be added to each field. The Subject 

field is often overlooked. While not required, a descriptive Subject 

line is very valuable for recipients to determine the urgency of 

opening the message. Last, but not least, the Message pane is the 

main purpose of the e-mail. This where you type your message. 

Threaded conversations will often be displayed when recipients 

reply to your e-mail. Don’t forget to add a proper e-mail signature! 

This Photo by Unknown Author is licensed under CC BY-NC 

http://mariajesusbfe.blogspot.com/2010/04/writing-emails-in-english.html
https://creativecommons.org/licenses/by-nc/3.0/
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Useful Keyboard Shortcuts 

• Windows key + E – open a new instance of File Explorer 

from anywhere in Windows. 

• Alt + P – show or hide the Preview pane. 

• Alt + Shift + P – show or hide the Details pane. 

• Alt + left arrow key – go back one folder in your history. 

• Alt + up arrow key – go up one folder in the folder tree. 

• Ctrl + N – open a new File Explorer window. 

• Ctrl + E – activate the Search bar. 

• Ctrl + Shift + N – create a new folder in the current folder. 
• Ctrl + mouse wheel up or down – increase or decrease the 

size of icons and thumbnails. 

• Ctrl + Alt + Del – starts Windows Security, which lets you 

lock the computer, switch to a different user, log off, start 

Task Manager, or shut down/reboot the computer. Also 

referred to as the Three-finger salute, as users who invoke 

this command are often in a frustrated state that requires 

some computer maintenance. 
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Microsoft Word Chapter 1: 
Developing Documents 

• Exploring the Word Window 
• Entering and editing text 

o o Paragraph and line spacing 

o o Automatic features 

• Spelling and grammar checking 

• Selecting text 

• Cut, copy and paste 

• Finding and replacing text 

• Creating bulleted and numbered lists 

• Inserting symbols 

• Inserting and modifying graphics 

• Utilizing WordArt and SmartArt 

• Inserting and modifying hyperlinks 
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Exploring the Word Window 
Get to know the elements of the Microsoft Word window! 

Microsoft Word illustrated 

• The Quick Access toolbar contains one-click buttons for 

saving, undoing, redoing, and print previewing a document. 

You can easily modify this toolbar to add your most 

frequently used commands. Just click the down-arrow on the 

right edge to customize this toolbar! 

• The title bar displays the name of current document, and the 

program. A new document will default with a temporary file 

name, such as Document1 until you save the file with a 

different name. The Minimize, Maximize and Exit buttons 

appear on the right edge of the title bar. 

• The Tell Me tool is a new way to get assistance with specific 

tasks in Word. When the user starts typing, Word suggests 

commands that are related to your keyword(s). The tool is 

context sensitive and integrated into your current document 

versus opening a separate window. Therefore, if you 



 
Word Chap 1 Page | 24 

type insert picture into the field, and click the resulting 

command, Word will open the Insert Picture dialog window 

without explaining the navigation instructions. 

• The Ribbon interface is a set of toolbars at the top of the 

window in Office programs designed to help you quickly 

find the commands that you need to complete a task. The 

ribbon displays a combination of icons and tabs. 

Commands are grouped under multiple tabs. Some 

commands are so extensive that they need additional 

windows to display their entire functionality. The dialog box 

launcher icon will open these windows. Contextual tabs will 

appear only when the user needs them, such as when a 

picture is selected, or a table is inserted. 

• The Zoom slider appears in the lower-right corner of the 

window. Click and drag the slider left, towards the minus 

symbol (-), to shrink the magnification. The magnification 

level is the percentage which appears to the right of the zoom 

slider. Click and drag the slider to the right, or towards the 

plus sign (+), to increase the magnification level. 

Alternatively, click the (+) or (-) symbols next to the Zoom 

slider to increase or decrease the magnification. Changing 

the Zoom percentage only affects the appearance on screen. 

Entering and Editing Text 

Microsoft Word is a word processor software application used to 

create, modify, and share documents. When Word is started, the user 

has the option of modifying a pre-developed template or creating a 

blank document. Users begin by entering data at the existing 

insertion point identified by the I-beam pointer (cursor). As the user 

types text into the document, Word will word-wrap the data when 

encountering the right margin and continue the text on the following 

line. The user only needs to press [Enter] when it is desired to start 

a new paragraph or insert a blank line. 
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Line spacing is the space between each line in a paragraph. By 

default, the line spacing within a paragraph in Word is 1.15 lines, 

and the end of a paragraph is followed by a blank line. While the 

default spacing may be appropriate for some documents, other 

situations might require different 

settings. For example, this paragraph 

is using 1.5 line spacing, which can 

be adjusted by clicking the option 

encircled above in the Paragraph 

group from the Home tab. Other popular line spacing 

options are double and triple-spacing. 
 

Line spacing is a popular option to adjust for various documents. 

However, paragraph spacing is less well-known. Adjusting the 

spacing before and after paragraphs creates necessary white space 

to make the document more readable. Go to Page Layout and under 

Spacing, click the up or down 

arrows to adjust the distance before 

or after the paragraph. Spacing is 

measured in points. You can also 

type a number directly. This document is 

currently using 8pt of paragraph spacing  After each paragraph. 

 

While entering text, users encounter many automatic features as 

they type, which include: 

Auto Type features  

Line Spacing 

Paragraph spacing 
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Spelling and Grammar 

In addition to the automatic spelling and grammar functionality, a 

user can manually 

check their document, 

and utilize extra 

functionality. To 

manually check the 

document for spelling 

and grammatical 

errors, the user can use 

the commands found 

under the Review tab. 

The keyboard shortcut 

to invoke this 

command is the [F7] key. In addition to the 

Spelling & Grammar check, the user can also 

utilize the Thesaurus and Word Count features to improve 

readability and accuracy. The thesaurus offers a collection of 

synonyms that can replace 

words that are used too often. It 

is a great tool for solving 

crossword puzzles! The Word Count is also 

automatically updated on the status bar.  

  

Spelling & Grammar 

Status bar 
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Selecting Text 

Aside from entering text, selecting 

text is probably the most common 

task for most Word users. 

However, highlighting text is NOT 

the same as selecting text. Alas, one 

must select text before one can 

highlight it! 

Almost every task 

begins by selecting something. Perhaps that’s why there are so many 

ways to select text? The following list is not comprehensive. 

Selecting Text 

  

This Photo by Unknown Author is licensed under CC BY-SA 

http://tex.stackexchange.com/questions/5959/cool-text-highlighting-in-latex
https://creativecommons.org/licenses/by-sa/3.0/
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Cut, Copy & Paste 

Editing a document often requires moving and duplicating text from 

one location to another. The process of 

moving text is commonly referred to 

as cut and paste. When data (text, files, 

graphics, etc.) is cut, it is removed from 

the document and placed into temporary 

memory via the Clipboard. The Cut 

process can be performed via the scissors 

icon on the ribbon, using the right-click 

shortcut menu or using the keyboard equivalent [Ctrl] + X. To paste 

the recently cut data, position the cursor in the desired location, and 

then choose Paste from the ribbon, shortcut menu, Paste Options 

screen tip, or the [Ctrl] + V keyboard shortcut. 

The Copy process can be performed 

to create duplicate data via the Copy 

icon on the ribbon, using the right-

click shortcut menu or using the 

keyboard equivalent [Ctrl] + C.  The 

paste process is the same no matter if 

the prior process is the Cut or Copy option. The paste process offers 

the paste options menu to allow the user to Keep the Source 

formatting, Merge the formatting from the source into current 

document, Keep the Text Only, or paste a picture of the selected 

data, instead of text. Data can be copied or moved within a 

document, between multiple documents or between multiple 

programs. This is a great example of how Microsoft Office is a suite 

of software applications that use common features to integrate data 

from one software application to another. 

 

Paste Options 
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Saving Files 

Once a document has been created, it should be saved as a file for 

future retrieval. The process of saving a Word document requires 

two essential elements: giving the document a filename and defining 

the location where the file will be stored. The save process can be 

initiated by clicking the Save icon on the Quick Access toolbar, 

choosing Save or Save As from the File menu or using the keyboard 

equivalents, [Ctrl + S] for Save or [F12] for Save As. The filename 

should be a unique, yet identifiable description of the file’s contents. 

The filename extension (.docx) is automatically added to filenames 

in Word. Once saved, the title bar will update with the new file 

name. The location of the file should also be given careful 

consideration. The user will likely choose between saving the file to 

the hard drive of the computer they are using or using cloud-storage 

to make the file more easily accessible from multiple devices. The 

Save command < will overwrite the existing file, while the Save As 

command will allow the user to change the filename or file location. 

 

  
This Photo by Unknown Author is licensed under CC BY 

https://anunlimitedamountofmoney.com/31-ridiculously-easy-ways-to-save-money/
https://creativecommons.org/licenses/by/3.0/
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Practice 1: The Solar System – Part 1 

1. Open the data file The Solar System.docx from the course 
data files. 

2. Correct the spelling errors by using the Spelling & Grammar 
tool from the Review tab. (Word should find four errors that 
need fixing) 

3. Select the two paragraphs of text at the top of page 2 
starting with The Asteroid Belt and concluding with ice and 
metal. 

4. Choose the Cut command using the shortcut menu (right-
click). 

5. Move the cursor to the blank paragraph before the 
paragraph starting with the text: The Outer Planets. 

6. Paste the data using the keyboard equivalent. [Ctrl] + V 

Use the [F12] keyboard equivalent to save the file with a new name 

(add the digit 1 after System) to your computer’s hard drive. 

 
Save As dialog 
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Finding and Replacing Text 

A document can be automatically searched for a specific character, 

word or phrase. Choosing the Find command on the Home tab will 

open the Navigation pane where search text can be entered. Matches 

will be displayed in the pane and highlighted in the document. 

Similarly, the Find and Replace feature allows users to make mass 

edits to a document. For example, a user might want to substitute 

the words teacher with trainer throughout a long document. Using 

the Replace command found in the Editing group of the Home tab, 

a user can choose to find and review or replace each occurrence 

individually or replace all occurrences in one step. 

The Advanced Find features are similar to the Find and Replace 

Search Options. To make the search more specific, Word allows 

users to define criteria, such as Match case or Find whole words 

only. These options will narrow the scope of returned results. For 

example, with the Match case check box selected, the text Mark will 

not be found if the word mark is entered as the search criteria. 

Conversely, the use of Wildcard characters will increase the search 

results. An asterisk character will allow any characters to be 

substituted. Therefore, check* will find checks, checked or 

checking. 

Creating Bulleted and 
Numbered Lists 

Formatting a list with bullets or numbers can help to organize the 

logic of a document. In a bulleted list, each item is a separate 

paragraph formatted with a hanging indent, a bullet (Ÿ), and a tab. 

The bullet character can be formatted to represent other symbols, 

such as check marks, squares or other symbols from the bullet 

library or custom-defined new bullets. Formatting a list with bullets 
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adds emphasis, but not priority. Each bulleted item is considered of 

equal importance, such as a grocery list. Conversely, a numbered 

list shows a priority or sequence. A typical recipe helps illustrate 

this difference: 

The ingredients and supplies are listed using bullets, because there 

is no distinction in their priority. However, the instructions utilize a 

numbered list, because the sequence is crucial to the process. 

 

To create a bulleted or numbered list, first select the paragraphs of 

text, and the select the appropriate option from the Home tab on the 

ribbon. Click the Increase Indent or Decrease Indent commands 

from the Home tab to format the list appropriately. To remove the 

bullets or numbering, place your cursor in the list and re-click the 

Bullets or Numbering command. 

Bullets and Numbered Lists 

Bullets & Numbering ribbon 
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Inserting Symbols 

Unique characters that don’t exist on your computer keyboard can 

be inserted into your document by selecting the Ω Symbol option 

from the Insert ribbon. Special characters such as the degree (º) or 

trademark (™) symbols can easily be inserted from the Symbol 

dialog window. Other popular symbols include graphics, shapes, 

and foreign language characters, such as the (é) used in the word 

résumé, which is a different word than resume. 

Symbol dialog 

In the Symbol dialog window, different sets of symbols will appear 

when different Fonts or Subsets are selected from their respective 

list arrows. The Webdings or Wingdings fonts offer a variety of 

graphics that can be inserted into paragraphs or as bullet shapes. 
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Inserting and Modifying 
Graphics 

It is said that a picture is worth a thousand words. This could be 

because graphic images make a document more interesting. You can 

insert photos from your computer or the web, edit them, compress 

them, resize and re-position them. Word 

offers a variety of graphics (from the 

Illustrations group of the Insert ribbon) that 

can be inserted into documents to add pizzazz 

to an otherwise dry document.  

A word-processing application differs from a 

text editor in part due to its ability to perform 

basic graphic design functionality. As shown 

in this textbook, the author has inserted 

graphic screenshots via the Pictures button on the Insert tab. The 

Insert Pictures only differ by where the source files reside. The 

This Device option will allow you to insert local pictures that reside 

on your local device. The Stock Images option provides Microsoft 

365 subscribers access to thousands of royalty-free images, icons, 

and more. Conversely, Online Pictures allows the user to insert 

images from the Internet using Microsoft’s Bing search engine or 
OneDrive, provided you have a OneDrive account set up.   

When inserting graphics obtained from the Internet, keep in mind 

that using someone else’s work without their permission is not only 

wrong but also may be illegal. US Copyright laws control how a 

copyrighted work can be used. Consider either using public domain 

images, which are free to use, or images distributed under a Creative 

Common license, which generally are free, as long as you provide 

attribution to the owner. The default search results in the Online 

Pictures option are Creative Commons licensed files.  
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Most of the images inserted via the Pictures and Online Pictures 

features are likely to be photos. Nonetheless, other common 

graphics include clip art, scanned artwork, 

icons, and shapes. Clip art differs from 

photos when the images consist of simple 

illustrations. This results in flexible file 

formats and small file sizes, which 

explained the appeal to early desktop 

publishers. However, increased computing 

resources have marginalized the benefits of 

clip art, and the rich quality of photos have 

diminished their demand. The once popular clip 

art option is hidden behind the Online Pictures feature. The keyword 

that is entered into the search box will, by default, retrieve photos, 

clip art, and other images. However, the filter option, 

which appears once the original results appear, can further restrict 

the results by image types, specific sizes. layouts or colors.  

Clip art example 
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A complete array of built-in shapes can be inserted to complement 

existing graphics. Popular shapes include lines, rectangles and flow 

chart symbols. 

Once a shape is 

selected, the user 

needs to draw it 

on a blank area of 

the document. 

Once inserted, 

the shape, like 

any other graphic 

object, can be 

resized and re-

positioned. To move the image, hover the mouse over the image 

until the pointer is the four arrows, then click and drag the image to 

your desired position. To resize a graphic, select the image and drag 

a corner sizing handle to resize it proportionately. The top/bottom 

or side handles allow the user to resize the graphic 

disproportionately. The rotate icon allows the user to rotate the 

object up to ± 360º. 
 

Once the graphic is selected, a new contextual tab called the Picture 

Tools tab will appear on the ribbon. This tab will allow the user to 

make a plethora of corrections and adjustments to the graphic. 

Picture styles, effects, layouts, and the image size are common edits 

to the defaulting graphic. To resize an image disproportionately, 

click the launcher icon in the bottom right corner of the Size group 

to open the Layout dialog window. Now unmark the Lock Aspect 

Ratio checkbox. 
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Perhaps the most common feature 

used in document layout 

considerations is the Wrap 

Text feature. By default, when 

pictures are inserted into a document, 

their layout is set to In Line with Text. 

This leaves a lot of unnecessary white 

space to the right of the image. To 

wrap text around a picture, select the 

picture, and then select a wrapping 

option (as shown in the image to the 

left of this paragraph). Popular 

options include Tight or Square. 

Utilizing WordArt and SmartArt 

Another desktop publishing tool that adds pizzazz to a drab 

document is the use of WordArt or SmartArt. WordArt is a drawing 

object with special effects that change the appearance of text by 

formatting special shapes, patterns and 

orientations. WordArt can be used to 

add color, outlines and 3-D effects to 

regular text. Common usage is titles for 

papers, posters or other marketing 

materials. Click the WordArt button in 

the Text group of the Insert tab. After 

selecting an initial WordArt style, a 

placeholder box will appear and await 

your input of text. Once inserted, a 

contextual tab offers numerous options 

to change the effects of the WordArt 

Text Wrap 
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object. Additional formatting options available include change the 

text fill, outline or text effects of the WordArt object. The Text 

Effects offer some exciting ways to rotate and transform the text. 

The best way to learn about these features is to experiment with 

them! 

 

SmartArt are diagrams that illustrate concepts and show 

relationships between elements. Think of SmartArt as pre-made 

drawing canvases that you can insert into your document and then 

customize as you see fit. There are a variety of styles to choose from, 

which you can use to illustrate many different types of ideas. Simply 

pick an arrangement, such as a list, process, cycle, etc. Insert the 

SmartArt via the Illustrations group on the Insert tab, which opens 

the SmartArt dialog window. 

After choosing a layout, a SmartArt placeholder will appear. In a 

SmartArt graphic, elements are represented by shapes. Each shape 

can have text applied, be resized and re-positioned. You can even 

add, delete, promote and demote shapes via the text pane or the 

contextual tab.  
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A SmartArt graphic can be formatted and edited using options on 

the contextual SmartArt Tools Design and Format tabs. The Design 

tab allows the user to pick from numerous layouts, styles and colors. 

The Format tab provides choices for shape styles and WordArt 

options. SmartArt can be utilized throughout the Microsoft Office 

suite of applications. Again, the best way to learn about these 

options is to experiment! 

SmartArt pyramid 

Inserting and Modifying 
Hyperlinks 

A hyperlink, often referred to simply as a link, is text or a graphic 

that, once clicked, “jumps” to a different location in the file or to a 

different software program. Software programs include e-mail 

applications, web pages or an external file, often created in 

Microsoft Office programs like Excel or PowerPoint. There are a 

few ways to insert a link into your document. Depending on how 

you want the link to appear, you can use Word’s automatic link 
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formatting or convert the text or graphic into a link. The fastest way 

to create a link in a document is to press ENTER or the SPACEBAR 

after you type the address of an existing webpage, such as 

www.minnesota.edu. Word automatically converts the address into 

a link. The same result occurs if the user were to enter an e-mail 

address, such as marcus.lacher@minnesota.edu. Hyperlinks have 

two parts: the address (URL) of the web page and the display text. 

In the two previous examples, the URL matches the display text, 

however it is possible to create a link to any word, combination of 

words, or an object, such as a picture or shape. 

Insert Hyperlink 

To create a link on a specific word or object to a web page, start by 

selecting the word(s) or object, and then click the Link button in the 

Links group of the Insert tab to open the Insert Hyperlink window. 

In the illustration below, a link is being defined to go to Microsoft’s 

website for the Word program. The text “Word” appears as the Text 

to display so that once the link is created, this text will appear with 

the hyperlink attributes, which are typically blue and underlined. 

The Address field contains the URL to the specific web page 

destination that will open in the current device’s default browser 

application. The Insert Hyperlink window fields will change 

significantly if the Link to: open on the left side is changed from 

https://products.office.com/en-us/word
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Existing File or Web Page to another option. To follow a hyperlink 

in Word, hold the Ctrl key and click the linked text or object. 

Borders and Shading 

Borders add interest and emphasis to your document. Borders make 

attractive frames for text, pictures, tables, or entire pages. You can 

customize borders to complement your document by experimenting 

with Word’s built-in styles. To add a border to text, select the text. 

On the Home tab, click the small down arrow next to 

the Borders button, and choose an option OR choose the Borders 

and Shading option to open the Borders and Shading dialog window. 

 

Make sure the Apply to box is set to Text, which adds a border 

around lines of text, or Paragraph, which creates a border that 
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outlines the paragraph. Also make sure that a choice, like Box, is 

selected under the Setting option. 

Shading is the color or artistic design you use as background for a 

paragraph. By shading words or paragraphs in Word, you can create 

visual interest in a document. The Highlight command offers a 

more limited color selection, which you can use when you review or 

edit a document to highlight specific text. The shading fill, style, and 

color can be defined from the Shading tab of the Borders and 

Shading window. To apply shading to a part of a document, select 

the data, then click the arrow next to Shading, and under Theme 

Colors, click the color you want to shade your selection. 

Shading palette 

Borders can also be added to pictures. Just select the picture, then 

choose a pre-formatted border from the Picture Styles gallery off 

the Picture Tools Format tab. 
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To remove the paragraph borders and/or shading, choose the None 

option in the Borders and Shading window. In the Shading tab 

choose the No Color item in the Fill section, then choose the Clear 

style in the Patterns section. 

Practice 2: The Solar System – Part 2 

1. Open the recently edited data file The Solar 
System1.docx from your data files. 

2. Find and Replace all occurrences of the word “mainly” with 
the word “primarily”. (Word should find three results that 
need changing) 

3. Select the four paragraphs of text starting with Mercury and 
concluding with Mars. Create a bulleted list. Repeat these 
steps using the paragraphs starting with Jupiter through 
Neptune. 
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4. In the paragraph following The Sun, replace 9000 degrees 
with 9000° using the symbol. (Character code 00B0) Repeat 
this step in the Venus paragraph by replacing 465 degrees 

with 465°.  
5. Insert an Online Picture of the sun in the blank paragraph 

above The Inner Planets. Resize the photo to be 1” x 2”. 
(Don’t forget to unmark the Lock Aspect Ratio checkbox in 
the Layout window) 

6. Apply the Square Wrap Text format to the picture, and 
position the image to the right margin. 

7. Apply WordArt to the text “The Solar System” using the 
Orange, Accent 2 fill. Apply the Top and Bottom Wrap Text 
format to the WordArt. 

8. Apply a hyperlink to the text Mars to a web page using the 
URL: http://nineplanets.org/mars 

9. Use the [F12] keyboard equivalent to save the file with a 
new name (add the digit 2 after System) to your computer’s 
hard drive. 

LICENSE 

 
Business Computers 365 by Marcus Lacher is licensed 
under a Creative Commons Attribution-NonCommercial-
ShareAlike 4.0 International License, except where 
otherwise noted.  

 

http://nineplanets.org/mars
https://mlpp.pressbooks.pub/businesscomputers2019
https://creativecommons.org/licenses/by-nc-sa/4.0/
https://creativecommons.org/licenses/by-nc-sa/4.0/
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Microsoft Word Chapter 2: 
Formatting Documents 

• Font and text attributes 

• Setting paragraph alignment and hyphenation 

• Utilizing the Format Painter 

• Indenting paragraphs 

• Setting tabs and tab stops 

• Creating and formatting tables 

• Inserting headers and footers 

• Setting page orientation and margins 
• Creating and inserting citations and bibliographies 

• Printing and saving files in alternative file formats 
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 Font and Text Attributes 

The way text appears on the screen, or a page is referred to as its 

format. Formatting text can enhance the appearance of a document, 

create visual impact, and help illustrate a document’s structure. 

Font, size, and style define a character’s format. A font is a 

complete set of characters with the same typeface or design. Dozens 

of fonts are available in the Font drop down list. Users can easily 

format text with fonts, colors, styles, and other formats by selecting 

the text and clicking 

various commands in the 

Font or Paragraph group 

on the Home tab. The Mini 

toolbar, appears faintly above text when you first select it, and 

includes the most commonly used formatting commands. The table 

below describes the functions of each button on the mini toolbar. 

Here are a couple of best practices when utilizing fonts. First, avoid 

using too many fonts in the same document. More than two or three 

fonts in the same document becomes distracting. Secondly, 

legibility and readability should be primary considerations. This 

should factor in the reader’s characteristics, and the purpose of the 

document. For example, while the default size for a font is 11pt, a 

larger size font (i.e. 14pt) might be more appropriate for an older 

aged reader. A pt (or point) is the equal to 1/72 of an inch. Headings 

and titles deserve larger font sizes. However, it is also good practice 

to limit the quantity of font sizes used in a single document. Lastly, 

consider using common fonts for professional and business 

documents. Calibri, Arial, Verdana and Times New Roman are 

ranked highly by Monster.com as preferable fonts for résumés, 

whereas Comic Sans is not recommended. Note that Calibri is only 

available on Windows operating systems, whereas Arial, Verdana 

and Times New Roman are some of the cross-platform available 

fonts. 
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Formatting buttons 

Setting Paragraph Alignment 
and Hyphenation 

Paragraph alignment determines how the edges of each paragraph 

aligns with the left and right margins. Alignment settings apply to 

all text within a paragraph. Remember that a paragraph is created 

each time the user presses the Enter key. To display the hidden 

characters, including paragraph marks, press the  symbol in the 

Paragraph group of the Home tab. Press the button again to hide the 

formatting marks. 
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• Left-aligned text is the default paragraph format. The left 

edge of the paragraph is flush, and the right edge is jagged. 

This option is typical for letters and reports. 

• Centered text is equally distant from the left and right 

margins. Common uses are titles and headings. 

• Right-aligned text is flush with the right edge, and the left 

edge is jagged. Typical uses are dates or headers and footers. 

• Justified-aligned text spreads the text evenly between the left 

and right margins, leaving both edges flush, unless the final 

line has limited characters. This option is common for 

newspaper columns and textbooks. 

Paragraph alignments 

Hyphenation can improve the overall readability of certain 

documents. Hyphenation is the process of adding hyphens to words 
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at the beginning 

of lines so the 

hyphenated part 

will fit at the 

end of the 

previous line. 

The hyphens 

are inserted 

between 

syllables in a word. Word can automatically hyphenate your 

document for you, or you can use the hyphenation tool to manually 

hyphenate your document. Users can customize their hyphenation 

settings via the Hyphenation Options dialog window. Use caution 

when manually inserting hyphens, because the hyphen will always 

remain even if editing moves the word to the middle of a line, and 

results in the word no longer needing hyphenating. 

Utilizing the Format Painter 

The Format Painter tool allows the user to copy a format from 

selected text and apply the format to other selections. For example, 

if you have inserted text in Word, and have it formatted using a 

specific font type, color, and font size, you could copy that 

formatting to another section of text by using the Format Painter 

tool. Select the text or place your cursor in the paragraph that 

contains your source formatting, then click the Format Painter 

tool from the Home tab’s Clipboard group. The cursor will 

change to include a paintbrush  , which indicates that the user 

can now select the destination text that should receive the source 

formatting. If multiple areas of text need the same formatting, the 

user should double-click the Format Painter tool to be able to apply 

the formatting to multiple selections, until the user presses the Esc 

key. The Format Painter tool works similarly in Excel and 

PowerPoint too. 
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Indenting Paragraphs 

Indenting a paragraph results in moving the editable insertion point 

from the left or right margins. Users can indent the left or right edge 

of a paragraph, just the first line, or all lines except the first line. 

Paragraphs are indented relative to the page’s margins and indenting 

a paragraph doesn’t affect the paragraph’s alignment. The default 

indents are 0 inches, meaning that lines of text extend from the left 

margin to the right margin. Indenting paragraphs can be performed 

by pressing the Decrease Indent or Increase Indent buttons on the 

Paragraph tab of the Home tab. Alternatively, to make precise 

changes to the Left and/or Right Indents or Paragraph Before/After 

Spacing, utilize the Paragraph group of the Layout tab. Indents are 

measured in inches and Spacing is measured in point, much like font 

sizes. 

 

A semi-block letter style requires the first line of each paragraph to 

be indented from the left margin, which is known as a first-line 

indent. Precise indent definitions can be specified in the Paragraph 

dialog window which can be opened by clicking 

the Launcher button in the Paragraph group. Alternatively, indents 

can also be set by dragging the markers on the ruler: 

Indent ruler markers 
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A first-line indent requires the user to drag the marker on the ruler 

to the position where the first line of the paragraph should begin. 

Typically, this is the .5” mark, which can also be accomplished by 

pressing the Tab key to indent the first line to the default .5” tab 

stop. A hanging indent occurs when the subsequent lines of a 

paragraph are indented more than the first. Hanging indents are 

often used when manually creating citations in a bibliography. To 

create a hanging indent, drag the marker on the ruler to the right. 

When citing long quotations in a research paper, users typically use 

both a left and right indent to offset the quotation, as shown below. 

 

Setting Tabs and Tab Stops 

Tabs allow users to align text vertically at a specific location in a 

document.  A tab stop is a point on the horizontal ruler that 

indicates the location at which to align text. A tab stop is a location 

where the insertion point will stop when the user presses 
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the key. Tab stops can be used to help align text to create 

columns of data. Custom defined tab stops are displayed on the ruler 

above the document. A set of default tab stops are located every half 

inch, but they do not appear on the ruler. When a new tab stop is 

defined, Word automatically removes the default tab stops to the 

left. Using tabs, users can align text to the left, right, or center of a 

tab stop, or text can be aligned at a decimal point. Word stores 

paragraph formatting, such as tab stops, in the paragraph marks at 

the end of a paragraph. Therefore, when the user pressing the 

ENTER key, tab stops are copied to the next paragraph. The same 

tab stops can then be used in sequential paragraphs to create columns 

of text. Tabs can be set by clicking on the horizontal ruler, or by 

using the Tabs dialog window. The following icons represent 

different tab stops on the horizontal ruler: 

 
Each type of tab stop is used in the example shown below. Note the 

markers on the ruler: 
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The default tab stop is Left, but tab  stops can easily be switched 

by multi-clicking the tab selector on the horizontal ruler. Existing 

tab stops on the ruler can be dragged to a new position if needed. To 

remove a tab stop, drag the tab stop off the ruler and release the 

mouse. The text will realign itself to the existing tab stops. Once the 

tab stops are in set, newly inserted text will align to the stops when 

the tab key is pressed. Alternatively, some users prefer to enter text 

with tabs, but 

without tab stops, 

and then apply 

the tab stops to 

the existing text. 

The Tabs dialog 

window is useful 

for adding new 

and editing 

existing tab 

stops.  The Tabs 

dialog window 

can be opened by 

double-clicking 

an existing tab 

stop or by 

clicking the 

Tabs… button in 

the Paragraph 

Dialog window, 

which is opened from the Paragraph Launcher button. The Tabs 

window is useful for precise position definitions, and it is the only 

option for adding Leaders to tab stops. A tab leader is a character 

that is repeated to fill the space spanned by a tab. The dotted leader 

is very commonly used on menus to make it easier to associate the 

menu description with its correlating price.  The Tabs window is 

also a convenient way to clear one or all tab stops in a document. 
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Practice 3: Wine Prices – Part 1 

1. Open the data file Wines unformatted.docx from your data files. 

2. Insert two blank paragraphs at the beginning of the document. 

3. Select the text Name in the first paragraph. Apply the Arial font, 

size 12, bold and red text color. 

4. Use the Format Painter tool to apply the same formatting from 

Name to Country, Color, Year, Type and Price. Hint: 

Double-click the Format Painter after placing the cursor in 

Name, and then click each the headings. Click the Format 

Painter tool again to turn it off. 

5. Select the text starting with Name through $16.99. Click the 

Paragraph Launcher button and then click the Tabs… button 

to open the Tabs dialog window. 

6. Set the following five tab stops: 

1. Center tab stop at the 1.5” position. (Type 1.5 in the Tab stop 

position field, then click Center, then click Set.) 

2. Left tab stop at the 2.15” position. 

3. Right tab stop at the 3” position. 

4. Center tab stop at the 3.75” position. 

5. Decimal tab stop at the 6” position. Add a dotted leader 

before clicking Set. Then click OK. 

7. A slight error may be noticeable. If you enable the 

Show/Hide , you should notice that there are two tabs 

between Country and Color. Remove one of the tabs. This 

should align the data into neat columns. 

8. Select the same block of text as step 5. Remove the 8 pt of 

paragraph spacing After each paragraph via the Layout tab. 

9. At the top of the document enter the text: Wine Prices. Center-

align the paragraph, and make the font 36pt and bold. 

10. Save the file with a new name: Tab formatted Wine Prices.docx. 

Your file should look like this: 
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Creating and Formatting Tables 

A table is a great way to organize information within a document. 

A table is a grid of cells arranged in rows and columns. Tables can 

be used to organize any type of content, whether you’re working 

with text, graphics or numerical data. Unlike tabs, table cells can 

have headers (in bold), as well as borders or boundaries, which make 

the information easier to read. A table typically includes headings 

that identify each column or row that contains data. The following 

is a 5×3 table, which means it has five columns and three rows. 

Sample table 

To create an empty table, click Table from the Insert tab, and move 

the cursor over the grid to select the number of cells for the table. 

Click the grid to create the table and then type text into the 

individual cells. Word automatically adjusts the column widths to 

be equal so that the table fills the space between the left and right 

margins. To manually adjust the width or height of a cell, drag the  



 
Word Chap 2 Page | 56 

 

 

border. Press the Tab key to move from cell to cell. If the insertion 

point is in the last cell, pressing the Tab key will automatically add 

a new row. 

If the number of rows and columns created turns out to be different 

than what is needed, you can easily add or delete rows and columns 

via the Table Tools Contextual tab. The Layout side of this tab will 

also allow the user to change cell size, merge & split cells, sort table 

data, change text alignment, and modify the table properties. 
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The Table Tools Design tab offers additional functionality to modify 

Word tables. Design elements include defining Table Style Options, 

like Header and/or Total Rows, selecting from a gallery of Table 

Styles, as well as adding shading and borders. You can easily insert 

and delete table rows and columns via this tab as well. 

 
It is possible to create a table from text that already exists. However, 

the data must be consistently separated, field-by-field, using a 

delimiter. A delimiter can be tabs, 

paragraphs, commas or some other 

user-defined character which is 

used to separate each field. With 

the cursor residing inside the 

existing source data, select the 

Convert Text to Table… option 

from the Table tab of the Insert 

ribbon. 

Clicking an option from a menu 

that ends with the ellipsis notation 

(…) indicates that a dialog window 

will appear. The Convert Text to 

Table dialog window allows the user to define the table size, AutoFit 

behavior, and the delimiter. 
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The contents of the rows in a table can be sorted based on a column. 

Users can sort in alphabetic (text), numerical (numbers), or 

chronological (dates) order using either Ascending (A → Z) or 

Descending (Z → A) manner. Clicking the Sort button on the Table 

Tools Layout tab will open the Sort dialog window. 

The Sort by options will be the column headers, or Column 1, 

Column 2, etc. if there is No header row. The first sort selection is 

known as the primary sort, followed by the secondary, and tertiary 

sort options. The Type drop-down list will offer the choices of Text, 

Number or Date, depending on the existing table data. Make sure to 

choose either Ascending or Descending for each sort level. 

Inserting Headers and Footers 

A header is the area at the top of a page, and a footer is the area at 

the bottom of a page. Headers and footers consist of one or more 

lines of text, page numbers, graphics, and other fields, such as the 

file name, document title, current date and/or time, or author’s name. 
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To create a header or 

footer, click either 

the Header or Footer 

drop down list from 

the Insert ribbon. 

A gallery of built-in 

designs is displayed. 

Clicking a built-in 

design makes the 

header or footer the 

active area of the 

document, while the 

body of the 

document fades to 

the background. A 

header or footer has 

three sections: left, 

center, and right. The 

user can either type 

text into existing 

placeholders, or 

insert fields from the 

Header & Footer 

Tools Design 

contextual tab, 

which only appears 

when the cursor is 

placed in either the 

header or footer. 

To return to the body of the document, double-click in the document 

body, or click the Close Header and Footer button on the Header & 

Footer Tools Design tab. Double-click in the header or footer area 

to make it active and allow for editing. 

Header gallery 
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The header or footer is printed on each page of the document. To 

specify a different header and footers for the first page, select the 

Different First Page checkbox on the Options group of the Header 

& Footer Tools Design tab. Any existing header or footer will 

automatically be removed.  A different first page is common in long 

documents to prevent the cover page from including the headers and 

footers contained in the rest of the document. A cover page usually 

does not include any header or footer data. 

One of the most common purposes of headers and footers is to 

include page numbers. Page numbers are helpful in documents that 

have more than one 

page. To add a page 

number at the current 

location in an existing 

header or footer, click 

Page Number > 

Current Position, and 

then choose a style 

from the gallery of 

choices. Scroll 

through the list of 

style options in the 

gallery to find one you 

like. You can select a plain number style, or a Page X of Y style to 

get a more defined starting and ending number (Page 1 of 7) format. 

Experiment to find the style that best meets your needs. 

Header & Footer Tools tab 
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An inserted page number can be further formatted as needed. 

Number formatting and different starting page numbers can be 

defined in the Page Number Format dialog window, which is 

opened when the 

user selects Format 

Page Numbers…. 

from the Page 

Number drop down 

list. Number 

formats include 

Arabic, alphabet, 

and roman numeral 

formats. 

The Page 

numbering options 

allow a user to 

restarting the page 

numbers at a user-

defined number. This can be useful to recognize unnumbered pages 

that precede the main part of the document. 

In the Position group, you can control the amount of space allotted 

to the header and footer. By default, each is 1/2-inch tall. Users can 

change these values in the Header from Top and Footer from Bottom 

list boxes. Manipulating these selections will affect the printable 

area of the document’s margins. 

It is a “best practice” to add page numbers before adding other 

header and footer fields, because any existing text will be replaced 

by adding page numbers using the Insert > Page Number process. 

Alternatively, users can add page numbering to existing header and 

footer text through the Quick Parts feature, which is not explained 

in this text. Other than page numbers, headers and footers often 

contain the document’s author, date and/or title. Each of these fields 

help identify the document, particularly when the document is 

printed and compared with other similar documents. 
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Setting Page Orientation and 
Margins 

The page setup of a document includes settings such as margins, 

orientation, and other pagination settings. These settings can be 

applied to the entire document, or specific sections, which can be 

created by inserting section breaks (not explained in this text). The 

Page Setup group found under the Layout tab contains these 

selections. 

Page orientation refers to how a rectangular page is arranged for 

viewing. The orientation of a Word document can be either portrait 

or landscape. Portrait orientation is taller than 

it is wide (vertically), and landscape 

orientation is wider than it is tall 

(horizontally). The default orientation is 

portrait. 

Choosing a page orientation needs to consider 

the paper size selected for the document. The 

standard 

paper 

size in 

North America is called Letter, 

which has the dimensions of 

8.5” x 11”. Legal documents are 

14” instead of 11”, which 

means when printed in portrait 

orientation, legal documents are 

three inches longer (and a pain 

to fit in a standard folder!). The 

standard paper size in Europe is 

known as A4. Its dimensions 

are 210mm x 297mm, which is 

closer to the Legal size, than the 
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Letter size. Many posters and tables are often printed on Tabloid 

sized paper, which is 11” x 17”. However, since a lot of home 

printers cannot accommodate this size of paper, many users choose 

to change their orientation to landscape, which changes the printable 

width to 11”, and the printable height to 8.5”. If adjusting the 

orientation doesn’t solve the layout challenges of the document, 

consider adjusting the margins! 

Margins are the white space surrounding the text on a page. 

Margins can be specified for the top, bottom, left and right edges of 

a document. The default margins are 1” each, but margins can easily 

be adjusted from the pre-set choices in the Margins drop-down list, 

or by manually adjustments in the Page Setup window, which can 

be opened by clicking the launcher button in the Page Setup group 

in the Layout tab. Narrow margins leave more room for more data, 

while wider margins decrease the amount of printable space. 

Similarly, larger top and bottom margins decrease the available 

space. If adjusting orientation and margins aren’t enough to resolve 

page formatting, consider using page breaks. 

Pagination is how a document is divided into pages. Word 

automatically determines how much text will fit on a page based on 

the amount of text and the document formatting. As new data is 
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added to a page, Word creates automatic page breaks, also known 

as soft page breaks. To force data to a new page, a user can insert a 

manual (hard) page break. Inserting a page break moves the text 

after the insertion point to the next page. To insert a page break, 

press Ctrl + Enter or click Page Break from the Insert tab. To remove 

manual page breaks, utilize the Show/Hide button to display 

formatting marks, such as the Page Break 

mark:  

To remove a hard page break, place the insertion point to the left of 

the page break and press the Delete key. Word will re-paginate 

itself and move data to the previous page. 

Creating and Inserting Citations 
& Bibliographies 

Many college courses require students to write research papers. 

While conducting the appropriate research may be the main 

objective of the assignment, collecting the research is often not as 

challenging as documenting the sources of the research. Part of the 

challenge associated with properly documented sources is 

understanding the format of the required style guide assigned by the 

instructor. A style guide is a set of standards for creating documents 

and citing of sources. A citation, or a reference, is a formal 

acknowledgement to a published or unpublished source. The 

purpose of using citations is to give credit to the author of the 

original research and avoid plagiarism. Plagiarism occurs when a 

user presents the data of another author as if it were their own. The 

major writing style guides include MLA, APA, CSE, and Chicago. 

Each style has unique requirements for handling citations. 

A typical requirement of a research paper is the production of a 

bibliography, a Works Cited or References page. A bibliography is 

an alphabetic list of the sources used to produce a scholarly work. 
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Each style guide has different requirements for what data is needed 

to be listed for each source. The bibliography helps the reader 

identify the source of the writer’s research. Manually creating a 

bibliography can be a tedious and inexact process and updating a 

manually-generated bibliography will likely induce heartburn. 

However, by carefully entering sources into Word, a bibliography 

can be accurately generated and re-generated with ease. 

Before a user can create a 

bibliography, they must create at 

least one citation and source in 

the document. Whenever a 

source is referenced in a 

document, the user should create 

a citation to give the original 

author credit. To add a citation, 

place the cursor in the desired 

location (follow the style guide), 

and click Insert Citation from the References tab, then choose Add 

New Source… 

 
The Create/Edit Source dialog window will appear where the user 

can enter as much information regarding the source as possible. The 

first field, Type of Source, will dictate which bibliography fields are 
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needed for the source depending on the specific style guide.  After 

entering the publication details, and clicking OK, the citation will 

appear in the document, and the source will be saved. 

 
Types of sources can include books, a web site, an article in a 

periodical, a sound recording, and many more. Often, a single source 

can be cited numerous times in a report. 

Users can easily add the citation again by 

clicking the Insert Citation drop down 

button from the References tab and 

selecting the source from the drop-down 

menu. A citation can be edited to add 

page numbers. Open the citation’s inline 

drop-down menu and choose Edit Source. 

Certain fields can even be suppressed. 
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After completing the paper, adding all the sources for the document, 

and completing the summary, adding the bibliography or works 

cited is extremely easy! Typically, a bibliography will reside on its 

own page. Therefore, create a manual page break, and then on the 

References tab, in the Citations & Bibliography group, choose the 

Bibliography option and choose from the pre-designed formats to 

insert the Bibliography or Works Cited into the document. 

 

The bibliography appears and the sources are formatted to match 

the selected style guide. If the user ends up adding more sources to 

the document, they can easily update the bibliography by clicking 

it and selecting Update Citations and Bibliography. 
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Printing and Saving Files in 
Alternative File Formats 

Before printing a document, it is a good idea to preview the 

document and specify which pages should print. The preview might 

help the user discover some layout issues that can be addressed 

before wasting ink/toner and paper. The Print Preview window can 

be accessed in Backstage view by clicking File > Print. It is also a 

popular idea to add the Print Preview command to the Quick Access 

toolbar if it doesn’t already exist. 

Print Preview 

Numerous options can be defined in Backstage view, such as which 

printer, how many copies, which pages, etc. Once these decisions 
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are made, pressing the big Print button in the top left of the window, 

will send the data to the selected printer. The back button  will 

exit Print Preview. 

If printing a hard copy is not desired, saving the file is the obvious 

alternative. The way that the user saves a document and the format 

that they save it in depends on how they plan to use the 

document. While choosing Save from the File menu will resave the 

file in its existing format, choosing the Save As command (F12) 

provides numerous alternatives. 

The first option available by using the Save As dialog window, is 

the ability to choose an alternative storage destination versus the 

existing location. Alternate storage destinations include a different 

file folder on the user’s hard drive, a portable file storage location, 

such a USB drive device, or a cloud-based storage location. 

OneDrive is Microsoft’s cloud-based storage option, but other 

cloud-based solutions, such as Dropbox, exist as well. Cloud 

computing requires Internet-connectivity to access the current 

versions of the files. An alternative file format is another option to 

consider from the Save As window. Choosing the drop-down list to 

the left of the Save button displays a list of alternative file formats. 
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One of the most common alternative file formats is a PDF (Portable 

Document Format) file. PDFs are popular formats to share with non-

Microsoft Office users, commercial printers, and users for whom the 

document is not to be edited. The PDF format looks the same on 

most computers, has a smaller file size, and preserves most 

formatting characteristics of the source document. The only 

software that is required to read or print a PDF file is Adobe Reader, 

which is available as a free download from Adobe’s web site. While 

prevention of editing was a key feature of PDF files, the current 

version of Word can actually edit PDF files, however, the edits are 

traceable. 

The other common file format is saving a file to be viewed on a web 

site or simply in a web browser. Saving a file as a Single File Web 

Page is the optimal approach to allow users to open the document 

using a web browser. The file extension of a single file web page is 

.MHT. Other occasionally used file formats include: .XPS, .ODT, 

and RTF. 

Practice 4: The Solar System – Part 3 

1. Open the recently edited data file The Solar 
System2.docx from your data files. 

 



 
Word Chap 2 Page | 71 

2. Create a 2 x 9 table at the end of page 2. 
3. Add and format data to table as shown to the right. 
4. Add a new column to the table to the left of the Name 

column. The header should be Proximity to the Sun. The 
data should be 1, 2, 3 …. 8. 

5. Sort the table in descending order by Number of Moons. 
6. Apply the Grid Table 4 – Accent 4 table style to the table.

 
7. Add the file name field to the left side of the footer, and the 

Accent Bar 2 page number to the center section of the 
footer. Refer to the illustration at right for steps 4-8. 

8. Change the paper size to Legal. 
9. Insert a page break before the paragraph beginning with 

The Dwarf Planets. 
10. Change the margins to the Office 2003 defaults. 
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11. Add a new citation source following the period at the end of 

the paragraph regarding the Sun on page 1. The source 

details should be a web page (The Sun) on a web site (Nine 

Planets). Use today’s date for the Year, Month, Day, and the 

URL: nineplanets.org/sol.html. Mark the Corporate Author 

checkbox. 

12. Add a Works Cited at the bottom of page 2.  

13. Save the file with a new name. i.e. The Solar System3. Save 

another version of the file in PDF format. 
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Microsoft Excel Chapter 1: 
Spreadsheet Basics 

• What is a Spreadsheet? 

• Entering, Selecting and Inserting Data 

• Manipulating Sheets 

• Formatting Worksheets 

• Creating Formulas to Perform Calculations 

• Copying and Pasting Formulas 

• Adding Basic Functions to Formulas 

• Inserting Headers and Footers 

• Adjusting the Page Layout and Preparing to Print 
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What is a Spreadsheet? 

A spreadsheet is a collection of data that is organized into rows and 

columns. Microsoft® Excel is a spreadsheet application used to 

store and analyze quantitative data. An Excel file is called 

a workbook, and it is saved with an .xlsx extension. A workbook 

file consists of one or more worksheets which consists of many 

columns and rows. Columns are the vertical part of a worksheet 

grid identified by letters. Rows are the horizontal part of a worksheet 

grid identified by numbers. The intersection of a row and column is 

called a cell. Each cell can store a single item of data. The data can 

contain text, numbers, formulas, and/or functions. Clicking a cell 

with the mouse pointer will make the selected cell the active cell. 

The active cell’s contents are displayed in the formula bar. 

Typical uses for Excel include: 

• Accounting reports (Balance Sheets, Income Statements, 

etc) 

• Budgets 

• Calendars 

• Checklists and task lists 

• Contact/Address lists 

• Expense tracking 

• Inventory control 

• Invoices 

• Mortgage and other financial calculations 

• Operational statistics 

• Sales price lists, forecasts and analysis 
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Entering Data 

Excel is great tool for generating useful information from data. 

However, the data must be entered before it can be analyzed and 

manipulated. There are numerous types of data, and numerous ways 

to streamline data entry. As data is typed, it appears in the active cell 

and in the formula bar. Pressing the Enter key will complete data 

entry and make the next cell in the column the active cell. If moving 

to the next cell after completing data entry is not the desired 

outcome, try clicking the Enter check mark in the formula bar. The 

data will be entered, but the active cell remains the current cell. 

Pressing the Esc key before completing data entry will cancel data 

entry and restore the original cell contents. 
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Streamlining data entry in Excel can be accomplished using several 

different features including keyboard shortcuts and Automatic 

Completion. Keyboard shortcuts allow rapid navigation in a 

worksheet without having to use the mouse. There are hundreds of 

keyboard shortcuts available in Excel and many are also available 

in other Microsoft Office applications. A few keyboard equivalents 

are illustrated at right, but for more examples, use the shortcut F1 to 

open the Help pane, and type keyboard shortcuts in the Excel Help 

field. 

When entering data into a sheet that contains a lot of duplicates, 

Excel uses the Automatic Completion feature to speed up data entry. 

After typing a couple of characters, Excel guesses how to fill the rest 

of the cell based on data previously entered in the cells above. To 

accept the suggestion (in highlighted text), press Enter, or 

alternatively, continue typing to replace the automatic entry. 
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Selecting Data 

After entering data, a common practice is to begin formatting the 

data. However, before a user can format the data, they must first 

select the data. Selecting data has multiple techniques based on user 

intent. Clicking on a single cell makes that cell the active cell. The 

cell reference appears in the Name box to the left of the formula bar. 

To select an entire column of data, just click the column letter 

heading. To select an entire row, click the row number heading. If a 

user wants to select several cells adjacent to each other, this would 

be considered selecting contiguous cells. Clicking the middle of the 

cell and dragging horizontally or vertically will select 

a contiguous range of cells. Another way to select a contiguous 

range of sequential cells is to click the first cell, hold down the Shift 

key, and click the last cell in the range. For example, clicking cell 

A3, and then holding down the Shift key and selecting F7 would 

select all of the cells from A3 through F7. The range reference would 

be written as A3:F7. 

 

Selecting a non-contiguous range of cells requires the use of the Ctrl 

key. To select non-contiguous cells, click the first cell, hold down 

the Ctrl key, and click each additional cell. This practice is 
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sometimes referred to as “cherry-picking” cells. In the example 

below, the selected range of cells are A4,A6,A7,F4,F6,F7. This 

practice can be used for selecting non-adjacent rows or columns as 

well. 

 
To select the entire worksheet, click the triangle box located to the 

left of column A and above row 1, or by pressing the keyboard 

shortcut: Ctrl+A. 

Inserting Data 

It is usually easy to add data to an existing worksheet, because Excel 

has seemingly unlimited columns and rows of cells. (There are 

limits, but this is not Jeopardy!) Nonetheless, sometimes it is 

necessary to insert a column or row into the middle of an existing 

range of cells. To insert a new column, select the column heading to 

the right of where you want the new column to 

appear, and click the top-half of the Insert button 

from the Home tab. Alternatively, just right-click 

the column heading to the right of the destination, 

and choose Insert from the Context Menu. Deleting 
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columns is very similar. Whichever column(s) that are selected will 

be deleted if using the Delete button instead of the Insert button. 

Inserting and deleting rows is also very similar. Selecting the row 

below the intended new row and either choosing Insert from the 

ribbon or from the Context Menu will create a new row above the 

selection. For example, right-clicking row 10, and choosing Insert 

from the Context Menu will create a new, blank row 10, and all 

existing data will move down one row. 

Using the right-click method is a little faster than clicking the 

worksheet and then clicking the ribbon, as the shortcut menu avoids 

the need to move the mouse to the ribbon. The Context Menu, also 

known as Shortcut Menu, provides added functionality by offering 

actions that can be taken with the selected item. In addition to 

inserting and deleting, formatting column widths and row heights, 

as well as hiding and unhiding columns and rows are options from 

the Context Menu. Adjusting the column width is a common action 
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since excessively wide columns 

prohibit efficient worksheet 

printing. Therefore, it is often 

preferable to widen a column width 

by double-clicking the boundary 

bar that separates the column 

heading letters. This is known 

as auto-fitting the column width since the column will resize its 

width to be just wide enough to display the longest data contained 

in that column. Clicking and dragging the double-arrow pointer to 

the left or right allows users to manually adjust the column width. 

Manipulating Sheets 

An Excel workbook consists of one or more worksheets. Much like 

a binder can have multiple sections of sheets divided by colorful 

tabs, an Excel workbook can multiple sheets that can be re-arranged, 

colored and renamed to fit individual organization plans.  Inserting 
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and deleting worksheets is similar to the inserting of columns and 

rows. In addition to using the Insert or Delete buttons from the 

ribbon, right-clicking an existing sheet tab will produce a Context 

Menu with a plethora of options. 

Just as inserting a new column will add the column to the left of the 

selected column, the newly inserted worksheet will appear to the left 

of the selected sheet tab. Options exist to insert a blank worksheet 

or a new sheet based off of an existing template. Clicking and 

dragging sheet tabs are easy method to rearrange the order of sheets. 

However, the Move or Copy… command offers the opportunity to 

move or place a duplicate sheet within an existing, open workbook. 

Adding tab colors and the Rename option can help organize sheets 

to user-specific criteria. Sheets can also be hidden and unhidden. If 

it is necessary to prevent others from unhiding sheets, the workbook 

can be protected with a password to be able to modify the sheets. 

The tab scrolling buttons to the left of the sheet tabs are enabled 

when too many sheets exist to be displayed above the status 

bar. To quickly add a new, blank sheet to the workbook, 

click the plus button to  the right of the sheet tabs. 

Formatting Worksheets 

Formatting data generally makes it easier to comprehend, and more 

attractive. The goal of formatting a business spreadsheet should be 

to make it look professional, accurate, and understandable. Options 

to format worksheet data depends a lot on the type of data. 

Formatting text in Excel is very similar to formatting text in Word. 

Using the Font and Alignment group icons on the Home tab of the 

ribbon, users can manually format all of the data in a cell or in a 

range of cells. Changing default formats includes things like 

changing the font color, style, size, text alignment in a cell, or apply 

formatting effects – all in an effort to make the data appear more 

visible. 
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Excel’s tabular layout (organized into labeled columns and 

numbered rows) sometimes limits the amount of data that can be 

efficiently displayed. Using the Alignment group options can help 

format data to make it appear as much like a word-processed report 

as possible. In the screenshot above, two Excel-unique formatting 

features help make the data more readable. In row 1, the text has 

been merged and centered across cells A1:F1. This required the cell 

range A1:F1 be selected before clicking the Merge & 

Center button from the Alignment group. This is very popular for 

worksheet titles. If the wrong cell range was selected and the Merge 

& Center is not effective, the user must re-select the Merge & Center 

button to unmerge the data, so the correct range can be selected 

before again clicking the Merge & Center button. 

Another popular Excel text-formatting feature illustrated above is 

the Wrap Text tool, which will prevent text from being truncated 

by wrapping the text into multiple rows within the same cell. If a 

cell has a lot of text, the data will overlap into the next cell to the 

right of the active cell. However, if the adjacent cell already has data, 

the text will be truncated (cut-off) without applying this feature. 

Cells C3:E3 in the above screenshot each have the Wrap Text 

feature applied. 
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While Excel has some pretty useful text-formatting functionality, 

the majority of data entered into Excel is usually numerical data. 

Therefore, utilizing Excel’s number formats effectively is crucial to 

make the worksheet as professional as possible. Professional 

formatting relies a lot on consistent formatting. Therefore, using the 

Format Painter tool (introduced in the Word chapters) and 

workbook themes are very helpful to maintain that 

consistency.  Changing the existing theme will dynamically update 

the appearance of all worksheets in a workbook by modifying the 

fonts, styles, colors and/or effects. 

Applying the correct cell format to numerical data is more than just 

style – it is substance too, because applying the wrong format can 

impact how other, related cell results are interpreted. The following 

graphic describes some of the more popular number formats. In 

addition to the examples provided, there are also other formats, 

including date & time values, which can be accessed by clicking the 

Number Format drop-down list. 

 

Changing the number of decimals displayed can be manipulated by 

the Increase Decimal and Decrease Decimal buttons in the Number 

group. The displayed value could change to a rounded value, 

however, the actual value stored in the cell has not changed unless a 

ROUND function has been applied. Formatting only affects how the 

value is displayed. Applying formats can result in number signs 

(#####) being displayed in a cell. This is not an error, but an 

indication that the cell width is not wide enough to display the 

formatted number. 
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Excel data can also be formatted as a table. A table is a collection 

of related data, organized into a tabular layout of rows and columns, 

that can be manipulated via sorting, filtering and formulas. To create 

a table, select the data and click Insert > Table from the ribbon to 

open the Create Table dialog window. 

Table style Blue, Table Style Medium 16 with banded rows, a header 

row, and filter buttons. 

Applying a table style will format the table with a predefined set of 

special table properties that includes options to define a header row 

or total row, and to band the row and/or columns to make the data 

easier to read. The filter buttons can also be removed. If the table 

functionality is no longer desired, click the Convert to Range option 

in the Tools group of the Design tab to convert the table to a normal 

range. 
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There are many additional formatting tools available within Excel, 

but it is important to consider that sometimes, less is more! Too 

much formatting can be overkill and reduce the readability of a 

worksheet. Try to limit the use of multiple colors, fonts, and 

background colors/graphics. Format with a design purpose, not to 

entertain, and don’t forget to use the Spell Check tool (F7) to proof 

your workbook before printing or sharing! 

Creating Formulas to Perform 
Calculations 

Perhaps the biggest benefit of using Excel is its ability to create 

formulas that, when written correctly, can dynamically update when 

predecessor data is updated. Formulas are mathematical calculations 

using data in the existing workbook to calculate new values. All 

formulas in Excel must begin with an equal sign (=), and can contain 

cell references, ranges of cell references, arithmetic operators, and 

constants as part of the formula’s syntax. Calculations in Excel 

follow normal math rules as it pertains to the order of operations 

rule. There are mnemonics available in various dialects to help 

decipher the order. The following graphics illustrate the order of 

operations rules and different formula syntax examples: 
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Formulas typically reference values stored in other cells. For 

example, in the Accounting equation: Assets = Liabilities + Owner’s 

Equity, one could calculate the Owner’s Equity using a formula. 

Assume that the value for Total Assets resides in cell D30, and the 

value for Total Liabilities resides in D60. The formula for Owner’s 

Equity in D65 using cell references would be =D30-D60. Using cell 

references is advantageous because if any of the cells that generate 

either the Total Assets or Total Liabilities is changed, the formulas 

in D30, D60 and D65 will also get updated. Another advantage is 

when a cell containing a formula is copied to another location, the 

formula will dynamically update to the new location’s reference 

information. This is called Relative Cell Referencing. If the 

formulas in column D are copied to column E, the new formula for 

Owner’s Equity in column E will be =E30-E60. Additionally, if 

rows are added or deleted in the range that the Total formulas 

reference, the formula will automatically update to the new formula 

range.  

Entering the syntax for a formula can be accomplished through 

typing the formula components, using a pointing technique or a 

combination of both. The pointing method can help avoid typing 

errors. In the Owner’s Equity example, the user would start by 
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typing the equal sign, and then instead of typing D30, just click on 

D30. Continue by pressing the minus sign, and then click on cell 

D60, and the click the Enter check mark on the formula bar. Using 

the point method is even more practical when defining large cell 

ranges in formulas. Just make sure not to reference the active cell in 

the formula. This will likely create a circular reference error, 

which is a formula in a cell that directly or indirectly refers to its 

own cell. 

 

Copying and Pasting Formulas 

Data in Excel can be cut, copied and 

pasted using similar shortcut menu 

options, keyboard equivalents, and ribbon 

icon commands as seen in Microsoft 

Word. Following operating system file 

management principles, moving data is 

synonymous with using the “Cut” and “Paste” commands, while 

duplicating data is the same as using the “Copy” and “Paste” 

commands. Other terminology that should be recognized is 

“source”, which is the cell or range to be moved or duplicated, and 

“destination”, which is the upper-left cell in a worksheet where the 

data is to be pasted. 

  

This Photo by Unknown Author is licensed under CC BY 

https://googlesystem.blogspot.com/2012/03/google-docs-and-clipboard-access.html
https://creativecommons.org/licenses/by/3.0/
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Copying and pasting formulas contain cell references is a very 

powerful feature, and to expedite this process, Excel has a nifty 

feature called AutoFill. The AutoFill procedure utilizes the fill 

handle, which is the solid, green square in the lower-right corner of 

the active cell or cell range. Clicking and dragging the fill handle to 

adjacent cells (horizontally or vertically) will copy and paste the 

contents and update the destination cells with relative cell references 

or sequential data aligned with built-in Custom Lists. This should 

save significant time, and likely improve accuracy, and AutoFill has 

many uses. 

Not only can AutoFill copy formulas, but it also be used to complete 

lists that have a recognizable pattern. It is helpful to select the source 

cells that demonstrate a pattern, then hover the mouse pointer over 

fill handle. The mouse pointer will change from the default pointer 

icon to a thin, black plus sign. The patterns can be numbers, dates, 

months, days of the week, etc. If AutoFill incorrectly guesses the 

series pattern, the AutoFill Options icon is available to change the 

paste actions. In the screenshots below, the fill handle in cell D5 will 

by copied to cells D6:D13. The results shown in the second 

screenshot will update the formula from D5 with relative cell 

references to rows 6:13. What is happening in cells D7:D8? 
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Practice 5: Test Scores 

1. In a new Excel workbook, enter the following data:  

2. Make sure to apply bold formatting to row 1, and text 

wrapping to cell E1. 

3. Format the data as a table with a header row and banded 

rows, but no Filter buttons. 

4. Apply the Facet theme. 
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5. Ensure that cell E1 has the text wrapping format applied and 

then resize the column width of column E to be 7 points wide 

and the height of row 1 to 36 points. 

6. AutoFit columns B, C & D. 

7. In cell E2, enter the following formula: =B2+C2+D2 and 

click Enter. Your worksheet should look like the screenshot 

at right. Notice that Excel automatically filled in formulas 

for the rest of column E cells using relative cell references! 

If this action is unwanted, click the lightning icon, and 

choose to Undo the Calculated Column. 

8. Press F12 to invoke the Save As command and save the file 

as Test Scores.xlsx. 
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Adding Basic Functions to 
Formulas 

Excel contains over 400 built-in functions that can be included in a 

formula to perform common calculations. A function performs a 

calculation on data called arguments to compute a 

result. Arguments are variables or values the function requires and 

are contained within parenthesis, and usually consist of cell 

references, but can also contain constants, text, cell ranges, and even 

other functions! The syntax of a formula using a function 

is: function name(argument1, argument2, etc.) Functions can be 

typed with the help of a ScreenTip, or added from the Insert 

Function window, which can be opened by clicking the symbol 

found at the left of the formula bar, or at the left side of the Function 

Library found in the Formulas tab of the ribbon. 

The most popular functions are also the easiest to comprehend, 

which might be correlated! Some of these most popular functions 
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are easily accessible from the AutoSum button in the Editing

 group on the Home tab of the ribbon. Look 

for the Greek sigma symbol. This feature is invaluable when it 

comes to entering functions, especially for common calculations 

computed via the SUM, COUNT, AVERAGE, MAX or MIN 

functions. There are multiple ways to utilize AutoSum, but the 

following procedure is probably the simplest. In the screenshot 

below, assume the desire is to total the number of boxes of Thin 

Mints cookies were sold the first 15 days of February. Make B19 

the active cell (the destination cell), then click the AutoSum button. 

The defaulting SUM option will be inserted into the formula bar 

with a defaulting cell range (the source cells) inside parenthesis. The 

cell range that defaults appears on screen with a scrolling marquee 

surrounding the cell range. This range is usually correct, but not 

always. If Excel chooses the wrong range, simply type in the cell 

range, or use the mouse to re-select the correct range (pointing 

method), and then click the Enter check mark. 
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The formula that defaults should be =SUM(B4:B18). Once this 

formula is submitted, the result, 97 will display. The intent of 

the SUM function is self-explanatory.  The AVERAGE function 

takes the SUM function one step further by dividing the sum of the 

values by the number of cells in the range. 

The MIN and MAX functions are used to find the smallest and 

largest values in a range of cells. These can be useful to identify 

outlier data that might skew the results. Each of these functions 

ignore cells that contain text or are empty. Alternatively, 

the COUNT function totals the number of cells that contain values. 

If a cell contains the value 0 (zero), it will be counted. However, if 

the cell is blank or contains the text zero, the cell will not be counted. 

This function is useful for determining the number of people who 

mark a checkbox in an Employee roster. For example, how many 

employees identify as a Veteran? Those who don’t, wouldn’t have a 

value, and therefore, would not be counted. If the desire if to count 

all cells that contain any data – use the COUNTA function. 
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Inserting Headers and Footers 

In Excel, headers and footers are lines of data that print at the top 

(header) and bottom (footer) of each page in a worksheet to help 

identify printouts. Headers and footers can contain descriptive text, 

graphics, and/or fields, such as titles, dates, or page numbers. 

Header and footer information does not display in Normal view, so 

to edit a header or footer, click Insert > Header & Footer to open the 

sheet in Page Layout view, and activate the Header & Footer Tools 

contextual tab on the ribbon. There are left, center and right sections 

for both the header and footer areas. 

Users have the option to use one or more of the many built-in 

headers and footers, or they can click any of the buttons in the 

Header & Footer Elements group on the Header & Footer Tools 

Design toolbar to create custom fields. 

Command buttons in the Header & Footer Elements group include: 

▪ Page Number: Click this button to insert the &[Page] code 

that puts in the current page number. 

▪ Number of Pages: Click this button to insert 

the &[Pages] code that puts in the total number of pages. 

▪ Current Date: Click this button to insert the &[Date] code 

that puts in the current date. 

▪ Current Time: Click this button to insert the &[Time] code 

that puts in the current time. 

▪ File Path: Click this button to insert 

the &[Path]&[File] codes that put in the directory path along 

with the name of the workbook file. 
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▪ File Name: Click this button to insert the &[File] code that 

puts in the name of the workbook file. 

▪ Sheet Name: Click this button to insert the &[Tab] code 

that puts in the name of the worksheet as shown on the sheet 

tab. 

▪ Picture: Click this button to insert the &[Picture] code that 

inserts the image that you select from the Insert Picture 

dialog box that enables you to select a local image (using the 

From File option) or download one from an online source 

using a Bing Image Search. 

▪ Format Picture: Click this button to apply the formatting 

that you choose from the Format Picture dialog box to 

the &[Picture] code that you enter with the Insert Picture 

button without adding any code of its own. 

The following screenshot illustrates fields in each section of the 

header. The Page Number and Number of Pages fields are in the left 

section. Manually entered text is in the center section, and finally, 

the Current Time and Current Date fields are being inserted into the 

right section. 

  

This Photo by Unknown Author is licensed under CC BY 

https://openoregon.pressbooks.pub/beginningexcel/chapter/1-4-printing/
https://creativecommons.org/licenses/by/3.0/
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To create a custom header or custom footer, click the Launcher icon 

in the Page Setup group of the Page Layout ribbon to open the Page 

Setup window. Next, click the Header/Footer tab, and then choose 

to open either the Custom Header… or Custom Footer… buttons. 

 

Four checkboxes appear at the bottom of the “Header/Footer” tab, 

and in the Options group of the Design tab of the ribbon. To remove 

headers and footers from the first printed page, select the Different 

First Page check box. To specify that the headers and footers on 

odd-numbered pages should differ from those on even-numbered 

pages, select the Different Odd & Even Pages check box. These 

options are similar to those in Microsoft Word. The other two 

options are unique to Excel. To specify whether the headers and 

footers should use the same font size and scaling as the worksheet, 

select the Scale with Document check box. To make sure the header 

or footer margin is aligned with the left and right margins of the 

worksheet, select the Align with Page Margins check box. 
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Adjusting the Page Layout and 
Preparing to Print 

The size of Excel workbooks tends to grow the more each worksheet 

is manipulated, typically by adding more columns and rows, and 

sometimes, more sheets. This added complexity makes physical 

output of Excel data challenging. Too many columns will result in 

the sheet not being able to be printed on one sheet of paper, and too 

many rows make it difficult to interpret data on pages beyond the 

first page. Fortunately, the Page Layout tab can help fit the data on 

fewer sheets of paper and make each page easier to understand. 

While themes can help modify the appearance of a spreadsheet’s 

colors and fonts, the other groups in the Page Layout tab can impact 

the arrangement of data and streamline the readability of the output. 

Starting with the Page Setup group, Excel allows tremendous 

flexibility with the margins of each worksheet. For example, 

Narrow margins allow more data to fit on one page by reducing the 

amount of white space on the edges of the sheet. A quick and easy 

way to allow more columns to print on one sheet, is to change 

the orientation from the default Portrait, to Landscape, which 

allows more columns and fewer rows to print on one sheet. The 

effects of these Setup decisions can be more easily illustrated by 

switching from the default Normal workbook view to the Page 



 

 
Excel Chap 1   P a g e  | 100 

Layout. The View tab also allows users to enable/disable the Ruler, 

Formula Bar, and on-screen gridlines and headings. 

If changing the margins and/or orientation is not resolving the issue 

of getting extra columns to print on the same page, an alternative 

could be changing the paper size. The default printer determines the 

paper sizes available from the Size drop-down list. To check the 

range of paper sizes that a printer can print on, consult the printer 

manual, or view the paper sizes that are currently set for the printer 

in the Print Setup dialog box. Some users have the option of 

printing to Legal (8.5″ x 14″) or even 11″ x 17″ (tabloid) printers. 

A final, more drastic option to keep data from overlapping into 

multiple sheets, is to utilize the scaling feature. Using the Scale to 

Fit group from the Layout tab, a printed worksheet can be scaled by 

to modify the font size of printed output by either shrinking or 

enlarging the output. The options exist to scale the output to fit to 1 

page wide (width) by 1 page tall (height). It might make sense to 

only modify the width, or by choosing a Scale percentage, which 

adjusts the overall sheet height and width proportionately. Keep in 

mind the needs of your audience. Too small of font might make the 

spreadsheet unreadable, and for certain audiences, the output might 

need to be scaled to a larger font than the editing view. 

The Sheet Options group of the Layout tab provides two significant 

print features for basic Excel printing. These include the options to 

have gridlines and/or headings appear in printed output. By default, 

the options appear in the Viewing screen, but do not appear when 

printed. Without Headings, the output would be very difficult to 

explain to others, and gridlines, much like banded rows, make it 

easier for the eye to line up the intersections of rows and columns. 

More advanced options exist for enhancing page layout and printing 

options by clicking the launcher button in each group. Several print 

settings can be adjusted in the Print Preview window. The sheet in 

the following screenshot is modified to print in landscape 
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orientation with Narrow Margins and it is scaled to Fit on One Page. 

It also has headings included in the print output. 

 

Practice 6: Test Scores - Part 2 

1. Open the Test Scores workbook previously saved. 

2. In the Table Tools Design tab, click the Convert to Range 

button remove the table functionality from the data. (Click 

Yes to the message) 

3. Type the labels: Total Points in cell A8 and Average in cell 

A9. 

4. In cell B8, click the AutoSum button to insert the SUM 

function. Accept the range that Excel proposes for the 

formula by clicking the Enter check mark on the formula 

bar. The formula should be: =SUM(B2:B7). 

5. With B8 as the active cell, use the fill handle to copy the 

formula to the destination cells C8:D8. 
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6. In cell B9, enter a formula using the AVERAGE function 

without using the AutoSum functionality. Instead, use the 

Insert Function button to select the AVERAGE function, 

and enter the range B2:B7 as the arguments. NOTE: B8 

should not be included in the range of argument cells. Use 

the fill handle to copy the formula to cells C9 and C10. 

7. In cell E2, double-click the fill handle. See what happens! 

8. Change the view to Page Layout. 

9. Add a header that includes the Current Date field from the 

Header & Footer Tools Design ribbon in the left side of the 

header. 

10. Ensure the Gridlines and Headings appear in printouts, 

scale the sheet to 150%, then view the file in Print Preview. 

Your worksheet should resemble the following: 

11. Save the file as TestScores2.xlsx. 
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Microsoft Excel Chapter 2:  
Beyond the Basics 

• Absolute versus Static References 

• Understanding Complex Formulas 

• Date & Time Functions 

• Logical Functions 

• More Math Functions 

• Sorting and Filtering 

• Conditional Formatting 

• Pie Charts 

• Bar & Column Charts 

• Line Charts 
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Absolute versus Static 
References 

One of the first things that new Excel users need to realize is that 

Excel is so much more powerful than a calculator. Some users insist 

on setting up a worksheet as if it is merely a calculator. These people 

fail to realize the power of cell references. Instead, they use static 

references to constant values. A static reference is a reference to a 

value that does not change. In the example to the right, instead of 

using static references (= 9000-3952.96) for the formula in D5, the 

user should employ cell references. (= B5-C5). The main benefit of 

use cell references is that the user can manipulate the input values 

in columns B and C, and the formulas in column D will remain 

accurate. If the user changes either input values in columns B or C 

with static references, the formulas in column D will need to be 

manually updated. 

Cell referencing is an extremely useful feature when formulas need 

to be copied across ranges in a worksheet. When creating formulas 

that contain references to cells or cell ranges, the default cell 

reference is a relative cell reference. When formulas with these type 
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of cell references are copied to other cells the formulas will 

automatically change relative to the cells that they are copied to. 

However, there may be instances where it is necessary for Excel to 

keep the exact cell referenced in a formula when copying to other 

cells. A cell reference that does not change when copied is called 

an absolute cell reference (sometimes called a fixed cell reference). 

The indicator that a cell reference is absolute is the presence of a 

dollar sign symbol in front of both the column letter and row 

number, such as $A$3. To create an absolute cell reference, either 

type the dollar sign manually, or press the F4 after entering the cell 

reference. Repeatedly pressing the F4 key cycles the reference 

through the four different combinations of relative, absolute, and 

mixed cell references. 

Mixed cell references are a combination of relative and absolute: 

either the column is relative and the row fixed (absolute), for 

example D$2, or the column is fixed and the row relative: $D2. 

Mixed cell references are rarely used, but they play a significant role 

when it is necessary to keep a single row or column unchanged while 

copying the formula. Mixed cell references are commonly used 

when creating a table of values, like a multiplication table or a 

mortgage rate table. 
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Whenever possible, utilize relative and/or absolute references 

instead of static cell references. In the worksheet at the right, the 

formula in C6 is using relative cell references to both the Sales 

amount (B6), and the Commission Rate (B3). Unfortunately, if this 

formula is copied (perhaps by using the fill handle) to rows 7:16, the 

resulting formulas will be wrong. Some cells will display zeros or a 

#VALUE! error, while others will display inflated amounts because 

the Rate percentage is being replaced by higher sales values. 

Therefore, the reference to B3 in the formula should be an absolute 

cell reference, i.e. =B6*$B$3. It may be tempting to construct the 

formula using a static reference to the constant value of .075 (i.e. 

=B6*.075). However, if the rate needs to be changed to 7.25%, the 

formulas with the static references would each need to be changed 

manually. Conversely, if the formulas in column C are using 

absolute cell references to $B$3, a single edit to B3 is all that is 

needed to update all of the cells in column C. Knowing the 

differences between the various type of cell reference will make the 

worksheet more scalable and flexible for future expansion. 
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Understanding Complex 
Formulas 

Formulas can be simple mathematical formulas or complicated 

formulas involving multiple mathematical operations, multiple cell 

ranges and nested functions. While it is a good idea to remember the 

order of operations rules, complex formulas can use parentheses to 

identify the arguments of functions and to override the order of 

operations. In mathematical operation formulas, operations within 

parentheses are performed before those outside of it. For example, 

in =A3+B3*C3, B3 is multiplied by C3 before A3 is added to the 

result, but in =(A3+B3)*C3, A3 and B3 are added together first, then 

the result is multiplied by C3. 

Parentheses in operations may be nested inside each other. The 

operation in the innermost set of parentheses will be performed 

first. Whether nesting parentheses in mathematical operations or in 

nested functions, always be sure to have as many closed parentheses 

in the formula as there are open parentheses, or you might break 

Excel and it will return an error message.  

This Photo by Unknown Author is licensed under CC BY-NC-ND 
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In the illustrated worksheet below, cell D30 contains a complex 

formula that calculates the differences between rooms available and 

rooms rented to determine the total number of unrented rooms in the 

Balcony and Penthouse categories. The formula in D30 is: 

=(SUM(C5:C8)-SUM(D5:D8))+(SUM(C25:C28)-

SUM(D25:D28)). Notice the number of open and closed 

parenthesis! 
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Date & Time Functions 

Excel can produce the current date and/or time, based on the 

computer’s regional settings. Excel can also add and subtract dates 

and times. For example, it may be necessary to keep track of how 

many hours an employee worked each week, and calculate their pay 

and overtime. There are numerous Date and Time functions in Excel 

to help calculate the addition or difference between dates or times. 

Excel stores all date and time values as sequential serial numbers. 

For example, January 1, 1900 is represented by the serial number 1, 

and January 1, 2020 is represented by serial number 43831 because 

it is 43,831 days after January 1, 1900. To view the serial number of 

an existing date, format the date using the General Number format. 

The conversion of dates and times to serial numbers simplifies the 

process of using dates and times in calculations. The key to 

displaying the results of these calculations is using the appropriate 

Number format, which may require diving into the world of creating 

custom number formats to display only days, hour and/or minutes. 

For example, if only the number of years is desired to be displayed 

when calculating the difference between two dates, the Custom 

Number format should be yy. 
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The TODAY and NOW functions are very similar since both return 

the current system date. However, the NOW function also returns 

the current system time. Many users format the results of the NOW 

function to only display the current system time. One characteristic 

of these functions versus the DATE function is that TODAY and 

NOW are volatile functions, so if the workbook is opened tomorrow, 

these functions will update automatically, whereas the DATE 

function will not change. These functions are for use within the grid 

of the worksheet, typically to calculate durations. There are separate 

Date and Time fields for use in worksheet headers and footers. 

Logical Functions 

Many employers and educators are placing increasing emphasis on 

the value of critical thinking. Critical thinking skills are often 

associated with problem solving skills, empathy, and thinking and 

acting in purposeful ways by making fact-based decisions. Excel is 

a practical tool for collecting and analyzing data critically. Excel’s 

logical functions are especially useful for enabling critical thinking. 

However, before exploring the utilization of Excel’s logical 

functions, it is necessary to review the logical operators that are 
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used to compare data between cells. The operators are often referred 

to as comparison operators. The six main logical operators are 

explained in the following graphic: 

 

These comparison operators can be used in Excel functions to 

compare all types of data, including dates, numbers, Boolean values 

(True or False, Yes or No), or text. All arguments must evaluate to 

the Boolean values of either True or False, or contain another, nested 

logical function. 

The IF function is one of the most popular and useful functions in 

Excel. It can be used to make a decision based on a comparison. If 

the comparison is true, one value is displayed in the cell; if the 

comparison is false, a second value is displayed. The syntax of the 

IF function is: IF(logical_test, [value_if_true], [value_if_false]). 

▪ logical_test – a value or logical expression that can be 

either TRUE or FALSE. Required.In this argument, you 

can specify a text value, date, number, or any 

comparison operator. 

▪ value_if_true – the value to return when the logical test 

evaluates to TRUE, i.e. if the condition is met. 

Optional. 

▪ value_if_false – the value to be returned if the logical 

test evaluates to FALSE. Optional. 
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Simple IF functions test to see if a cell contains a certain text string 

and returns different values 

depending on if the logical 

test returns a True or False 

logic. A sample formula is 

illustrated in the screenshot 

at right. That’s some logical 

critical thinking! 

Instead of returning text 

strings, the IF formula can 

test the specified condition, perform a corresponding math operation 

and return a value based on the result. This is done by using 

arithmetic operators or other Excel functions in the value_if_true 

and /or value_if_false arguments. For example, =IF(C4>=D4, 

E4*.25, E4*10%). This formula is determining if the value in 

column C is greater than or equal to the value in column D. If the 

result of the comparison is true, then the value to be displayed should 

be the value in column E multiplied by .25 (25%). If the result of the 

comparison is false, then the value to be displayed should be the 

value in column E multiplied by 10% (.10). 
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Other popular Excel Logical functions include the AND, as well as 

the OR functions. These functions allow users to create multiple 

logical tests within a single IF function. These functions return 

either TRUE or FALSE results when their arguments are evaluated. 

The AND function only returns TRUE if every condition is met. 

However, the OR function returns TRUE if any condition is met. 

The syntax of both functions are the same: =AND(logical1, logical2, 

etc.) Examples of each function are illustrated in the screenshots 

below. The first illustration uses the AND function to determine if 

any of the people are eligible for the Inner Circle. They need to have 

a Customer Satisfaction Score of at least 4.0, and be a Vikings fan. 

The second example uses the OR function. The more lenient 

comparison operator yields more eligible people for the Inner Circle. 

AND function example 
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OR function example 

More Math Functions 

The most popular Excel function in the Math category is 

undoubtedly the SUM function. The Excel Math Functions perform 

many of the common mathematical calculations, including basic 

arithmetic, conditional sums & products, quotients, and rounding 

calculations. There are many more examples, but some of the more 

popular Math functions are identified in the table below. There are 

many variations of some of these functions to be found in the Insert 

Function window. 
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The first two functions from the table above are considered basic 

mathematical operations. Instead of multiplying two cells using the 

* operator, Excel users can opt to use the PRODUCT function. i.e. 

=PRODUCT(B2,B3) versus =B2*B3. The PRODUCT function is 

most useful when multiplying a series of cells. Ensure that the cells 

referenced contain numbers or dates. If the data referenced includes 

text, the PRODUCT function will return the #VALUE! error 

result.  The QUOTIENT function is similar to the PRODUCT 

function, except instead of multiplying cells, it divides cell(s) by 

other cell(s) and returns a result in Integer format. An integer is a 

whole number; therefore, it will not display the remainder typically 

generated in division calculations. The graphic above illustrates the 

differences between using the divide operator and the QUOTIENT 

function. The numerator is the dividend and is the value before the 

forward slash (/). The denominator is the divisor and is the value 
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after the forward slash (/). In this example, A1 (or 13) is the 

dividend, and B1 (or 5) is the divisor. 

An alternative to using the QUOTIENT function is to utilize the 

ROUND function or any of its related functions (ROUNDDOWN, 

ROUNDUP,MROUND). In the graphic above, a user could rewrite 

the formula in A4 as =ROUND(A1/B1,0) by using the ROUND 

function to get the similar results as the QUOTIENT functions. The 

difference is that the QUOTIENT result does not store any 

remainder amounts. As shown in the graphic at the right, using the 

ROUND function can yield significantly different results than using 

the QUOTIENT function, however, the user can control the level of 

detail desired in the calculation. Some users simply opt for the first 

scenario without using either function. Instead, they utilize Excel’s 

formatting functionality to remove the displaying of decimals. 

Using the Decrease Decimal button  from the ribbon on cell B4 

can change the display to various results. However, the un-

truncated/un-rounded result is still stored in the cell. 
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Practice 7: Expense Report 

1. Create a new worksheet with the following data from the 

image below: 

2. In row 9 enter the following data: 

o Date: 5/30/2019 

o Description: Travel to Minneapolis 

o Meals: 25 

o Mileage: 205 

o Lodging: 150 

o Other: 

3. In cell G9 enter the following complex formula using 

relative and absolute cell references: 

=C9+(D9*$C$6)+E9+F9   (are the parenthesis necessary?) 

4. Format columns C, E, F and G as Currency format with 

two decimals. 

5. Enter the following in row 10: 

o Date: 5/31/2019 

o Description: Travel home 

o Meals: 20 

o Mileage: 205 

o Lodging: 

o Other: 15 

6. Use the fill handle to copy the formula in G9 to G10. 

7. Insert a new row below the Mileage Rate row, and in B6 

enter the label: Trip Duration. (bold the label) 
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8. In cell C6 enter a formula that subtracts A9 from A10. 

Change the format of cell C6 to General. 

9. In cell B15 enter the label: Totals: (right-align & bold this 

cell). 

10. Select cells C15:G15 and click the AutoSum button. 

Change the format of D15 to General. 

11. Enter the label: Need Receipts? in cell B2. (bold the label) 

12. In cell C2, enter the following logical function: 

=IF(F15>0,”Yes”,”No”) 

13. Save the file as Helga Expenses May2019. Your worksheet 

should resemble the following: 

 

Sorting and Filtering 

Worksheets can have large amounts of data, and it can be 

overwhelming if it is not sorted correctly. Arranging data in a 

specified order is called sorting. Rows can be sorted in either 

ascending (low to high) or descending (high to low) order. 
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Ascending order can also be considered alphabetic order if the data 

is text or chronological order if the data is dates or times. 

Before data can be sorted, Excel needs to know the exact range of 

cells that is to be sorted. Excel will select areas of related data as 

long as there are no blank rows or columns in the data range. Blank 

rows and columns define the outer limits of the data range. To ensure 

that the correct data is selected, highlight the range before starting 

the sort. 

As Excel determines the defined range of data to be sorted, Excel 

also determines if field names exist. Users should format the first 

row of the data range with unique formatting Often, just making the 

labels bold will help Excel identify the field names. Identifying the 

field names will prevent Excel from including these fields in the 

records to be sorted. The field names become the sort keys needed 
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for multiple column sorts. In the image below, the possible sort keys 

are: Cruise Date, Accommodation Category, Rooms Available, 

Rooms Rented, Rate, Revenue and Shortfall. 

 
The data range above is already sorted in ascending order by the 

Accommodation Category key field. A single column sort is quite 

easy. Simply click any cell in the 

column that represents the key 

sort. In the above example, any 

cell from B4 to B28 would 

be acceptable. Then, click the the 

A-Z option in the Sort & Filter 

group of the Data tab. The entire row is sorted because each row is 

a record that should stay grouped together. Be careful NOT to select 

a single column of data or the records may not be kept together. 

Excel will warn the user with a warning message. If the user chooses 

to Continue with the current selection, only the data in the column 

with change their order, while the data in the other columns remain 

unchanged. This will most likely destroy the integrity of the data. 

Advanced sorting involves multiple key fields from multiple 

columns. A multi-level sort can be set up by clicking the Sort button 

from Sort & Filter group from the Data tab (or the Sort & Filter 

button from the Editing group of the Home tab and choose Custom 
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Sort) to open the Sort dialog window. The first sort criteria, also 

known as the primary sort, was previously defined to sort by 

Accommodation Category in ascending order. To add a second 

level, also known as a secondary sort, click the Add Level button. 

After entering additional sort criteria, additional levels can be added. 

As shown in the graphic on the previous page, secondary criteria 

have been added to sort in descending order by Revenue. The data 

in column B will not appear to change, but the records will reorder. 

Compare the results below with the previous table. 

 

 

  

An Excel filter, also known as an AutoFilter, is used to display only 
the data that meet specific criteria. Data that does not meet the 

criteria is hidden from view. Excel’s basic filter functionality allows 

users to filter rows by value, by format and by criteria. Filters can 

reduce a large, complex worksheet of data into meaningful 

information. With filtering, you can control not only what you want 
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to see, but what you want to exclude. Users can filter based on 

choices they make from a list, or they can create specific filters to 

focus on exactly the data that they want to see. Clicking the filter 

button from the Data tab will add drop-down arrows to the column 

headers in a range of data. Clicking a drop-down arrow provides 

sorting and filtering options, like filter by color or text filters.  A 

simple AutoFilter will be signified by the clearing of check boxes of 

the data that should be hidden. After applying a filter, a user can 

copy, edit, chart or print only visible rows without rearranging the 

entire list. Like sorting, filters can be applied to multiple columns to 

further reduce the results that are displayed. 

A column that has been filtered will have its drop-down arrow icon 

switch from an upside-down triangle to a filter icon, as shown 
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highlighted in yellow below. Only the cruises from the Penthouse 

accommodation category will be displayed after clearing all check 

boxes except the Penthouse category. 

 

To remove a single filter, click the filter icon in the row header and 

choose Clear Filter from…. To clear all filters quickly, choose the 

Clear button from the Data tab on the ribbon or to remove filtering 

functionality, re-click the Filter icon from the Sort & Filter group. 

For more advanced users there are many more ways to utilize filters 

in Excel, such as Custom Filters and Advanced Filters. Nonetheless, 

a lot can be accomplished with the basic AutoFilter feature. 

Conditional Formatting 

Using spreadsheet functionality to enhance critical thinking is a 

primary reason that Excel is so popular among business 

professionals. Decision-making is made easier when users can 

quickly spot trends, identify variances, and be alerted when certain 

criteria is met. Excel’s conditional formatting feature is a really 

powerful tool when it comes to applying different formats to data 

that meets certain conditions. Conditional formatting  is one of the 

most simple yet powerful features in Excel by applying user-specific 

formats to a cell/cells when user-specific conditions (rules) are met. 

Not only does it make a spreadsheet look awesome, but it also helps 

make sense of the data. 
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Clicking the Conditional Formatting button on the Home tab of the 

ribbon offers several options to define the condition 

criteria (rules), and several formatting options to 

display the data in meaningful ways.  To choose formats that are 

applied to a cell(s) when a condition is met, select a range of cells, 

then click the Conditional Formatting button to display a menu of 

rules. Clicking a rule will expand an additional menu. For example, 

to identify which cruise accommodation categories provide the most 

significant revenue shortfall, utilizing a highlighting rule that 

formats cells that are greater than $100,000 would be a very 

practical conditional formatting rule that could provide some 

strategic information. Selecting the range of G5:G28 and applying 

the Greater Than rule, will create eye-catching formatting. The data 

in the first field can either be a cell reference or a static value, as 

shown below. 
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Numerous rule types exist beyond the preset comparison operator 

menu choices. Rules can identify cells that contain certain text or 

before/after a certain date, or even highlight duplicate data. 

Top/Bottom Rules can reveal the top or bottom 10 records in a 

certain column. The quantity can be modified from the top/bottom 

10 to a user-specific number. 

Custom rules can be defined by choosing More Rules… from the 

Highlight Cells Rules menu, which opens the New Formatting Rule 
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window. Choosing alternative Rule Types will modify the 

functionality available in this window. 

 
 
After defining the rule criterion, custom formats can be selected by 

clicking the Format button. The Format Cells window opens to 

allow custom Number, Font, Border or Fill formatting. To enforce 

more complex rules, multiple conditional formatting rules can be 

applied to the same data. However too many colors can sometimes 

be distracting and should be used sparingly. Therefore, Excel offers 

more formatting choices than just color fills. Data bars, color scales 

and icon sets can also be used to emphasize data that meets certain 

conditions. 

The icon sets work great when color is not effective, such as when 

printing to black & white laser printers. Icons are even more 
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noticeable than colors because of their unique look and sparing 

use.  Icon sets will help visually represent the data with directional  

arrows, shapes, indicators, ratings, and other objects. For icons in 

sets of three, Excel will assign icons by dividing values into thirds – 

the first icon is assigned to the top one third of values, the second 

icon is assigned to the second third of values, and the third icon is 

assigned to the lowest one third of values. The values are adjusted 

for four and five-icon sets. Conditional formatting’s flexibility is 

extensive, but perhaps even more impressive is that, like formulas, 

conditional formatting rules are volatile. As the data changes, the 

conditional formatting dynamically adjusts to evaluate the new data 

against the existing conditional rules. 

  



 

 
Excel Chap 2   P a g e  | 129 

Pie Charts 

With Excel, users can organize data so that it has context and 

meaning. The output of Excel manipulation can take the shape of 

either a table or chart. When deciding to use a chart or a table to 

communicate the data-driven message, it is wise to always ask how 

the information will be used, and who is the audience? People 

interact very differently with these two types of visuals. Tables, 

which display data in a columnar layout, are meant to be read. 

Therefore, tables are ideal when the data requires more specific 

analysis. Tables offer preciseness, letting users dive deeper to 

crunch the numbers and examine exact values, instead of focusing 

on approximations or visualizations. 

A chart is a visual representation of a range of related worksheet 

data. A chart can illustrate a large amount of numerical data quickly 

and in an easy-to-understand fashion. Charts are particularly useful 

for simplifying complex sets of data to expose the shape of the data 

– numerical patterns, trends, and other significant activity. What 

charts lack in terms of precision they overcome with broader insight 

and quicker comprehension. 

According to some psychologists, 

people can be classified as either 

“left-brained” or “right-brained” 

thinkers. A person who is “left-

brained” is often said to be more 

logical, analytical, and objective. 

Utilizing tables to display 

spreadsheet data may be more 

effective with “left-brained” people. A person who is “right-

brained” is said to be more creative, thoughtful, and subjective. 

Conversely, displaying spreadsheets data using certain Excel charts 

may be more suitable for “right-brained” people. Both tables and 

charts offer unique advantages, but one is not always better than the 
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other. The choice ultimately depends on the data at hand, the 

message that is intended to convey, and the audience that will be 

consuming the information. 

Learning how to work with charts means not only knowing how to 

create them but also realizing that different types of chart and 

layouts can reveal and emphasize different knowledge. Like a 

picture, a chart can be worth a thousand words. It all depends on 

how well the chart is designed and developed. A well-constructed 

chart will provide context and clarity for data analysis and 

storytelling. The first step to creating useful charts it to organize and 

precisely select the data that should be charted. This includes the 

cells that contain both the data and the label headings. 

The terms charts and graphs are often used interchangeably. There 

are some subtle differences, however. Graphs are numerical 

representations of data that show correlations and trends. Charts are 

visual representations of data that tell a story. Ironically, the term 

infographic, is better defined as a chart than as a graph.  

Each chart type conveys information in different ways. Pie charts, 

for example, are best for charting data that is a percentage of a 

whole. For example, what percentage of your monthly income is 

spent on transportation? Charts contain different objects for each 

chart type. Objects in a pie chart include: 

• Chart title – describes what is charted. The label heading of 

the data series is used by default, but this can be edited. 

• Legend – an index of information that corresponds to the 

category labels. 

• Data labels – identify each value in the data series. 

• Plot area – the part of the chart that displays data 

graphically. 

• Chart area – the entire chart and all its elements. 
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A pie chart can only include a single series of data, whether it is a 

single column or a single row of data. A data series is the sequence 

of values that Excel uses to plot in a chart. Each value from the data 

series is represented by a slice (or wedge) of the pie. The size of 

each slice varies with its percentage of the total of the entire 

data series. To create a pie chart, first carefully select the appropriate 

data range before selecting the chart type from the Insert tab.  In the 

above chart, the selected data range is $B$3:$F$3, $B$19:$F$19, 

since the only data series being charted 

is the total sales (quantity) of each 

cookie flavor. Every date (row) 

represents an additional data series, but 

since pie charts only plot a single data 

series, these series’ should not be 

selected. Pie charts should be avoided 

when there are many categories, or 

when categories do not total 100%. 
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Typically, 2-D charts are easier to read than 3-D charts. 

When a chart is created as an object on a worksheet, sizing handles 

will appear on the outer borders. The chart, or any object within the 

chart, can be moved and/or resized similarly to a picture or other 

objects in Microsoft Office. When a pie chart is first created, Excel 

will use the default colors and design. Users can customize the chart 

look easily by utilizing chart styles. In the Design contextual tab of 

the Ribbon, several different styles will be displayed in a row.  

Mouse over them to see a preview: 
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An additional option for quickly changing the look of a chart is to 

utilize the Quick Layout menu to select one of several preset to add 

elements like percentage labels, value labels, and differently located 

legends to the chart. Users can also add and 

remove individual elements, such as chart 

titles, data labels, data tables, and more by 

using the Add Chart Element menu. Some 

elements are not available for certain chart 

types. One of the most useful chart elements 

that get added manually to a chart 

are data labels. Data labels are linked to 

values on 

the 

worksheet, and they update 

automatically when changes 

are made to these values. Data 

labels make a chart easier to 

understand because they show 

details about a data series or its 

individual data points. Users 

can add data labels to all data 

points or a specific data slice by 

ensuring that only the specific 

slice is selected. In addition to 

the Add Chart Element menu 

and quick layout options, users 

can add data labels by right-

clicking the chart and choosing 

Add Data Labels from the 

shortcut menu. Once added, the 

data labels can be further 

modified by right-clicking the 

chart and choosing Format 
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Data Labels to open the Format Data Labels task pane. One or more 

types of labels can be added and positioned. Adding Category Name 

labels make the legend redundant. Be careful not to add so many 

labels that the chart becomes too crowded to read! 

After adding labels, it may become necessary to resize or move the 

chart. After adding a title, data labels, and removing the legend, the 

chart looks different, but is still the same size, even though certain 

elements have resized. 

Which pie chart looks better? Generally, removing the legend 

through use of data labels is considered a preferable design strategy. 

Alas, there are even more ways to customize a pie chart that is 

beyond the scope of this text! Additional functionality includes 

creating 3-D pie charts, exploding slices, rotating, sorting, adding 

different fill designs, and much more! 
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Bar & Column Graphs 

Bar graphs are practical for comparing the differences between 

values with horizontal bars. The lengths of the bars are proportional 

to the size of the data category they represent. A vertical bar graph 

is referred to as a column chart, and they are basically the same – 

just 90° apart. Unlike a pie chart, a bar graph can include several 

series of data. Bar graphs are simple, easy and flexible, and thanks 

to the horizontal layout, bar graphs can accommodate longer 

category names. Bar (and column) graphs contain the following 

objects: 

• Chart title – describes what is charted. 

• Chart area – the entire chart and all of its elements. 

• Plot area – the region within the horizontal and vertical 

axes. 

• Axes titles (horizontal, vertical)- describe the data. 

• Legend – an index of information that corresponds to the 

series names. 

• Data labels – identify each value in a data series. 

• Value axis (y-axis) – contains values. Horizontal axis on 

bar charts and vertical axis on column charts. 

• Category axis (x-axis) – contains the category labels. 

Horizontal axis on column charts and vertical axis on bar 

charts. 

• Gridlines – mark the intervals on an axis. 
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While the data and chart on the previous page only display one data 

series, most bar and column charts tend to display multiple data 

series to compare and contrast one set of data against another. The 

chart below adds a second data series in column C and changes the 

chart type to a column chart. The two different data series are 

illustrated with different color data points. Also, note how the axes 

change directions! The value axis maximum, major and minor units 

were also modified to different numerical values. 
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A histogram is a column chart that shows frequency of data. It is 

similar to a bar graph but has important differences. For example, 

the bars of data in a histogram are not separated with a gap. Also, in 

general, histograms depict ranges instead of categories. Histograms 

are often used to show statistics.  

To create a histogram in Excel, you provide two types of data — the 

data that you want to analyze, and the bin numbers that represent the 

intervals by which you want to measure the frequency. You must 

organize the data in two columns on the worksheet. These columns 

must contain the following data: 

▪ Input data  -  This is the data that you want to analyze by 

using the Histogram tool. 

▪ Bin numbers -   These numbers represent the intervals that 

you want the Histogram tool to use for measuring the input 

data in the data analysis. 

The output of the histogram analysis is displayed on a new 
worksheet (or in a new workbook) and shows a histogram table and 

a column chart that reflects the data in the histogram table. 
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Charts can easily get crowded with details. Therefore, keeping the 

chart on the same worksheet as the data is not always feasible. Users 

can move a chart to any location on a worksheet or to a new or 

existing worksheet. By default, a chart is created as an object within 

a sheet. The chart can be resized, but sometimes the chart needs to 

be as large as possible. To move the chart to a new worksheet, click 

the Move Chart button on the Chart Tools Design tab. Next, click 

the New sheet radio button, and then in the New sheet box, type a 

name for the new worksheet. After clicking OK, the new sheet will 

be to the left of the existing sheet. A new, standalone chart will 

occupy the entire page to maximize the visibility of the data. The 

Move Chart window also provides the option of moving the chart as 

an embedded object into an existing sheet. 
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Line Graphs 

A line graph displays a series of data points connected by a straight 

line. Line graphs are a good way to show change or trends over time. 
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Line graphs are simple to create and easy to read. In contrast to 

column or bar graphs, line graphs can handle more categories and 

more data points without becoming too cluttered. Each line displays 

as a different color. Line graphs help people examine why data is 

changing and make decisions about how to proceed. The Line graph 

is especially effective in displaying data trends. Stock market 

investors utilize line charts to track historical stock performances 

and help determine if a trend can be forecasted in the future. 

In a Line Graph, the vertical axis (Y-axis) always displays numeric 

values and the horizontal axis (X-axis) displays time or other 

categories. Time intervals can be measured in years, months, days, 

or hours. 

To create a line graph, start by selecting the data range, then 

choosing the Line Graph button  in the Charts group from the 

Insert tab. 

In the 2-D line graph illustrated on the previous page, two sets of 

data series are plotted for fifteen days. The Skinny Mints cookies 

are identified by the red line, and the orange line plots the 

Chocolate/Peanut Butter cookies. Each date is a data point. 

Additional data series can be added by expanding the data source 

range. Line graphs provide an easy way to track historical data. In 

many cases, the way the data is trending makes it easy to predict the 

results of data in future periods. 

Excel offers numerous other graphs and charts that might better 

help illustrate the story behind the data, however all charts must 

address the challenge of sharing or outputting the graphic(s) to 

their target audience(s). Here are a few printing issues to consider: 

• Printing only the chart. If the active cell is not selecting the 

chart, both the chart and worksheet data will print. However, 

if the chart is currently selected, only the chart will print by 

default (as a chart sheet). If the intent is to print both the chart 
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and the data, make sure to move and/or resize the chart to 

ensure everything fits appropriately within the sheet 

margins. This will embed the chart within the sheet. 

Utilizing the Print Preview window to verify what will print 

by default will allow the user to make numerous changes, 

such as the orientation, margins and scaling. A different 

installed printer can also be selected. The graphic below 

illustrates from the Print Preview window, an embedded line 

chart in landscape orientation with headings enabled for 

print. The sheet has also been scaled to fit to one page. 

 

• Chart colors that are not compatible with black and white 

printers. A lot of office printers are black and white laser 

printers due to their low-cost to operate at high volumes. A 

color laser printer may be a worthy investment for common 
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chart printing. If a black and white printer is all that is 

available, it may be necessary to change the colors to 

patterns or contrasting shades of grey. 

• Not enough or too much information. Reads of the chart 

must be able to comprehend the message the chart is 

attempting to convey. This might require adding context, 

such as titles, data labels, and text-box callouts. Conversely, 

a chart can have too much information that the chart is 

cluttered and unreadable. In this case, summarizing the data 

my be prudent, or even re-selecting a different source data 

range. A chart can also be unreadable due to poor design 

considerations like wrong fonts and font sizes, as well as 

distracting colors and object sizes. 

• Excel charts are volatile and will change as often as the 

source data is changed. If a static copy of a chart is needed, 

consider saving the chart as a picture. This can be 

accomplished through using the copy and paste special 

Infographic example 
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commands. Using Paste Special will allow a chart to pasted 

in either PNG, JPEG, GIF or other formats. Alternatively, 

Excel files can be saved as PDF files for inserting in other 

electronic documents/files. 

  

Practice 8: Weather Report 

1. Open the data file The Weather Report.xlsx or create a new 

sheet from the illustration at right. 

2. Add conditional formatting to all cells in B6:E17 so that 

any cell is at least 90° with red fill cell formatting, or below 

32° in light blue fill. 

3. Use the Internet to research average monthly high temps 

for Fort Myers, FL. Enter a label and the temps in column 
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E. The conditional formatting should dynamically format 

the cells. 

4. Create a 2-D bar graph of Anchorage and Mesa temps for 

all twelve months. 

5. Move the bar graph to its own chart sheet. 

6. Return to the original source data sheet and create an 

embedded 2-D line graph with markers for all four cities 

for all twelve months. Change the graph title to Average 

Month High Temps. Move the chart slightly so the top-left 

edge is in cell F6. 

7. Use Print Preview to view the entire sheet (not just the 

chart). Change the orientation to landscape. Compare your 

results with the screenshot below: 

8. Save the file as The Weather Report2.xlsx to your drive. 
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Excel Index 
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active cell, 103 
Add Chart Element, 158 
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AutoFill, 117 
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Boolean, 138 
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chart, 154 
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Conditional formatting, 149 
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data series, 156 
dividend, 141 
divisor, 141 
fill handle, 117 
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footers, 123 
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headers, 123 
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icon sets, 152 
Keyboard shortcuts, 105 
logical operators, 137 
margins, 126 
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Mixed cell references, 132 
non-contiguous, 106 
orientation, 126 
Print Setup, 127 
Quick Layout menu, 158 
Relative Cell Referencing, 115 
Scale to Fit, 127 
sorting, 144 
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syntax, 114 
table, 113 
Tables, 154 
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worksheets, 103 
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Microsoft Access Chapter 1:  
Database Basics 

• Absolute versus Static References 

• The Four Main Objects in a Database 

• Database Design 

• Creating a Table 

• Primary and Foreign Keys 

• Table Relationships 

• Entering and Editing Records 

• Creating Forms 
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What is a Database? 

A database is a collection of related data that is organized so that it 

can be easily access, managed and updated. Databases can store 

details about people, products, orders, or anything else. Data can be 

defined as facts and statistics about people, objects, events and 

ideas. Organizations interpret, process and analyze data to turn the 

data into useful information. This information is used to make 

better decision-making. 

In the past, many databases were paper 

based. Paper records were stored in 

files within file cabinets. File cabinets 

still exist today, in large part due to the 

fears associated with the insecurity of 

electronic records being compromised. 

The individual documents (records) 

are categorized into different folders 

(tables) to streamline user access. 

However, this process is labor-

intensive, susceptible to errors, and an 

office eyesore! 

The Interior Decorator’s 

Nightmare – a filing cabinet 
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Databases are used for two major purposes: for processing 

transactions and analytical research. Transactional databases track 

daily operations. This data can be extracted into other software 

programs for further manipulation, summation and classification. 

This allows users to perform analytical research and prepare reports 

to help create strategic information. 

Computerized databases organize data into rows, columns and 

tables, and is indexed to make it easier to find things quickly. Data 

gets updated, expanded and deleted as new data is added. Automated 

processes quickly manipulate the data, and data accuracy is 

enhanced through automated rules. The advancements in database 

software technologies have contributed to the Information Age that 

currently exists. The growth of the filing cabinet market cannot 

compare to the growth of electronic data contained in private and 

public networks, and web sites throughout the Internet! 

While a spreadsheet can function as a database, with its utilization 

of columns and rows, the flat-file structure creates redundancies and 

inconsistencies which limit the ability to find and understand the 

data. In contrast, a relational database uses a tabular structure so that 

data can be easily reorganized and accessed in several different 

ways. Relational databases are made up of a set of tables with data 

that fits into predefined categories (fields). Each table has at least 

one data category (field) in a column, and each row has certain data 

for the categories (fields) which are defined in the columns. 

Microsoft’s relational database software program is called 

Access. Access only functions with Windows operating systems 

(not available on a Mac O/S) and is not available in all Office 

versions. Access is a tool to organize, store, and manipulate data, in 

order to report on the data stored in tables. The power of a database 

comes from the ability to link tables together to provide data 

processing efficiencies for large sets of data. Access’ integration 

with the other Microsoft Office programs makes it a very popular 

and economical relational database solution. 
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The Four Main Objects in a 
Database 

While Microsoft Access is made up of seven components, this text 

will focus on the main objects: tables, forms, queries and reports. 

Together, these objects allow users to enter, store, analyze and 

compile data in various ways. When an Access database is opened, 

the objects are illustrated in the Navigation Pane on the left side of 

the window. The standard view in the Navigation Pane displays all 

objects in the database organized by object type. The Navigation 

Pane is used to run, open, and manage the objects of a database. 

Double-clicking an object will open the object in a document 

window. 

A table is the database object that stores data organized in an 

arrangement of columns and rows. Each row is a record and each 

Navigation Pane 
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column is a field within each record. A record is all of the data 

pertaining to a person, place, thing or event. Each record will have 

one or more fields and every database must have at least one table. 

A relational database must have more than one table. 

The other three objects are typically based off of the tables, so take 

the time to set up the tables correctly, the first time! A form object 

is typically used for entering new records into a table or 

edit/deleting/display existing records in a table. Forms are the 

primary interface that most users of a database enter and display 

data. A query object retrieves specific data from other database 

objects and then displays only the data that the user specifies. 

Queries are the equivalent of asking questions about the data. 

The report object summarizes the records from a table or query into 

an easy-to-read format suitable for printing or exporting to other 

software programs. 

Access objects have several views. Each view gives users different 

perspectives and offer different functionality. The two most 

important views are Datasheet view and Design view. Datasheet 

view displays a table in a datasheet where fields are in columns and 

records are in rows. This view is useful for comparing records and 

is often used when sorting or filtering data. This view is also 

practical for printing data since many of the records can fit on a 

single sheet of paper. Records can be added in datasheet view, but 

forms are a more typical object for data entry. Nonetheless, the 

asterisk (*) that appears to the left of the row below the last record 

indicates where a new record will appear. The grey box to the left of 

each record is a record selector. Clicking a record selector will make 

the record active. Right clicking the record selector will allow users 

to delete the selector record or add a new record to the table. Design 

view allows users to setup and edit the fields in an object. 

Datasheet view of a Customer table 
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Database Design 

A properly designed database will divide data into tables to 

eliminate duplicate information (also known as data 

redundancy). Redundancy occurs when data is repeated several 

times in a database. Redundant data is bad, because it wastes space 

and increases the likelihood of errors and inconsistencies. A good 

database prevents redundant data when, for example, customer data 

(ID, Name, Address, etc) is stored in one table and then other tables 

store just the customer ID to refer to the customers. Another 

important design consideration to maintain is data accuracy. A 

common motto when performing data entry is “garbage in, garbage 

out”. The correctness and completeness of information is important 

if the user wants to rely on their data. If your database contains 

incorrect information, any reports that pull information from the 

database will also contain incorrect information. As a result, any 

decisions you make that are based on those reports will then be 

misinformed. 

Creating a new database involves determining the database schema, 

which is a description of the data and the organization of the data 

into tables. Designing a schema consists of the following steps: 

1. Determine the purpose of the database and which data to 

include in the database. It is a good idea to write down the 

purpose of the database on paper — its purpose, how you 

expect to use it, and who will use it. 

2. Divide information into related groups to create tables and 

then give each table a descriptive name. Data should be 

grouped to ensure there is little to no redundancy. Each table 

must have data related to at least one other table through a 

table relationship. 

3. Describe the fields and determine the primary key for each 

table. 
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Creating a Database Table 

As previously stated, a database cannot 

exist without at least one table. Therefore, 

when a new database is created in Access, 

the first object that opens is a table in 

datasheet view. Switching the view to 

Design View allows the user to make 

many design decisions in a much more 

intuitive view. Many users like to use 

Datasheet View to paste data copied from 

Excel. However, setting up the fields in Design View makes it easier 

to define each field’s properties and data type. 

Design View doesn’t display any data. Therefore, there’s more 

space available to display other settings. In Design View, you can 

see the data type listed next to each field. When a user clicks on a 

field (in the top frame), the bottom frame displays the properties for 

that field. The user can then change these properties as desired. 
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Creating a table in Design View allows the user to define advanced 

settings, like data types and properties, for each field in the table. 

However, the first step is defining the field names. Here are a few 

guidelines when creating field names: 

• Names can include numbers, UPPER and lowercase letters, 

and any combination. Avoid special characters (exclamation 

points, periods, brackets, quotes, etc.) 

• No leading spaces. Spaces between words is acceptable, but 

not common practice, because: 

• Make the names as short as possible without excessive 

abbreviation. Formatting column widths for displaying in 

printouts can be challenging with excessively long field 

names. For example, Order # or Order Number are better 

than Customer Order Number. 

• Ensure the names are unique per table. If a table has fields 

for Customer ID and Product ID, neither field should be 

named simply ID. Likewise with the word Name. It is too 

generic and needs a prefix identifier. 

• Break data into multiple fields. For example, instead of one 

field for Customer Name, create fields for First Name and 

Last Name. This will allow sorting and filtering on single 

fields. Another example would be separating an address into 

multiple fields for Street Address, City, State/Province and 

Zip/Postal Code. 
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Every field has a data type. A field’s data type indicates the kind of 

data that the field stores, such as large amounts of text or attached 

files. A field’s data type determines what other properties the field 

has including its size and formatting options. Field data types are 

defined in the table design grid, whereas field properties are defined 

in the Field Properties pane in the bottom of the Table Design View 

window. Data types include: 

 

Data type Description Size 

Short Text 

Use for text or combinations of 

text and numbers (i.e. Phone 

Numbers). 

Up to 255 

characters 

Long Text 

Use for larger amounts of 

alphanumeric data, including 

sentences and 

paragraphs.  Note: You cannot 

sort a memo field. However, 

they are searchable. 

Up to 1 GB 

Number Numeric values. 4 bytes 

Large Number 

Numeric values. Stores a non-

monetary, numeric value and is 

compatible with the 
SQL_BIGINT data type in 

ODBC. Use this data type to 

efficiently calculate large 

numbers. 

8 bytes 

Currency 

Use for monetary data. Holds 

up to 15 digits of whole 

dollars, plus 4 decimal 

places. Tip: You can choose 

8 bytes 
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which country’s currency to 

use. 

AutoNumber 

Unique value generated by 

Access for each new record, 

usually starting at 1. 

4 bytes 

Date/Time Use for dates and times. 8 bytes 

Yes/No 

A logical field can be 

displayed as Yes/No, 

True/False, or On/Off. In code, 

use the constants True and 

False (equivalent to -1 and 

0). Note: Null values are not 

allowed in Yes/No fields. 

1 byte 

Ole Object 

Can store pictures, audio, 

video, or other BLOBs (Binary 

Large Objects). 

Up to 2 GB 

Hyperlink 

Contain links to documents or 

other files, e-mail addresses, or 

web pages. 

Up to 8 

bytes 

Attachment 

Attach pictures, documents, 

etc. Can contain an unlimited 

number of characters per 

record. Access will compress 

the file. 

Up to 2 GB 

Calculated 

Use to create an expression 

that uses data from one or 

more fields. You can designate 

different result data types from 

the expression. 

Dependent 

on the data 

type of the 

result type 

property 
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Lookup 

Wizard… 

A wizard starts to help define 

either a simple or complex 

lookup field. A simple lookup 

field uses the contents of 

another table or a value list to 

validate the contents of a 

single value per row. A 

complex lookup field allows 

you to store multiple values of 

the same data type in each row. 

Dependent 

on the data 

type of the 

lookup field 

After creating a field and setting its data type, users can set 

additional field properties. The field’s data type determines which 

other properties that can be set. The field size is the number of 

characters or the type of number it can store. For Number and 

Currency fields, the Field Size property is especially important, 

because it determines the range of field values. For example, a one-

bit Number field can store only integers ranging from 0 to 255. In 

the Field Properties pane, on the General tab, enter the new field 

size. Users can choose from the following values: 

• Byte — For integers that range from 0 to 255. Storage 

requirement is a single byte. 

• Integer — For integers that range from -32,768 to +32,767. 

Storage requirement is two bytes. 

• Long Integer — For integers that range from -

2,147,483,648 to +2,147,483,647. Storage requirement is 

four bytes. 

• Single — For numeric floating-point values that range from 

-3.4 x 1038 to +3.4 x 1038 and up to seven significant digits. 

Storage requirement is four bytes. 

• Double — For numeric floating-point values that range from 

-1.797 x 10308 to +1.797 x 10308 and up to 15 significant 

digits. Storage requirement is eight bytes. 
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• Replication ID — For storing a GUID that is required for 

replication. Storage requirement is 16 bytes. 

• Decimal — For numeric values that range from -9.999… x 

1027 to +9.999… x 1027. Storage requirement is 12 bytes. 

Numeric and date/time fields can have a specified format to define 

how the data is displayed. Short text, long text, and hyperlink fields 

usually have no format. Predefined numeric field formats include: 

• General Number – (Default) Display the number as 

entered. 

• Currency – Use the thousand separator; follow the settings 

specified in the regional settings of Windows for negative 

amounts, decimal and currency symbols, and decimal 

places. 

• Euro – Use the euro symbol (  ), regardless of the 

currency symbol specified in the regional settings of 

Windows. 

• Fixed – Display at least one digit; follow the settings 

specified in the regional settings of Windows for negative 

amounts, decimal and currency symbols, and decimal 

places. 

• Standard – Use the thousand separator; follow the settings 

specified in the regional settings of Windows for negative 

amounts, decimal symbols, and decimal places. 

• Percent – Multiply the value by 100 and append a percent 

sign (%); follow the settings specified in the regional 

settings of Windows for negative amounts, decimal 

symbols, and decimal places. 

• Scientific – Use standard scientific notation. 

When it comes to date/time fields, Access automatically displays 

the date and time in the General Date and Long-Time formats. The 

dates appear as, mm/dd/yyyy in the U.S. and as, dd/mm/yyyy 

outside the U.S. where mm is the month, dd is the day, and yyyy is 
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the year. The time is displayed as, hh:mm:ss AM/PM, where hh is 

the hour, mm is minutes, and ss is seconds. Here are some other 

predefined formats for date/time fields: 

• Long Date – Displays only date values, as specified by the 

Long Date format in your Windows regional settings. i.e. 

Monday, May 13, 2018. 

• Medium Date – Displays the date as dd/mmm/yy but uses 

the date separator specified in your Windows regional 

settings. i.e. 13-May-2018. 

• Short Date – Displays date values, as specified by the 

Short Date format in your Windows regional settings. i.e. 

5/13/2018. 

• Medium Time – Displays hours and minutes followed by 

AM or PM. Access uses the separator specified in the Time 

setting in your Windows regional settings. i.e. 9:23 AM. 

• Short Time – Displays only hours and minutes. Access 

uses the separator specified in the Time setting in your 

Windows regional settings. i.e. 9:23. 

Other popular (not all inclusive) field properties that appear based 

on certain data types include: 

• Decimal Places – Specifies the number of decimal places to 

use when displaying numbers. 

• Caption – The label text that is displayed for this field by 

default in forms, reports, and queries. If this property is 

empty, the name of the field is used. Any text string is 

allowed. 

• Default Value – Automatically assigns the specified value 

to this field when a new record is added. Popular with State 

or Country fields for data entry in regional uses. 
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• Input Mask – Controls how data is entered and is useful 

when text or date entries should follow a certain format. 

Access has several predefined masks. To open the Input 

Mask Wizard, click the ellipses (…) at the end of the Input 

Mask field. Popular existing input masks include the Phone 

Number and Zip Code masks. Typically, clicking Next to 

accept the default options throughout the wizard will create 

the most common input masks. Custom masks can be created 

by clicking the Edit List button. Mask characters include the 

digits 0 and 9. A 0 placeholder means that a digit is required, 

whereas a 9 means that a digit is optional. For example, the 

last four characters of a Zip Code are often optional, so the 

mask would display as 00000-9999. 
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• Validation Rule – Helps ensure accurate data through 

creation of an expression criterion that must be true 

whenever the value is added or changed in the field. 

Validation rules are popular for numeric and date entries and 

are formed with one or more relational operators and/or 

logical operators. A typical rule in an Order Entry table/form 

might require the Quantity be at least one. The rule in the 

Quantity field could be  >=1. 

• Validation Text – If an entry breaks the rule, it is cleared 

from the entry box and the Validation Text is displayed in a 

dialog box. Highly recommended to be used in conjunction 

with the Validation Rule so the data entry person knows why 

their entry is not acceptable. 

• Required – Specifies if data must be entered or not. Choice 

is Yes or No. Default is No. 

• Indexed – Specifies whether the field has an index. There 

are three available values: Yes (No duplicates) – Creates a 

unique index; Yes (Duplicates OK) – Creates a non-unique 

index; No – Removes any index on the field. If users often 

search a table in Access or sort its records by a particular 

field, users can speed up these operations by creating an 
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index for the field. Access uses indexes in a table as people 

use an index in a book: to find data, Access looks up the 

location of the data in the index. In some instances, such as 

for a primary key, Access automatically creates an index. At 

other times, it may be necessary to create an index manually. 

Primary and Foreign Keys 
Fields that are part of a table relationship are called keys. A key 

usually consists of one field but may consist of more than one 

field. There are two kinds of keys: 

• Primary key – To ensure that no two records in a table are 

identical, one field in each table is designated the primary 

key. A primary key consists of one or more fields that 

uniquely identify each record that you store in the table. 

Often, there is a unique identifier, such as an ID number 

(Employee ID, Customer ID, etc), a serial number, or a 

social security number that serves as the primary key. 

Always choose a primary key whose value will not change. 

A key icon appears next to the name of the primary key field. 

AutoNumber data type fields make good primary keys. 

• Foreign key – A table can also have one or more foreign 

keys. A foreign key contains values that correspond to values 

in the primary key of another table. For example, you might 

have an Orders table in which each order has a customer ID 

number that corresponds to a record in a Customers table. 

The customer ID field is a foreign key of the Orders table. 
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Table Relationships 

Access is a relational database management system. In a relational 

database, users divide information into separate, subject-based 

tables. Keeping data separated in related tables produces the 

following benefits: 

• Consistency – Because each item of data is recorded only 

once, in one table, there is less opportunity for ambiguity or 

inconsistency. For example, storing a customer’s name only 

once in a table about customers versus storing it repeatedly 

(and potentially inconsistently) in a table that contains order 

data. 

• Efficiency – Recording data in only one place results in less 

disk space used. Additionally, smaller tables tend to provide 

data more quickly than larger tables. Finally, not using 

separate tables for separate subjects will introduce null 

values (the absence of data) and redundancy into the tables, 

both of which can waste space and impede performance 

• Comprehensibility – The design of a database is easier to 

understand if the subjects are properly separated into tables. 

In relational database terms, a relationship is a situation where 

multiple tables can contain related data that is linked by a common 

field. A relationship consists of a parent table and a child table. The 

child table references the parent table by having a field that matches 

a field in the parent table. The child’s field is the foreign key, 

whereas the parent’s field is the primary key. In a relationship, any 

data entered into the child’s foreign key field must match a value 

from the parent’s primary key field. By ensuring that the foreign 

key’s data matches data in the primary key, Access ensures that all 

records in the child table will have an associated record in the parent 

table. There are three types of relationships: 
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• One-to-One – A row in table A can have only one matching 

row in table B, and vice versa.    i.e. A baseball player can 

have only one Jersey Number. 

• One-to-Many – A row in table A can have many matching 

rows in table B, but a row in table B can have only one 

matching row in table A.   i.e. A baseball player can have 

many games played. 

• Many-to-Many – A row in table A can have many matching 

rows in table B, and vice versa. This is achieved using a third 

table (commonly called a junction table) that contains 

lookup data for both tables. Multiple players can play 

multiple games. 

Determining the relationships between tables helps ensure that the 

right tables and columns exist. When a one-to-one or one-to-many 

relationship exists, the tables involved need to share a common 

column or columns. When a many-to-many relationship exists, a 

third table is needed to represent the relationship. 

Entering and Editing Records 

Entering records directly into Datasheet View is probably the most 

intuitive way to enter data into a database. In Access, this is common 

because many Access databases are considered single-user 

databases. With multi-users databases, data integrity policies would 

discourage most users from having editing rights directly to the 

tables. Therefore, in these databases, the more common method for 

entering and editing records in a database would be via a form. 

Nonetheless, entering records directly into Datasheet View has 

some advantages, including: 

• Users can look at their data in columns and rows in a 

datasheet without using any special formatting. 
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• When a user opens a table in Datasheet View it resembles a 

Microsoft Excel worksheet, and the user can paste or add 

data in one or multiple fields. Data can be copy and pasted 

from a Word table or Excel worksheet into Access. 

• Printing a table’s datasheet in Portrait or Landscape 

orientation. Use Print Preview to change the orientation and 

margins before printing. Output can also be sent to a PDF 

file. 

• Users don’t need to explicitly save their data. Access 

commits user’s changes in the table when they move their 

cursor in the same row towards a new field, or if they move 

their cursor towards another row. 

• Sorting and filtering data is very similar to Microsoft Excel. 

Access allows users to sort data in Datasheet View one iteration at 

a time in either Ascending or Descending order. Ascending order is 

also referred to as alphabetical order when the sort is based on a text 

field, chronological order when the field is a date/time data type 

or numerical order when the data type of the field is Number. 

Sorting a datasheet does not affect the order that the records are 

displayed in a form. 

Displaying records based on specified criteria is called filtering. 

When a filter is applied, records that do not meet the specified 

criteria are hidden from view until the filter is removed. To filter 

records based on the data in a field, click in the field to base the filter 
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on and then click on the Filter button on the ribbon or click the drop-

down triangle to display a menu similar to the graphic below. 

To remove a filter, clear the check boxes, and click OK or click the 

Filter button again or click the Advanced button on the ribbon 

and choose Clear All Filters. 

Most databases contain hundreds, if not thousands, of records. 

Therefore, when a table becomes so large that the records and data 

do not fit in the datasheet window without scrolling, the Find feature 

becomes very practical. 



 

 
Access Chap 1   P a g e  | 166 

 
In Datasheet view, use the Find command, from the Home tab, to 

quickly locate specific records using all or part of a field value 

entered in the Find What: field. If in the States table above, if the 

user entered the value North in the Find What field, Access would 

find two records for North Carolina and North Dakota, but only if 

the Match: value was changed from Whole Field to Any Part of 

Field or Start of Field. Using wildcard characters can be extremely 

helpful if the user does not know the exact spelling of the value they 

are looking for. A wildcard character can replace a single character 

or multiple characters, which can be both text and numbers. Clicking 

the Replace tab will allow the user to replace the data in the Find 

What: field with the data entered in the Replace With: field. This 

could be very useful when updating name changes, such as when 

Kentucky Fried Chicken changed their name to KFC in 1991. 
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Creating Forms 

A form is a database object that offers an alternative interface to a 

table beyond the Datasheet view of the table. Forms can improve 

data entry proficiency by rearranging the order and tab sequence of 

fields within a table. Forms can also be designed to hide certain 

fields from appearing. For example, a credit limit or credit card 

number field might only be accessible from the table Datasheet view 

to limit the access to sensitive data from users who do not have rights 

to view or edit tables. In Access, users have the option of creating a 

blank form from scratch, using the Form Wizard, or having Access 

automatically create a form from a table or query. 

A basic form can be easily created by using the Form tool. Simply 

select the table (or query) in the Navigation Pane that the form 

should be based off, and then click Create > Form (from the Forms 

group). all the fields from the underlying data source are placed on 

the form. If Access finds a single table that has a one-to-many 

relationship with the table or query that you used to create the form, 

Access adds a datasheet to the form that is based on the related table 

or query.  
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A split form can be created by clicking More Forms from Create tab, 

and then choosing Split Form. A split form displays two views of 

the data simultaneously — a Form view and a Datasheet view. 

Working with split forms provides the benefits of both kinds of 

forms in a single form. For example, a user can use the datasheet 

portion of the form to quickly locate a record, and then use the form 

portion to view or edit the record. 

 
Split Form 

To be more selective about what fields appear on your form, use the 

Form Wizard. This multi-step process allows the user to define how 

the data is grouped and sorted, and in some instances, fields from 

multiple tables/queries can be added to the same form. Once a form 

is created, use the different views to modify the forms design or 

populate the forms with data. Forms have three views: 
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• Form view – shows the data in the form. This is the view to 

use to enter or change data. Record controls at the bottom of 

the form are used to display specific records and add a new 

record (the right arrow with the yellow star). The form’s 

design properties cannot be changed in this view. 

 

 

Form View 
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• Layout view – shows the form and the data in a visual 

layout. This is the view that opens when a form is initially 

created. Some of the form design properties, such as field 

fonts and column widths, can be changed in this view. 

However, the data cannot be changed in this view. Notice 

the Form Layout Tools contextual tabs! 

Layout View 
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• Design view – shows the form design, but not the data. Any 

aspect of the form’s design can be changed in this view, but 

the data cannot be changed. The Design, Arrange and 

Format contextual tabs appear for this view too. 

The Design tab allows the user to modify the color, fonts or 

theme of the form. A logo, title and/or date/time field can 

also be added to the form. Form controls (buttons, text 

boxes, combo boxes, etc) can also be added. 

The Arrange tab is used for modifying the order and position 

of the fields on the form. The Format tab allows the user to 

modify the style of the form including the fonts and a 

background image can be added. 

Design View 



 

 
Access Chap 1   P a g e  | 172 

 

 

A user can switch between views as often as desired while 

customizing the form. Switching views can be done by using the 

View button on the Ribbon, or the three icons at the bottom right of 

the Access window.  

NOTE: If a field in a table has been modified after the form is 

created, the existing form does not automatically update. The form 

can be modified, but sometimes it is easier to delete the existing 

form and recreate it based off the new table settings. 
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Practice 9 – Auto Sales – Part 1 

1. Open the data file AutoSalesData.accdb.  

2. In the Customers table, apply an input mask to the Phone 

field. (Hint: The Salespersons table has an input mask on its 

Phone field.) 

3. In the Sales table add a Validation Rule to the SalesPrice field 

to ensure no auto is sold for less than $500. Add Validation 

Text that instructs the data entry person to add a valid price if 

less than $500 is entered for a record. 

(Hint: validation rules should use comparison operators). Say 

Yes to Data Integrity rules alert messages. 

4. Add the following two records to the Customers table. 

(Accept the default CustomerIDs) 

Arnold; Hammer; 218-555-8811; 212 Elm Street; Aurora; 

MN; 59990 

Susan; Wong; 218-555-0182; 212 Fir Street; Aurora; MN; 

59990 

5. Add the following two records to the Salespersons table. 

MT001; Ming; Tran; 218-555-4470; 5.00% 

SS001; Sandy; Swensen; 218-555-7788; 4.50% 

6. Add the following two records to the Autos table.  

N331155007; Honda; Pilot; 2017; White; 13600; $31,499 

N991155007; Toyota; Camry; 2016; Red; 26500; $21,499 

7. Add the following two records to the Sales table. (Accept the 

default InvoiceNums) 

Arnold; N331155007; Ming; 9/1/2018; $29,500 

Susan; N991155007; Sandy; 10/1/2018; $18,000 
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8. In the Autos table, make the Serial Number field the primary 

key field by clicking the Primary Key icon on the Design 

ribbon. Say Yes to save the table. 

9. Create a form based off the Autos table named Autos_F. 

10. Add a new field to the Autos table named Certified. The Data 

Type s/b Yes/No. Close and Save and verify the new field 

appears in the Datasheet view, but not in the recently created 

form. 

11. Delete the existing form, and then re-create a new form based 

off the new Autos table. Verify that the new form now 

includes the Certified field. 

12. Close all open objects and then close the database. Notice that 

the database is always saving edits. If you want to save the 

database with a new name, use the File > Save As > Save 

Database As command.  The Save As button appears at the 

bottom of the window. 

 
LICENSE 
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Access Chapter 2: Retrieving 
Information from a Database 

• Query Basics 

• Types of Queries 

• Sorting Queries 

• Access Reports 

  

 

This Photo by Unknown Author is licensed under CC BY-SA-NC 
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Query Basics 

Queries are far more powerful than the simple searches or filters that 

might be used to find data within a table. This is because queries can 

draw their information from multiple tables. The real power of a 

relational database, like Access, lies in its ability to quickly and 

easily retrieve and analyze data by running a query. Access queries 

allow users to pull information from one or more tables based on a 

set of search conditions the user defines. A common synonym for 

the word query is: question or inquiry. Queries essentially ask 

questions of databases. Queries do not store data. Therefore, a major 

benefit of queries is the ability to save a query to be re-ran at a later 

time after table data has been updated. This eliminates the need 

spend time recreating all the fields and criteria desired to answer a 

popular question, such as a customer calling frequently to check on 

their latest account balance. 

Queries can be something simple, like list all names in a table, or 

something a little more complex, like list all products that are priced 

over certain amount. A query can be very simple or very complex, 

depending on the user’s requirements. As tables grow in size they 

can have hundreds of thousands of records, which makes it 

impossible for the user to pick out specific records from that table 

without a query. The tricky part about queries is that one must 

understand how to construct one before one can actually use them. 

 
When a query is run, the results are presented in a table, but when a 

query is designed, a different view is used. This is called Query 

Design View, and it lets users see how the query is put together. 

While the Simply Query Design Wizard can be used to display fields 
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from one or more tables or queries with the option to choose a 

detailed or summary report, the wizard is limited by its inability to 

select data criteria. This is why most Access queries are created in 

Query Design View, as this allows for far more complexity to be 

added to create complex simple to complex queries. 

After clicking the Query Design button on the Create tab, the Query 

Design View opens and by default the Show Table dialog window 

appears with a list of available tables and queries that can be added 

to build the query. Select one or more tables that contain the data 

desired to produce the answers to the potential questions. However, 

only add tables that contain fields that you intend to add to the query 

design. Tables added to the query design that do not have fields in 

the query grid can skew the query results. The exception to this rule 

is if the table is needed to join two or more other tables that are part 

of the query design. After the Show Table window is closed, it can 

be re-opened by clicking the Show Table button in the Design 

contextual tab. 



 

 
Access Chap 2   P a g e  | 178 

 
The next step to creating a query is to add the fields from the 

tables/queries into the query design grid (at the bottom of the 

window). Fields can be added by double-clicking the fields from the 

tables in the Object Relationship pane. A user can also drag a field 

from the table to the grid. A field can also be selected from the Field 

drop-down list in each column of the query design grid. If the fields 

are added in the wrong order, the column can be deleted or moved 

by clicking the top of the column and dragging the field to the 

appropriate location. 

Types of Queries 

Numerous queries from simple to complex can be created. A few 

of the more popular queries include: 

• Single-Table Select query 

• Multiple-Table Select query 

• Range query 

• Complex query 

• Totals query 

• Action query 

• Parameter query 

• Crosstab query 

The simplest query is a Single-Table select query. A single-table 

query is based on only one table. It is essentially the same as an 

advanced filter applied to a table. To create a query in Design View 

follow these steps: 

1. Add the data source(s). This can include table(s) and/or 

queries from the Show Table dialog window. For a single-

table query, only one table will be selected. 
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2. Join related data sources: Access does not automatically 

create joins between queries and tables that are not related. 

If Access does not create joins when data sources are added, 

joins should be created manually. Data sources that are not 

joined to any other data source can cause problems with the 

query results. To add a join, drag a field from one data source 

to a corresponding field on another data source. Access 

displays a line between the two fields to show that a join has 

been created. Note: the graphic below is NOT an example of 

a Single-Table query. A Single-Table query would only have 

one table, so a join would not be applicable. 

3. Add output fields – Double-click or add a field from a data 

source in the upper pane of the query design window down 

to the Field row of the QBE grid, in the bottom pane of the 

query design window. To quickly add all fields down to the 

Field row of the query-by-example (QBE) grid, double-

click the table or query name from the upper pane to 

highlight all the fields in that source and then drag them all 

down to the QBE grid at the same time. Alternatively, 

double-click the asterisk in the table. 

4. Specify criteria – (Optional) Use the Criteria: and/or Or: 

rows in the grid to limit the records that the query returns 

Query Design View 

Query By Example Grid 
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based on whether data from the fields meet the specific 

criteria. Non-Select queries utilize this row extensively. 

5. Execute (Run) the query – To see the results of the query, 

click the Run button on the Query Tools Design tab. Access 

will display the query results in Datasheet view. To make 

additional changes to the query, click the View button to 

return the Query Design View to make necessary edits 

before re-running the query. If the query is complete, click 

the Save command in the Quick Access toolbar. When 

prompted to name it, type a descriptive name and click OK. 

The new query should now appear in the Navigation Pane in 

the Queries object group. 

As previously stated, a relational database must have multiple 

tables. Therefore, Multiple-Table Select queries are far more 

common than Single-Table queries. The key to these queries is 

adding tables or queries that are related through joins via a common 

field. This may require a little planning before composing at the 

computer. Determine what information is needed for output, and 

then pinpoint which tables contain the fields needed to produce the 

information. Further analysis may reveal that criteria might be 

needed to streamline the results. The query in the previous graphic 

uses fields from four related tables. 

A select query with criteria that matches a range of values is called 

a range query. This type of query relies on relational operators to 

restrict the query results. When a range query compares text, 

alphabetical order is used to determine which data matches the 

criteria. For example, to return all used vehicles less than $10,000 

from a database of used vehicles, the criteria would be < 10000. 

Note the lack of a dollar symbol or comma delimiter? Adding a $ in 

front a number would change the datatype from a Number to a Text 

data type. Another example using the States table that tries to return 

results that do not include North Dakota results would use a criterion 



 

 
Access Chap 2   P a g e  | 181 

such as <> “ND”. Using the quotation marks indicates that the 

criteria is of the Text data type. 

A complex query is any query that uses criteria in multiple fields. 

Criteria can include relational operators as well as logical operators. 

If multiple criteria exist in the same row, the And operator is 

implied. The Or operator can be used in the Criteria row or using the 

Or: row below the Criteria: row. Complex queries often utilize 

wildcard characters to add additional complexity. Complex queries 

sometimes include the same field twice to accommodate additional 

criteria. In these situations, the Show checkbox is often cleared to 

prevent the field from displaying twice in the query results. The 

graphic above illustrates a query that includes AND as well as OR 

Complex Query 
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criteria, and wildcard characters too! The results should produce a 

list of music CDs that include any Classic Rock CDs and any 

Country CDs from Artists that include the name “Brooks” in any 

combination. This would include any Garth Brooks CDs as well as 

any Brooks and Dunn CDs. 

There are times when setting simple criteria won’t generate the 

desired results, especially when working with numerical values. The 

objective may be to see the query results grouped or counted in some 

way. A Totals query uses a type of function called an aggregate 

function to sum the data in a query result set. Aggregate functions 

perform a calculation on a column of data and return a single value. 

Access provides a variety of aggregate functions, 

including Sum, Count, Avg, Min and Max.  

To sum data, add the Sum function to the query, to count data use 

the Count function, and so on. The following example will illustrate 

how many of various bakery menu items have been ordered. The 
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query datasheet results below display the quantity of various cakes 

ordered on separate order transactions.  

Creating a Total query will group all identical menu items from 

separate orders, and then by using the Sum function, Access will add 

values in the Quantity field to calculate the total number 

ordered for each menu item. To create the Total query, the first 

step is to click the Totals button  from the Show/Hide group 

of the Query Tools Design tab. This will add a Total: row to the 

query design grid. The default values in the row are set to Group By. 

Clicking the drop-down arrow in the Quantity column of the Total: 

row, and selecting Sum will accumulate (add) the quantities of 

products ordered. Executing the query by clicking the Run button 

will display the results in the query’s datasheet view as shown 

below. Note the Quantity field name changes to SumOfQuantity. 

In Access, queries can do a lot more than just displaying data. 

Through the use of assorted Action queries, Access can perform 

various actions on the database data. Microsoft Access provides 

four different types of Action Queries: 
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• Append –   Retrieves data from one or more tables and 

adds the data to another table. 

• Update –  modifies or updates records. Criteria can be 

specified to limit which records are updated, but if no criteria 

is specified, all records will be updated. 

• Delete –  useful for quickly deleting a set of data on a 

regular basis. 

• Make-table –  retrieves data from one or more tables, 

and then loads the result set into a new table. That new table 

can reside in the database currently open, or a new database 

can be created. 

Action queries change data based on some set of criteria. Action 

queries can delete records, update data, append data from one or 

more tables to another table, and make a new table. Users must be 

cautious because once the query is executed, the data is changed and 

cannot be undone. Experts advise to make a backup of the database 

before proceeding with significant action queries. 

A parameter query retrieves information in an interactive manner 

by prompting the end user to supply criteria before the query is run. 

If a particular query is used often but modified slightly, a parameter 

query may be more efficient. When the query is run, the user is first 

prompted to enter a parameter (or multiple parameters). Once the 

parameter has been supplied, the query can return the results, based 

on the parameter provided. The key to creating parameter criteria is 

to enter the parameter prompt inside square brackets, such as: 

[What’s your favorite color?]. The square brackets will cause a 

parameter dialog box to open when the user runs the query. The text 

inside the square brackets will be displayed to the user, and an input 
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field will be displayed for their input. If the user enters purple in the 

prompt, all records in table that store the data: purple will be 

returned as the query results. 

In the example above, parameter criteria are entered in the Genre 

field’s Criteria cell. When the query is executed, Access will display 

the following prompt: If the user were to enter the data: Pop in the 

prompt, the following results would be displayed the query 

datasheet view. (The data entered into the prompt is not case-

sensitive) 

A crosstab query is a special type of query that calculates a sum, 

average, or other aggregate function, and then groups the results by 
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two sets of values — one down the left side (row headings) of the 

datasheet and the other across the top (column headings)- much like 

an Excel spreadsheet. When building a crosstab query in Design 

view, use the Total and Crosstab rows in the design grid to specify 

which field’s values will become column headings, which fields’ 

values will become row headings, and which field’s values to sum, 

average, count, or otherwise calculate. 

In the above example, the Music database will calculate a Count on 

the number of CDs are possessed by Artist – using the Row 

Headings and by Genre – using the Column Headings. The Title 

field will serve as Value field. The data source is an existing query 

named Classic Rock CDs, which provides the fields necessary to 

create the crosstab query. After executing the query, the datasheet 

results appear similar to: 

 

A crosstab query does not always populate all the fields in the result 

set because the tables used in the query do not always contain values 

for every possible data point. It is possible to enter an expression in 

the Criteria row to limit the results for the column heading field. 

However, using a criteria expression with the column heading field 

does not limit the number of columns returned by the crosstab query. 

Instead, it limits which columns contain data. For example, suppose 
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you have a column heading field that has three possible values: red, 

yellow, and blue. If you apply the criterion =’blue’ to the column 

heading field, the crosstab still displays a column for red and a 

column for yellow, but only the column for blue contains data. 

Sorting Queries 

Sorting in Access is the process of rearranging records in a specific 

order. Sorting data can create a significant 

impact on the usability of Access queries and 

reports. Sorting can occur before or after 

executing a query. In the datasheet view, a 

query can be sorted after running the query by 

using the Sort Ascending and Sort Descending 

buttons in the Sort & Filter group of the Home tab. To create more 
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complex sorting criteria, use the Query Design window to create 

multi-field sorts. 

Multi-field sorting requires the use of primary, secondary and 

potentially, tertiary sorting fields. Using Access’ Query Design 

View, fields can be arranged in any order in the QBE grid to 

accommodate the desired order. It is important to comply with the 

sorting rules inherent with the various data types of each field (see 

table above).  If you sort by multiple fields in Access, the order of 

the sorting is applied by field, from left to right, when viewing the 

result set. When sorting this way, you include the sorting criteria in 

the query’s SQL code. This then sorts the query result set the same 

way each time you run the query. However, this can be manipulated 

by adding duplicate fields to the grid, specifically for sorting 
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purposes. The key to this strategy is to utilize the Show checkbox 

for these sort-only fields. Clearing the Show checkbox will prevent 

these fields from displaying the Datasheet results, but their sorting 

mission will still be accomplished! Using Query Design also affords 

the ability to sort one field in Ascending order and another in 

Descending order in the same sort process. 

In the example below, the goal is to sort the records primarily by 

Last Name. However, some records might share the same Last 

Name. Therefore, if there are duplicates, the First Name field will 

serve as the secondary sort criteria. Furthermore, it is desired that 

the results set display the records with the First Name field to the 

left of the Last Name field. This necessitates the use of a duplicate 

First Name field that will only be used for sorting purposes. Also 

notice that the Show checkbox is cleared for this duplicate field, so 

as not to confuse the layout of the results set. Hiding a field, by 

clearing the Show checkbox. can also be used for applying Criteria 

restrictions on a field that is not desired to be displayed in the results 

set but is needed to narrow the results. This is popular with the 

sensitive data, like Salary or Credit Limits. 

 

Access Reports 

Utilizing Access to analyze data results in lots of information. This 

Information needs to be shared – often will people who do not, or 

should not, have rights to utilize the Access database. 

Access reports organize and present data in a reader-friendly, 

visually appealing format by using data from any queries or tables 
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in the database. The tables or queries that provide the underlying 

data are also known as the report’s record source. A report is a 

database object that comes in handy when you want to present the 

information in your database for any of the following uses: 

• Display or distribute a summary of data. 

• Archive historical information. 

• Provide details about individual records. 

• Create labels. 

There are four different report views in Access. Two are essentially 

print views and the other two are report building views. As with all 

other Access objects, you can toggle the view using the buttons at 

the bottom right of the screen, or by using the View button on the 

Ribbon. The four views include: 

• Report view – shows how a report would appear with 

dummy data using a continuous page layout. 

• Print Preview – allows users to see what the report will look 

like when printed. This view can be used to change the page 

layout, including the report orientation. 

• Layout view – allows users to edit the report design while it 

contains live data. Considered the most intuitive view to use 

for report modification, this view can be used for nearly all 

potential changes to a report in Access. 

• Design view – allows users to view and change any aspect 

of the report structure, but not the data. This view displays 

any expressions that are used to generate content and 

displays the header and footer bands for the report, page, and 

groups. This is the preferred view for adding controls to the 

report, such as labels, images, lines and rectangles. 

The design of a report is divided into sections that can be modified 

in the Design view. Reports created by using the Report button are 

plain and simple, and have several sections, as detailed in the table 
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to the right. More complex reports created using the Report Wizard 

can also have multiple group header and group footer sections to 

print grouping details and summary information. 

 

Reports can be designed and formatted in a similar way to forms. 

When you create a report, four new tabs appear in the Report Layout 

Tools section of the Ribbon specifically for working with reports. 
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• Design: Group and sort elements in the report, add text and 

links, insert page numbers, and modify the sheet’s 

properties. 

• Arrange: Adjust the table to be stacked, tabular, etc.; move 

rows and columns up an down or left and right; merge and 

split columns and rows; control the margins and bring 

elements to the “front” or “back” in a layering format. 

• Format: Includes regular word processor formatting tools 

like bold, italic, underline, text and background color, 

number and date formatting, conditional formatting, etc. 

• Page Setup: Allows adjusting of the page’s overall size and 

toggling between landscape and portrait. 

Another popular approach to creating reports is to use the Access 

Report Wizard. The Report Wizard provides more flexibility than 

by simply using the Report button. The Report Wizard guides users 

through a series of questions and then generates a report based on 

these answers. Users can choose the tables and fields, group the data, 

sort the data, summarize the data, choose a layout and orientation, 

apply a style, and title the report. Grouping data puts all the values 

in a field into a group based on the field’s value. By using the Report 

Wizard, users can create up to four sort levels. If the data has been 

grouped, the option exists to summarize the data by displaying the 

sum, average, and minimum or maximum value for each numeric 

field. Choose to have the report display just the summary data or 

each detail line and the summary data. Note: Users can also add 

grouping, sorting, or totals by using the Group, Sort, and Total pane 

while the report is open in Layout view or Design view. 

To print a report, right-click the report in the Navigation Pane and 

choose Print Preview from the shortcut menu. Print Preview 

command options include: 

 

• Print the report 

• Adjust page size, margins or orientation 

• Zoom in or out, or view multiple pages at a time 
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• Refresh the data on the report 

• Export the report to another file format. 

To save paper, or to send a print job to a professional printer, or send 

the report via e-mail, you can create a .pdf or xps format of your 

report: On the Print Preview tab, in the Data group, click PDF or 

XPS. Reports can be saved as an object in the Navigation Pane, and 

at later date, updated and re-printed. Unlike Access queries, the page 

settings are maintained in Access reports when saved. 

 

  

This Photo by Unknown Author is licensed under CC BY-SA 

http://stackoverflow.com/questions/14526236/dynamic-sequencing-of-data-in-ms-access-reports
https://creativecommons.org/licenses/by-sa/3.0/
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Practice 10 – Auto Sales - Part 2 

13. Open the data file AutoSalesDataChap2.accdb.  

14. Add the following records to the Sales table. (Accept the 

default InvoiceNum) 

Ahmed; N840084247; Sandy; 10/1/2018; $450 (You should 

receive an error message that the minimum price must be 

$500). Change the price to $950. 

15. While many employees at the auto 

dealership cannot add or delete new 

records, most can run queries to 

“read” the data. You decide to create a 

simple query (via Query Design) of 

the Customers table that displays all 

details. (Hint: double-click the 

asterisk (*) in the Customers table.) 

Run the query, close and save the 

query as All Customers.  

16. Create a select query that displays 

First Name, Last Name, Phone, and 

City of only the customers from Aurora. Save the query as 

Aurora Customers. 

17. Create a complex query that displays all autos that are Hondas 

sorted by most expensive to least expensive. Display the 

Make, Model, Year, Color and Price. Save and name the 

query Honda Autos. 

18. Edit the Honda Autos query to sort by Year (newest models to 

oldest) and if there are duplicate Year models, sort by Price as 

the secondary sort.  

19. Create a new query similar to the Honda Autos query. Modify 

the new query to restrict the results to display all autos with a 

price of at least $10,000, sorted by Make and secondarily by 
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most expensive to least expensive. (You should get 22 results) 

Save and name the query as $10K Autos. 

20. Create a parameter query named Which Color?, that displays 

the Make, Model, Year, Mileage and Price of all autos. The 

query should prompt the user for the color, but the color 

should not display in the results. Run the query and enter 

Black as the color. (You should get 6 results) 

21. Close all objects and save the database. 
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Microsoft PowerPoint Chapter 1:  
Creating Presentations 

• Planning a presentation 

• Adding and deleting slides 

• Adding slide text versus slide notes 

• Creating bulleted and numbered lists 

• Comparing presentation views 

• Utilizing tables and charts 

• Inserting and modifying graphics 

• Creating a photo album 

• Inserting and modifying shapes 

• Utilizing WordArt 

• Inserting SmartArt 

• Inserting slide and handout footers 

• Apply design themes 

• Formatting the slide background 

• Replacing text and fonts 
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Planning a Presentation 

Microsoft PowerPoint is a presentation software program used to 

organize and present information to others. PowerPoint is a popular 

presentation aid that utilizes visual and stimulating elements to 

accompany a presenter’s communication through slides and 

multimedia tools. Planning a presentation necessitates defining the 

purpose of the presentation, identifying the target audience for the 

presentation, and deciding the type of output for the information. 

The purpose of the presentation can generally be categorized into 

either of two general areas. The most common purpose for a 

presentation is to inform an audience by providing facts and figures. 

Informational presentations often include slides with tables, charts, 

graphics and text. Classroom lectures that utilize PowerPoint are 

typically information-type presentations. A secondary purpose of 

presentations is to persuade or sell the audience on an idea. Sales 

and political speeches fall into this category of persuasive 

presentations. Style is almost as significant as content for persuasive 

presentations. Therefore, design themes are important 

considerations for this type of presentation. 



 

 
PowerPoint Chap 1   P a g e  | 199 

Another important consideration when planning a presentation is to 

determine the audience, including the venue in which the 

presentation will occur. The characteristics of the audience will help 

distinguish the type of vocabulary, font size, and design themes that 

would be appropriate. An audience of colleagues will allow more 

flexibility versus a group of customers, in terms of language and 

content. Understanding who the audience is, and why they are there 

can really influence the design and content of a presentation. The 

venue also influences the design of a presentation. A large room will 

require larger fonts and louder audio for the presentation to be 

understood by the audience. Conversely, a smaller room make 

necessitate a softer design. The presenter should also take time to 

ensure that the venue has ample and compatible audio-visual 

equipment (projector, cables, screen, speakers, etc.) to successfully 

run the presentation. 

Get to know the elements of the Microsoft PowerPoint window! 

Note the similarities to Word and Excel! 
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• The Quick Access toolbar contains one-click buttons for 

saving, undoing, redoing, and print previewing a 

presentation. You can easily modify this toolbar to add your 

most frequently used commands. Just click the down-arrow 

on the right edge to customize this toolbar! 

• The title bar displays the name of current presentation, and 

the program. A new presentation will default with a 

temporary file name, such as Presentation1 until you save 

the file with a different name. The Minimize, Maximize and 

Exit buttons appear on the right edge of the title bar. 

• The Tell Me tool is a new way to get assistance with specific 

tasks in PowerPoint. When the user starts typing, 

PowerPoint suggests commands that are related to your 

keyword(s). The tool is context sensitive and integrated into 

your current presentation versus opening a separate window. 

Therefore, if you type insert picture into the field, and click 

the resulting command, PowerPoint will open the Insert 

Picture dialog window without explaining the navigation 

instructions. 

• The Ribbon interface is a set of toolbars at the top of the 

window in Office programs designed to help you quickly 

find the commands that you need to complete a task. The 

ribbon displays a combination of icons and tabs. 

Commands are grouped under multiple tabs. Some 

commands are so extensive that they need additional 

windows to display their entire functionality. The dialog box 

launcher icon will open these windows. Contextual tabs will 

appear only when the user needs them, such as when a 

picture is selected, or a table is inserted. 
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Adding and Deleting Slides 

 

New slides can easily be added to a presentation by clicking the 

bottom half of the New Slide button in the Slides group of the 

Home tab. If the top half of the New Slide button is clicked, the 

default slide layout (Title and Content) will be inserted into the 

presentation. By clicking the bottom half of the button, a gallery of 

several different slide layouts will appear. 
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The type of content the user intends to add will dictate which slide 

layout is selected. Most slide layouts include one or more 

placeholder to guide the user where to add content. Placeholders 

can contain different types of content, including text, graphics, 

tables, charts, and videos. Placeholders can be resized, reformatted 

or deleted. The most common slide layout (Title and Content) has 

two placeholders. The user simply needs to place the cursor inside 

the placeholder and begin typing to add text or click an icon to add 

an object. PowerPoint automatically sizes the text as it is typed to fit 

within the placeholder. 

The AutoFit icon  is displayed next to a placeholder when more 

text than can fit is typed. 

The alignment, font, size, and other formats can be applied to the 

selected text in a placeholder by using the Mini toolbar or the Home 

tab. A layout can be changed by clicking the Layout button to the 

right of the New Slide button and choose a different layout. To 

delete a slide, right-click the slide in the thumbnail pane, and choose 

Delete Slide from the shortcut menu. 
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Adding Slide Text vs Slide Notes 
While text can be added to slides via placeholders in various slide 

layouts, text can be added directly to the Notes pane to create 

speaker notes for the presenter of the slide show. Maintaining a 

minimal number of slides requires that each slide only contain 

summary text, not details. The details need to be added orally 

through the presentation speaker. The data in the Notes pane does 

not appear in Slide Show view. The Notes pane can be opened or 

closed by clicking the Notes button on the status bar. 
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Creating Bulleted and 
Numbered Lists 

The Title and Content slide layout is both the default and the 

overwhelming most popular slide layout for most slides in a 

presentation. This is the root cause of why so many PowerPoint 

presentations bore their audiences with mundane amounts of text. 

The worst offense is when users simply write sentence upon 

sentence of text, which often gets read to the audience by the 

presenter. This is a known symptom of the notorious, “Death by 

PowerPoint” condition. A better approach is to create presentations 

which utilize bulleted and numbered lists to help organize text or 

show sequential processes. Too many slides of the same format can 

This Photo by Unknown Author is licensed under CC BY-SA-NC 

https://3844f16.tracigardner.com/page/3/
https://creativecommons.org/licenses/by-nc-sa/3.0/
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exhaust the audience, so use lists in moderation. However, when 

used with animation (discussed in the next chapter), lists can really 

help manage the flow of information by synchronizing the visual 

elements of the slide show with the verbal accompaniment of the 

speaker. 

As defined in the Word chapters, bulleted lists differentiate from 

numbered lists in that numbered lists demonstrate sequencing, 

whereas bulleted lists simply imply that each item is part of a non-

ordered group. Bullets and numbers can be formatted using custom 

symbols and number formats to synchronize with the presentation 

design. Bullets and numbers can also be indented to create sub lists. 

The Paragraph group contains the commands to increase and 

decrease the indentation of bullets and numbers. 

  

A slide with bullets and a numbered list 
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Comparing Presentation Views 

PowerPoint can display its slides in several different presentation 

views, which can be accessed from the View tab, the Status bar, or 

the Slide Show tab.  Each view has its own unique purpose as 

described in the table below.  

Presentation Views 
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PowerPoint offers a variety of views to display content depending 

on the situation. Some views help create a presentation, while others 

help deliver a presentation. Choose wisely! 

Utilizing Tables and Charts 

The organization of a PowerPoint presentation necessitates that the 

presentation be concise and meaningful. Tables and charts represent 

an opportunity to present a lot of data in an organized, structured 

graphic. Tables can be created and inserted into a slide in a similar 

process as Word tables. Tables can be inserted from the Insert tab, 

or by clicking the Table icon  from a Content layout 

placeholder. Two contextual tabs are available for formatting the 

table, similar to Word. Adding table styles that match the theme of 

the presentation is desirable. Creating tables through this process is 

ideal for tables full of text, such as the table in the illustration below. 

Tables can also be created in Word, and then copy and pasted into 

PowerPoint. Either way, tables are a great way to consolidate a lot 

of information into a single slide. 

If the table contains a lot of numerical data, it might make more 

sense to create the table in Excel and paste it into PowerPoint. Data 
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can be edited in PowerPoint using Excel formatting tools. Data can 

even be linked so that when the Excel file is updated, the 

PowerPoint slide is also updated. If the data is not linked, it is an 

embedded object. Embedded objects become part of the 

PowerPoint file and, after they are inserted, they are no longer part 

of the source (Excel) file. 

Charts are used to illustrate numerical data, which can help the 

audience visualize patterns, relationships, or trends in data. The 

decisions about linking or embedding a table are very similar to the 

decisions regarding inserting charts. Charts can be created in 

PowerPoint or Excel, but most are typically already created in Excel 

and simply need to be pasted into PowerPoint. Then comes the 

decision about embedding or linking the chart. When a chart is 

selected on a slide, options on the Chart Tools Design and Format 

contextual tabs can be used to modify the look of the chart. 

Inserting and Modifying 
Graphics 

Graphics can be utilized to make a presentation more interesting and 

informative. If the PowerPoint developer is trying to keep the length 

of a presentation to ten or fewer slides, keep in mind that many 

believe that a picture is worth a thousand words! Sometimes 

graphics can be more informative than words and enhance a 

presentation by evoking emotion in the audience. PowerPoint 

graphics typically refer to pictures, and pictures can take the form of 

digital photographs, clip art, or computer-generated imagery 

(CGI). Digital photographs are realistic images captured with a 

digital camera or scanned to a file by a scanner. Clip art images are 

line-based drawings that are intentionally non-realistic. An example 

of a computer-generated image is a logo, typically produced in a 

software program such as Adobe Illustrator, or a 3-D graphic, such 

as an avatar. 
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Inserting graphics into PowerPoint is very similar to Word. 

However, in addition to using the Images group options on the Insert 

tab, users can also insert a graphic via an icon in a content 

placeholder. Graphics can either be inserted from the user’s own 

device, or from online sources. 

Each type of graphic has its pros and cons. Clip art can be popular 

because their simplicity results in a compact file size, which can be 

increased or decreased without distortion. Additionally, the 

unrealistic nature of these images makes them appropriate for 

representing sensitive topics that require anonymity. Digital photos 

are very realistic, which inspire authentic reactions. However, these 

images result in large files that can be difficult to transfer among 

devices. Additionally, resizing a digital photo can create undesirable 

pixilation. 

Caution should be used to ensure that graphics are used 

appropriately by only including images that are relevant to the 

message being advanced. Graphics usage should also obey 

applicable copyright laws, especially when downloading images 

from Internet sources. According to the U.S. Copyright Office, 

This Photo by Unknown Author is licensed 

under CC BY 

An example of Computer-Generated Imagery (CGI) 

http://www.flickr.com/photos/mamjodh/2592478285/
https://creativecommons.org/licenses/by/3.0/
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a copyright is a form of protection for “original works of 

authorship”, and is usually identified by the © symbol. Photos and 

high-quality artwork that has been self-produced are not at odds to 

copyright infringement, but images downloaded from online 

sources should be credited, purchased or defined as royalty-free or 

be accessed through a Creative Commons (CC) license. By 

default, Microsoft’s Bing Image search engine will only return 

images licensed under Creative Commons when utilizing the Online 

Pictures command in PowerPoint. 

 
The robust photo-editing functionality within PowerPoint makes it 

easy to manipulate the size, location, and look of inserted graphics. 

After selecting the graphic, sizing handles will appear around the 

graphic, and the Picture Tools contextual tab will appear to offer a 

plethora of image formatting features. 
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Some of the most commonly used picture formatting tools include: 

1. Resizing and cropping. The easiest way to resize a graphic 

is to drag the sizing handles. The corner handles will 

increase or decrease the image’s size proportionally, 

whereas the middle or top/bottom handles can distort the 

Sizing 

Handles 
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image’s size. Specific height and width measurements can 

be defined in the Size group. Click the launcher to open the 

Format Picture pane. Clearing the Lock Aspect Ratio 

checkbox will allow the user to define specific sizes for the 

height or width without proportionally resizing the other 

dimension. Cropping an image result in a part of the image 

being removed. This is useful when an image has a lot of 

unwanted content that can distract from focusing on a certain 

aspect of an image. An image can even be cropped to fit into 

a specific shape. To reduce the file size of the presentation, 

use the Compress Pictures feature, in the Adjust group, to 

permanently delete the cropped portion of the image. 

Clicking Reset in the Format Picture pane or Reset Picture 

in the Adjust group will return the image to its original size. 

2. Corrections and Color adjustments. If an inserted picture 

is too dark, the Corrections feature allows the user to edit the 

picture’s brightness and contrast. The picture can be 

softened or sharpened as well to make the picture blurry or 

distinct. Color adjustments can also be applied to change the 

saturation (how vivid the colors are) and tone (the 

temperature – cool or warm) of a picture. Colored filters can 

also be overlaid to recolor a picture to fit the presentation’s 

theme. 
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3. Picture styles. Applying a picture style or effect from the 

numerous preset gallery options can visually enhance the 

way a picture appears. Picture styles make the picture look 

more stylish by applying a combination of borders, 3-D 

rotations, shadow effects or frame shapes. After selecting the 

picture, hover the cursor over any of the gallery choices, and 

PowerPoint will display a live preview of the style applied 

to the image. Clicking a selection will apply the picture style 

settings. 

 
4. Picture effects. Users can enhance a picture by adding 

effects, such as Shadows, Reflections, Glows, Soft Edges, 

Bevels or 3-D Rotations. To fine-tune the effect, click 

Options at the bottom of any effect menu. Multiple effects 

can be applied to the same picture, such as an outer shadow, 

an angle bevel and a contrasting right, perspective 3-D 

rotation. 
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Practice 11: The Continents 

1. Plan your presentation. Your goal is to create a slide show to 

accompany your presentation regarding the planet Earth. 

The content will include slides with text, a table and some 

photos of various continents. The design will be basic. The 

audience is your fellow classmates. 

2. Open the data file Continents.pptx from your data files. 

3. View the presentation in Slide Sorter view, and then revert 

back to Normal view. 

4. In the title slide, add your name to the subtitle placeholder. 

5. Insert a new Title and Content slide after the title slide (slide 

1). Add the title: Earth’s Continents, and then add seven 

bullets to the Content placeholder with the text: North 

America, South America, Europe, Africa, Asia, Australia, 

Antarctica. Make the title font 54pt. 

6. In slide 3 (North America), add an online picture of North 

America to the content placeholder using the Online Pictures 

icon. 

7. In slide 4 (South America), change the size of the graphic to 

have a height of 4.5”. Let PowerPoint adjust the width 

proportionately. 
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8. In slide 7 (Africa), apply a Brightness +20%, Contrast -20% 

correction adjustment. 

9. In slide 8 (Oceania/Australia), apply a Metal Oval picture 

style, and a Glow 18pt, blue picture effect, as well as a 

Perspective: Turned Left, Tilted Up 3-D Rotation picture 

effect. 

10. Add the following speaker note to the Oceania/Australia 

slide: Talk with an Aussie accent! 

11. Change the layout of the Oceania/Australia slide to a Title 

and Two Content layout. In the new content placeholder, add 

the following text bullets by referring to the illustration to 

the right: 

12. Save the presentation with the file name My Continents.pptx 

to your default local folder. 

Creating a Photo Album 
If your presentation’s purpose is more slanted towards entertaining 

versus educating, then a photo album is a popular feature that might 

facilitate that entertainment. PowerPoint’s photo album allows 

users to load a bunch of digital photos into a single file, one photo 

per slide, formatted consistently, with a variety of formatting 

options. Photo album is a great tool for creating self-running 

presentations that display photos from an event or a family memory 

(graduation, wedding anniversary, funeral, etc.) PowerPoint creates 

a new presentation file when a user chooses to create a photo album.  
 
To start, take note of where the photos you want for the album are 

located (preferably on a local device). Then go to the Insert tab and 

click the Photo Album button. Once the Photo Album window 

opens, the next step is to insert the pictures from your device by 

clicking the File/Disk… button. The Insert New Pictures dialog 

window will appear. The user should then navigate to where the 

photo files reside on their device, then select multiple picture files 

(remember to use the Ctrl button to select multiple non-consecutive 
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files) and choose Insert. The selected files will appear in the Pictures 

in Album scrolling window in the Photo Album window. The order 

of the slides can be rearranged in this window or in the main 

PowerPoint window. 

The more important decisions that should be determined before 

clicking the Create button pertain to the Album Layout and Picture 

Options. Notice how the Captions below ALL pictures option is 

disabled? This is due to the Picture layout currently being set to the 

Fit to Slide option. Choosing any other Picture layout will enable 

this option. Captions are a great way to add accompanying text to 

each slide in the album and provide explanation for the photos when 

no presenter is present. If this feature is skipped and needs reversing, 

choose the Insert tab, click the Photo Album drop down arrow, and 

select Edit Photo Album. The picture layout, frame shape, theme 

and picture options can all be redefined, and pictures can be added 

or deleted as well. The Insert Text Box is an alternative way to add 

manually add text to a separate slide versus the captions, which 

defaults with the operating system’s file name as the slide caption. 

This data can be edited for each slide via the normal PowerPoint 
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view. Photo albums can become even more entertaining when 

additional (yet to be explained) functionality is added. However, 

these features, which demand a lot of creative attention, can become 

very time-consuming! The Photo Album feature was designed to 

work with the Windows operating system. Therefore, this feature is 

not available for Mac users. 

Inserting and Modifying Shapes 

Many different types of shapes can be inserted into a PowerPoint 

slide to help illustrate concepts and draw attention. Want to 

emphasize a certain focal point on a slide? Draw an arrow and add 

a custom format! The basic shapes are found in the Drawing group 

of the Home tab, but more extensive selections exist from 

the Shapes drop-down list from the Insert tab. Shape 

categories include lines, geometric figures, arrows, stars, 

callouts, and banners. Once a shape is selected from the 

gallery, a crosshair pointer allows the user to draw the 

shape on a slide. Shapes can be filled, stacked, aligned, grouped and 

merged using advanced formatting. 

Many aspects of each shape can be further modified, including its 

line gradient, line color, fill color, weight, outline, shadow and other 

3-D effects. Similar to other graphics, like clip art or a photo, a shape 

can be resized, relocated and reset to complement the design of the 

presentation. Text can be added to further annotate a shape and 

explain a concept. 
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Utilizing WordArt 
Keeping the audience’s attention requires using non-standard text in 

order to maintain interest in the presentation. Strong visual elements 

help hold the audience’s attention. As discussed in the Word 

chapters, WordArt is a feature that applies decorative text styles 

and text effects to any text object in order to attract the audience’s 

attention. Features such as shadows, outlines, colors, glows, bevels, 

gradients, and 3-D effects can convert ordinary text into something 

extraordinary! The easiest way to utilize WordArt is to select an 

existing text object, then from the Drawing Tools contextual Format 
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tab, click a predefined WordArt style from the gallery of choices. 

Clicking the More drop-down arrow will expand the gallery. After 

selecting a style, the text will appear in the selected style, and can 

be further customized by choosing text fill, outline or effect options. 

WordArt is a great replacement for title text. Notice the difference 

between the two titles with normal text versus WordArt with text fill 

color, and a transform 3-D text effect. 

 

Inserting SmartArt 

Like WordArt, SmartArt is a cross-application feature that adds 

appeal, design and intrigue to an Office file. A SmartArt graphic is 

a professional-quality diagram that visually illustrates text using a 

variety of shapes. Like WordArt, a SmartArt graphic can be created 

from scratch or text can be converted with a few simple 

clicks. Converting a bulleted list to a SmartArt list is 

very easy! To create a SmartArt diagram from scratch, 

click the icon on the Insert tab. A gallery of graphics 

will appear. 
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Users can choose from among many different layouts to effectively 

communicate a complex concept. Categories range from process 

and cycle diagrams to list and relationship graphics. Choosing the 

appropriate graphic is key, because some of these diagrams are 

complex, and therefore, can be more confusing than informative. 

Other considerations when choosing to use a SmartArt graphic 

include the amount of text that will be included with the shapes 

versus the amount of legible space available on a slide. Too many 

shapes can easily overcrowd a slide to the point that it is illegible. 

Users can quickly and easily switch layouts, so try different layouts 

(across types) until you find the one that best illustrates your 

message. 

  



 

 
PowerPoint Chap 1   P a g e  | 221 

After selecting a SmartArt graphic, the diagram will replace the 

content placeholder of the slide. New [Text] placeholders will 

appear to allow the user to customize the diagram. Alternatively, a 

Text pane should appear to the left of the graphic to ease the 

insertion of text. If the pane does not automatically appear, click the 

arrow control on the left size of the SmartArt graphic. 

After adding text, and possibly photos, additional formatting is 

available from the SmartArt Tools contextual Design and Format 

tabs. The Change Colors and SmartArt Styles options offer radical 

format changes. A SmartArt style is a preset combination of 

numerous effects, such as line style, bevel, or 3-D, which can be 

applied to a SmartArt graphic to create a unique and professional 

design. 

 
To create a SmartArt graphic from 

existing text on a slide, place the cursor 

inside the text, click the Convert button 

from the SmartArt Tools Design tab, and 

then choose the Convert to Text option. 

This is a great way to liven up basic 

bulleted lists to eye-popping 

information! 
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Inserting Slide and Handout 
Footers 
Slide footers represent another way to further customize the look of 

the presentation. Slide footers are typically displayed at the bottom 

of the slide, depending on the presentation’s theme. Several fields 

are available to be added to each slide, including the date, a slide 

number or a customizable text field. A combination of 

these fields can be included or excluded. From the Insert 

tab, choose the Header & Footer option from the Text 

group to open the Header and Footer window. 

Two options that often get overlooked are the Don’t show on title 

slide checkbox, and the Apply versus Apply to All buttons. The Don’t 

show on title slide option is usually selected to prevent the footer 

from appearing on the title slide. To assign the footer options to the 

current slide, choose the Apply button. Alternatively, the Apply to 

All button assigns the footer options to all slides, except the title (if 

the Don’t show on title slide checkbox is marked). 
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Slide footers are different than handout footers. Both can exist in the 

same presentation, but each has their own uses. While the slide 

footers appear on screen during slide shows, the Notes and Handout 

footer is designed for hard copy printouts. 

Similar fields are available as the Slide Footer, although the Header 

text box represents a new option, and only the Apply to All button 

exists, since the header and/or footer will appear on all pages of the 

handouts/notes pages. The Header and Footer fields often contain 
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data like company or author names, copyright notices, and keywords 

like Confidential, Sample, Draft, etc. 

To delete any header and footer information from the 

Notes and Handouts printouts, open the Header & Footer 

window, click the Notes and Handouts icon, and clear all 

fields and checkboxes before clicking the Apply to All 

button.  

Apply Design Themes 
The most significant way to add visual impact to a PowerPoint 

presentation is to apply a design theme. A design theme is a named 

combination of formats that comprise of colors, fonts, backgrounds, 

and other effects. Themes exist throughout Microsoft Office so that 

files created in one application tie together with files created in other 

Office applications. While the default Office theme is plain and 

boring, users can choose from a gallery of other themes to give the 

presentation a new look and feel. To change the theme, select a 

theme from the Themes group on the Design tab. More themes are 

available by clicking the More button. 

Hover over a theme thumbnail to see the theme name. It’s also easy 

to quickly change the look and feel of a theme by using variants in 

PowerPoint.  Each theme has its own Variants that apply some 

predefined color and effect variations. Variants appear to the right 

of the themes in the Design tab. Variants can be further customized 

by clicking the More button to modify the theme colors, fonts, 

effects or background styles. To further customize a design theme, 

it is easy to apply a new variant while everything else about the 

theme remains the same. 
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Many organizations have a standard, recognizable theme that should 

be consistently used to follow the organization’s branding standards. 

While a theme can be applied to individual slides, it is advisable to 

apply one theme to an entire presentation, which creates a uniform, 

professional look. 

Formatting the Slide 
Background 
While each design theme has its own background colors, patterns or 

images, every slide in a PowerPoint presentation can modify a 

background by changing colors, gradient fills, or adding/subtracting 

graphics. The background is the area behind the text and graphics 

on a slide. 
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To customize the presentation’s background, click the Format 

Background button in the Customize group of the Design tab.  The 

Format Background pane will appear to the right of the slide pane. 

When choosing a different color or gradient fill for the slide 

background, consider ensuring that a proper contrast between the 

font colors and the background make the presentation easy to read 

for your projected audience. A dark background might be 
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appropriate with good lighting, but a dark room might necessitate 

using a light background color. The Transparency slide bar can mute 

the color by increasing the transparency percentage. A graphic can 

be inserted and strategically located to the side of the content 

placeholder by adjusting the Offset percentages. 

After defining all background settings, click the Apply to All button 

to update all slides with the new background. The slide illustrated 

below has the Facet theme with a custom background and a graphic 

offset to appear to the left of the content placeholder. 

Replacing Text and Fonts 
Popular presentations that get used over extended periods of time 

often need updating due to product, 

personnel or company name changes. This 

is particularly the case in technology 

companies. Instead of relying on manual 

editing to find specific words that need to 

be changed, the Find or the Find & Replace 

features can be much more accurate to 
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accomplish the same goal. In the Editing group of the Home tab, 

click the Replace drop-down list, and choose Replace … to open the 

Replace window. Use the Find what: and Replace with: fields to 

update the presentation by replacing certain text with new text. 

Exact case settings can be required to ensure words like Mark versus 

mark are not replaced inadvertently. 

Sometimes a new design requires that a font be changed throughout 

the entire presentation. Changing fonts throughout a presentation is 

very similar to changing certain text throughout a document or 

throughout a presentation. In the Editing group of the Home tab, 

click the Replace drop-down list, and choose Replace Fonts… to 

open the Replace Font window. In the Replace: drop-down list, 

choose the existing font that needs to be replaced, and then in the 

With: drop-down list, select the new font that should appear instead. 
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Printing a Presentation 

A hard copy of a presentation may be printed for a variety of 

reasons. A copy might be printed to provide an editor to review and 

edit. A second reason might be to generate speaker notes for the 

presenter. A third reason might be to produce handouts for audience 

members. Whichever reason is chosen, previewing the printout in 

Print Preview can resolve a lot of unforeseen issues before wasting 

a lot of time, paper and ink/toner. It is recommended to add the Print 

Preview icon to the Quick Access Toolbar to make it easy to review 

the presentation’s accuracy and organization. 
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The most common reason to print a PowerPoint file is to produce 

handouts, but this objective demands further consideration. How 

will the audience use the handouts? Will they use them as a 

reference, or will they be used to take notes? The answer to this 

decision will affect the first option under the Slides setting. The 

default is Full Page Slides, which is rarely the preferred selection 

since each slide is printed on its own sheet. Notes Pages should be 

the option if the intent is to generate speaker notes. The Outline 

option will print the presentation in outline format which prints text, 

but no graphics, tables or photos. This option is popular if saving 

paper is a goal. The nine different Handouts options offer various 

numbers of thumbnail versions of each slide per sheet of paper. 

Three slides is appropriate if it is desired to give the audience room 

to take notes, whereas six slides is suitable if the goal is simply to 

provide reference materials. Once the print options have been 

selected, click Print or the Print icon to print the presentation. 
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Practice 12: The Planets 

1. Download the Planets.zip file from the Course Data Files. 

Extract the files to a location on your device where you 

save files for this course. 

2. Open a new, blank presentation in PowerPoint. 

3. Insert a new photo album using the eight photos unzipped 

from step 1. Choose the 1 picture, Picture layout. Include 

captions below all pictures. 

4. Apply the Celestial theme, along with the blue variant. 

5. Change the title text to Our Planets, then change the text to 

WordArt with the Lime, Accent color 1 Pattern fill. 

6. Insert a slide footer with M State – 2023 on all slides 

except the title slide. Include a handout footer with your 

name. 

7. Capture a screenshot of Print Preview displaying handouts, 

2 Slides per page in full color. 

8. Compare your results with the screenshot below. Cancel 

the printing and save the file as Our Planets.pptx. 
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PowerPoint Chapter 2: 
Enhancing Presentations 

• Adding slide transitions 

• Apply animations to slide content 

• Scalable Vector Graphics and Icons 

• Adding and modifying audio 

• Adding and modifying video 

• Inserting and modifying hyperlinks 

• Utilizing templates and slide masters 

• Zoom, Zoom, Zoom! 

• Employing proofing tools 

• Saving files in alternative file formats 
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Adding Slide Transitions 

No one wants to watch a PowerPoint presentation that is neither 

interesting or entertaining. Without certain design elements, many 

audience members will consider PowerPoint to be boring. In fact, 

some audiences sarcastically suffer “Death by PowerPoint” when 

the presenter and presentation are not stimulating. Don’t be like 

Dwight Schrute of “The Office” and start a fake fire to get your co-

workers’ attention, because you don’t know how to create a great 

PowerPoint presentation! One way to add appeal to your 

presentation is to use multimedia elements. 

Motion and multimedia can evoke emotion in the audience and can 

be applied in a variety of ways. Slide transitions are the visual and 

audio effects that occur when the presentation moves from one slide 

to the next while in slide show view. By default, no transitions exist 

in a newly created presentation. However, applying transitions can 

be easy and effective. 

Users can control the speed, add sound, and customize the properties 

of transition effects. When used effectively, transitions can add a 

professional feel to a presentation. However, inconsistent and 

inappropriate transitions can distract from the purpose of the 

presentation, so careful consideration should be taken to ensure that 

a transition effect complements the goals of the presentation. While 

transitions can be applied to individual slides, consistency across all 

slides is considered a “best practice”. 

Applying a transition can be accomplished by clicking a slide 

thumbnail in the left pane, and then clicking the Transitions tab on 

the ribbon. This is the slide that will appear after 
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the transition. The user can click on any of the transition icons to see 

a preview of how the visual and audio effects will display during 

slide show view. Clicking the More button will display a gallery of 

transition choices. There are three categories of transition types: 

Subtle, Exciting, and Dynamic Content. While simplistic, Subtle 

transitions are popular because they are effective. Their 

effectiveness is partly due to their lack of distraction. Exciting 

transitions and Dynamic Content, 

which use more complex animations, 

can be overkill if not used in 

moderation. Any slide transition usage 

needs to remember the purpose of the 

presentation, and not distract from that 

objective. 

To customize the look of a transition, 

users can utilize the Effect Options 



 

 
PowerPoint Chap 2   P a g e  | 236 

command to change the direction of a specific transition. These 

options will vary depending on the selected transition. To remove a 

transition, apply the None option to a slide. 

After a transition is selected, enter a time in seconds in 

the Duration field. This controls how fast the transition occurs; a 

larger number makes it go slower. From the Sound drop-down 

menu, a sound effect can be added. Caution! – sound effects can 

quickly become annoying if not used sparingly, and many of these 

affects are a little cheesy! Under the Advance Slide label, choose 

either or both of the On Mouse Click or After checkboxes to 

determine how to trigger the transition effects. The On Mouse 

Click option is popular for presentations with a live speaker in 

control of the presentation’s pace. The After combo field is 

necessary for self-running presentations, and presentations that need 

to be conducted in a specific timeframe. Precise duration’s of time 

(usually in second equivalents) can be specified for each slide using 

the After-combo field. 

 

To apply the same transition and settings to every slide, click Apply 

to All to maintain consistency. Otherwise, select different slides and 

repeat this process to apply a different transition to each. The 

specific timings for each slide are best displayed in Slide Sorter 

view. Note: clicking the Apply to All option will override any 

existing transition settings already defined on other slides. 
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Apply Animations to Slide 
Content 

Animations refer to the movement of objects and text on a slide 

during slide show view. Animations can help make a PowerPoint 

presentation more dynamic, more memorable, and more interesting. 

Animations affect the individual objects on a slide, including 

bullets, text, and graphics. Each effect can be timed to appear on a 

slide, in a specific sequence, using either Entrance, Emphasis and/or 

Exit effects. Entrance animation effects occur as the object 

initially appears on a slide, whereas exit animation effects transpire 

as the object leaves the slide. Entrance animation is very popular for 

introducing bulleted text one bullet at a time, which prevents 

viewers from advancing their attention beyond the current 

topic. Emphasis animation occurs after the object has displayed on 

the slide. It can be useful to draw attention to a specific object on a 

busy slide by adding motion or highlights.  

To apply an animation, select an object on a slide, and then choose 

an animation icon from the Animations tab. In the photo below, a 
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callout shape was added, formatted and filled with text, before a 

Float In entrance animation effect was applied. 

Additional animations can be added to text or objects by clicking 

the Add Animation button in the Advanced Animation group. If an 

attempt is made to add an animation without first clicking “Add 

Animation” it will replace the existing animation instead of adding 

to it. This step can be repeated multiple times to add as many 

animations to an object as desired. 

Clicking the Animation Pane, located in the Advanced Animation 

group of the Animations pane, is a useful tool for organizing 

multiple animations on the same slide. The Animation Pane lists the 

objects on a slide that have animation applied. It can be used to 

reorder the animation sequence and choose options for the 
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animations. Effect Options can be applied to change the direction of 

the animation. To adjust the order of the animated objects, select an 

option in the Sequence category in the Effect Options gallery. The 

By Paragraph Sequence is very popular with bulleted text 

paragraphs. Notice that numbers are assigned to each element to 

help identify the order each occurs on the slide. 

Transitions and animations have many settings, with opportunities 

to apply multiple actions to a single slide. To maintain a professional 

design, it is important to maintain consistency with transitions, 

animations, and other multimedia, including audio and visual 

effects. 

Scalable Vector Graphics and 
Icons 

Newer versions of Microsoft 365, including PowerPoint, support 

inserting and editing scalable vector graphic (.svg) files. An SVG 

file uses an XML-based text format to describe how the image 

should appear. An SVG file can be scaled to different sizes without 

losing quality—the format is resolution-independent. Therefore, 

This Photo by Unknown Author is licensed under CC BY-

SA 

https://en.wikipedia.org/wiki/Scalable_Vector_Graphics
https://creativecommons.org/licenses/by-sa/3.0/
https://creativecommons.org/licenses/by-sa/3.0/
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website and print graphics are often created in the SVG format, 

permitting them to be resized to fit different designs in the future. 

SVG files are often created and modified using Adobe software 

programs, like Illustrator, InDesign and Photoshop.  

The library of icons in Office apps consists of SVG images that 

users can insert in an Office file and then customize. These icons are 

free to use and there's no royalty or copyright to worry about. 

1. Select Insert > Icons. 

2. Browse or search with keywords for an image. Then select 

it and choose Insert. 

Users can insert and edit scalable vector graphic (SVG) images in 

presentations to create sharp, well-designed content. Since a 
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Scalable Vector Graphics file is really a text file in its details, users 

can view the text version of the file in any text editor. Vector-based 

graphic files are very customizable. The easiest method to open an 

SVG file for viewing (not editing) is via a web browser.  Most 

modern browsers will render the SVG format without having to 

download the file first.  

 

After an SVG image is placed in your presentation, its appearance 

can be modified including: 

▪ Resize the image without any loss of image quality 

▪ Change the fill color 

▪ Add or change the outline 

▪ Apply a preset style that includes both a fill color and an 

outline 

▪ Apply special effects, such as a shadow, reflection, or glow 

 

All the above options are available on 

the Graphics Format tab of the ribbon when an 

image is selected on the canvas: 

 

 An icon in SVG format 
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Adding and Modifying Audio 

An audio file can be added to a slide and played during a slide show. 

Audio files can be music, voice narration, 

or sound bites. To record and hear any 

audio, the computer must be equipped with 

a sound card, microphone, and speakers. 

Typical audio file formats include .mp4, 

.mp3, .wav, and .wma files. To insert a 

multimedia file (audio, video or 

screenshot), click the Media button on the 

Insert tab.  When a sound file is inserted, a 

sound icon  is added to the slide and the 

Audio Tools contextual tab appears to provide options to format 

how the audio plays on a slide. 
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After the audio file is inserted, and a sound icon appears on a slide, 

several formatting decisions should be addressed regarding how the 

audio sounds during playback. The sound can be previewed by 

clicking the Play/Pause button in the Audio Control Bar. The Audio 

Timeline can be dragged to the left or right to advance the audio to 

the desired start location. If hiding the icon from displaying on 

screen during Slide Show View is desired, clear the Hide During 

Show checkbox in the Audio Options group. If the audio file is 

hidden during playback, the Start drop-down list selection should be 

set to Automatically, since the On Click option is only available if 

the icon is visible so it can be clicked. The Play Across Slides option 

is great is the file is long enough to play as background music for 

many slides. This is a popular choice to complement photo albums. 

 

Record audio 

1. Select Insert > Audio. 

2. Select Record Audio. 

3. Type in a name for your audio file, select Record, and then 

speak.  Important: Your device must have a microphone 

enabled in order to record audio. 

4. To review your recording, select Stop and then select Play. 

5. Select Record to re-record your clip or select OK if you’re 

satisfied. 

6. To move your clip, select and drag the audio icon to where 

you want it on the slide. Note: If you’re using more than 

one audio file per slide, it’s advisable to put the audio icon 

in the same spot on a slide to find it easily. 

7. Select Play. 
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Adding and Modifying Video 
Video is even more engaging than video because it adds visual 

appeal in addition to audio sensory stimulation. An appropriate 

video can provide a lasting memory for the audience, and provide 

compelling evidence to influence and educate. Videos offer a lot of 

upside, but they require also require a lot of resources and careful 

consideration. The overall length of the presentation needs to be 

considered when deciding to utilize videos with a slide presentation. 

Videos tend to be lengthy and the presentation should stay focused 

and on time. Additionally, video file sizes are enormous. Therefore, 

storage and portability are often major issues to consider if 

embedding videos into a presentation. 

 
There are a couple of ways to add video to a PowerPoint 

presentation. You can add a video from your hard drive, embed one 

from YouTube, or simply linking an image to the video’s location. 

Inserting a video is very a similar process to inserting an audio file. 

When clicking the Video drop-down list, decide between inserting 

a Video on My PC… or Online Video… Either option will open a 
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dialog window to allow the user to navigate to the location of the 

video file. Like audio files, many media files are available to 

download royalty-free from online sites like freemusicarchive.org 

or videvo.net. 

 

To insert a link to a YouTube site, or embed a YouTube video code, 

choose the Online Video… option. The link to YouTube option will 

require a strong Internet connection during playback, however this 

will control the size of the PowerPoint file. 

Once inserted, ensure that the video is moved and resized to be 

legible for the audience during playback. With the video object 

selected, a new contextual Video Tools tab will appear with 

Formatting and Playback options. The Playback tab offers many 

ways to customize the impact of the video. 

The first, and most important decision, is to decide whether the 

video should play Automatically once the slide appears or until a 

mouse click triggers the playback. A lot of time can be taken to trim 

and adjust the fade of a video, which can be useful to ensure a 

snippet of a video plays instead of the entire video file, which can 

often be too lengthy. There is no denying the impact of videos in 
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today’s multimedia rich world. Nonetheless, careful planning and 

design is necessary to ensure that the investment of time and 

resources are worthwhile for use in a PowerPoint presentation. 

Some common video and audio file formats are listed below. 

Inserting and Modifying 
Hyperlinks 

Hyperlinks make a presentation dynamic by allowing connections 

to other slides, documents and/or web pages. A hyperlink is an 

object which when clicked, jumps to another location in the current 

file or opens another file, or address on the web. Hyperlinks have 

two parts: the address (of the web page, e-mail address or file 

location), and the display text (or graphic image). For example, the 

text: M State, could be linked to the web site www.minnesota.edu. 

Likewise, the logo  can also be linked to www.minnesota.edu. 

To insert a hyperlink, right-click the selected text and 

choose Link… from the shortcut menu, or select the text 

and click the Link button on the Insert tab. 
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Select a type of link from the Link to sidebar, and then type a label 

in the Text to display field. A link could open a file on from the 

Current Folder, a recently Browsed Page from the Internet or a 

Recent File that was opened on your computer. NOTE: If you link 

to a file on your computer, and move your PowerPoint presentation 

to another computer, you'll also need to move any linked files.  

 

For web pages, type a URL in the Address: box, or for an E-mail 

Address, type the e-mail syntax into the E-mail address field. 

Choose the Place in This Document option to redirect PowerPoint 

to a designated slide when the link is clicked. For all options, use 

the ScreenTip… button to add text that displays on-screen when the 

cursor hovers over the hyperlink. Make sure to test the inserted links 

by using Slide Show view and clicking each link. 
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Utilizing Templates & Slide 
Masters 

Consistency is an important quality to maintain a marketing brand. 

Corporate presentations should maintain consistency when utilizing 

certain PowerPoint functionality, particularly features like 

transitions, themes, fonts, etc. Two ways to maintain consistency in 

a PowerPoint presentation is to use templates or slide masters. A 

PowerPoint template is a replica of a slide that is saved as a .potx 

file. A template usually contains consistent layouts, fonts, colors, 

designs and even related content. Templates are a popular starting 

point for creating new presentations, in part because they save time, 

and maintain consistency. However, don’t be afraid to change 

designs add additional slides to these templates to make the 

presentation your own. Many organizations create an organization 

template that maintains the branding of the organization when 

employees create corporate presentations. Microsoft has hundreds 

of free downloadable PowerPoint and other Office templates 

available on Office.com. Existing and custom-created personal 

template files are typically found on your hard drive at: 

C:\User\<UserName>\AppData\Roaming\Microsoft\Templates. 

 

A slide master is the template that applies to all slides in a 

presentation. When all slides need to contain the same fonts, font 

sizes, and images (such as logos); a user can make those universal 

changes in one place—the Slide Master, and they’ll be applied to all 

the slides. To open Slide Master view, on the View tab, select Slide 

Master.  
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The left pane will display thumbnails of the slide master and of all 

the slide master layouts. Hovering the pointer over a slide layout 

displays the layout name and indicates which slide in the 

presentation utilize that layout. The top icon in the left pane will 

display the slide master.  

Any modifications (formatting or added logos) to the slide master 

will apply to all slides in the presentation. Formatting applied to a 

slide layout master only affects slides that use that specific layout. 

To return to the normal slide view, click the Close Master View 

button on the Slide Master tab. 
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Zoom, Zoom, Zoom! 

Make your presentations more dynamic and exciting by using the 

zoom for PowerPoint feature (circa 2019). When you create a zoom 

in PowerPoint, you can jump to and from specific slides, sections, 

and portions of your presentation in an order you decide while you're 

presenting. PowerPoint create visual links between sections of your 

presentation. It makes the presentation interactive by adding a 

clickable thumbnail of a slide or a section in your presentation and 

allowing you to easily navigate within your presentation with cool 

visual effects! 

There are three zoom options. A summary zoom is a landing page 

where users can see the pieces of their presentation summarized into 

one slide. Think of this zoom feature as a visual table of contents. 

When presenting, use the zoom to go from one place in your 

presentation to another in any order you like.  During the 

presentation, you can click on any slide on the summary to proceed 

according to the need of the audience rather than the preset slide 

progression. Get creative, skip ahead, or revisit pieces of your slide 

show without interrupting the flow of your presentation! 
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A section zoom is a link to a section already in your presentation. 

You can use them to go back to sections you want to really 

emphasize, or to highlight how certain pieces of your presentation 

connect. (PowerPoint sections are not discussed in this text.) 

A slide zoom allows users to navigate freely between slides in any 

order without interrupting the flow of the presentation. They're a 

good option for shorter presentations without lots of sections but 

slide zooms can be used for lots of different presentation scenarios. 

Slide zooms help users drill down into multiple pieces of 

information while feeling as though they’re staying on the same 

canvas. From this viewpoint, users can move freely between slides, 

emphasize the important slides, and even cut the presentation short 

without seeming so to the audience. 
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Employing Proofing Tools 

 

In today’s social media/texting communication environment, 

punctuation, spelling and grammar have begun to lose its luster. 

While this cavalier attitude might be acceptable for personal 

communications, professional communication still demands proper 

attention to details. Why is it such a big deal to proofread a 

PowerPoint presentation? Well, if you make an error in a Word 

document, one or perhaps a couple of people will notice. However, 

a presentation is usually given to a large audience, so any spelling, 

grammar or punctuation error will be magnified by multiples. 
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PowerPoint provides users with several proofing features – 

including the Spelling and Grammar tool – that can help create 

professional, error-free presentations. From the Review tab, 

clicking the Spelling button will open the Spelling pane to the right 

of the slide pane. For each error in the presentation, PowerPoint will 

offer one or more suggestions, which can be ignored or selected by 

clicking the Change button. The Spell Checker only recognizes 

misspelled and unknown words, not misused words, so proofreading 

a presentation is still important. The Thesaurus is a fun tool for 

suggesting synonyms for over-used words. Reusing the same words 

too often reduces the readability and professionalism of a 

presentation, so try out the Thesaurus! It is also a great resource for 

solving crossword puzzles! Anyone got another word for thesaurus? 
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Saving Files in Alternative File 
Formats 
The default file extension for a PowerPoint file is .pptx. Various 

alternative formats exist depending on how the file needs to be 

saved. The biggest factor will be the audience’s needs. In special 
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circumstances, when it is necessary to share sensitive or legal 

information with others, it may be prudent to save the presentation 

file in a fixed layout format that locks the file from being edited. The 

PDF and XPS formats are two popular fixed layout formats.  From 

the File tab on the ribbon, click Export and choose the Create 

PDF/XPS Document button to open the Publish as PDF or XPS 

dialog window. Publishing a file in a fixed layout format requires 

appropriate viewer software, such as Adobe Reader, which opens 

PDF files.  Adobe Reader is a free program downloadable from 

Adobe’s web site.  

If the audience does not have access to a computer with PowerPoint 

installed, saving the file as a video or PDF format could be an easy 

solution. Other file formats are available from the Export window 

by clicking the Change File Type option. Alternative formats 

include a PowerPoint Show, or an Image File type which can be 

optimized for hard-copy printouts or web sites. 

To save a PowerPoint presentation as a video to share with others: 

1. Select File > Export > Create a video. 

2. Select the quality of the video: 

▪ Ultra HD (4K) - Largest file size and ultra-high 

quality (3840 x 2160). 

▪ Full HD (1080p) - Large file size and full high 

quality (1920 x 1080). 

▪ HD (720p) - Medium file size and moderate quality 

(1280 x 720). 

▪ Standard (480p) - Smallest file size and lowest 

quality (852 x 480).  

Note:  Full HD (1080p) is recommended for most uses.  

3. Decide if you want to: 

▪ Use Recorded Timings and Narrations 

▪ Don't Use Recorded Timings and Narrations 
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4. In the Seconds spent on each slide box, select the default 

time you want to spend on each slide. 

5. Select Create Video. 

6. Enter a file name and then browse to the location you want 

to save your video. 

7. In the Save As type box, select if you want to save the video 

as a MPEG-4 Video or Windows Media Video. 

Tip: The MPEG-4 Video format is recommended for the best 

compatibility with video players. 

8. Select Save. 

9. It will take some time to generate the video. Check the 

progress bar at the bottom of the window to see when it's 

complete. 

 

What to do with your video after creating it? 

After you create a video, you can share it with others by using the 

following methods: 

1. Email your presentation to others (due to the large file size 

of the video, this is not a recommended option) 

2. Upload to your organization’s network/web page/portal. 

3. Save to an external file share or other location. i.e. YouTube. 

  

https://support.microsoft.com/en-us/office/email-your-presentation-to-others-9c74c737-6fd5-4b10-a073-58aca3570911
https://support.microsoft.com/en-us/office/save-your-presentation-file-34377c9c-a1e5-44e1-9c3f-e6e72ee6c541
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Practice 13: The Planets – Part 2 

1. Open the file Our Planets.pptx. 

2. Press the F12 key and save the file as Our Planets – 

FINAL.pptx. 

3. Via the slide sorter view, rearrange the slides in order closest 

to furthest from the sun. 

4. Apply the Vortex slide transition to all slides in the 

presentation. 

5. Add the From Bottom Effect Option and a 5:00 (second) 

duration to Apply to All slides. 

6. At the end of the presentation, add a new Title and Content 

slide with the following text: 

o Title: The Dwarf Planets 

o Content: (each as its own paragraph) 

▪ Pluto 

▪ Ceres 

▪ Eris 

7. Change the font size of the title text to 44pt and the three 

paragraphs to 32pt. 

8. Apply the Zoom animation scheme (By Paragraph) to the 

three paragraphs. 

9. Change the slide layout to Two Content and in the new 

placeholder, click the Insert Video icon, and add the 

SolarSystemVid file from the Course Data Files. Ensure that 

the video starts automatically. 

10. On the first slide, insert the audio file The Cavern from the 

Course Data Files. Ensure the audio starts automatically, and 

does not appear during playback, but does play across all 

slides. 
11. Add a hyperlink to the Pluto text on the last slide to the web 

site: theplanets.org/pluto/. 

12. Save the file, then save a copy in PDF format. 
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